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Become an apple Genius
The Apple Genius Bar is a reassuring 

facility. But do you really need an 

appointment? Become your own Mac 

expert with our comprehensive guide.

personalize your iOS device
From individual ringtones on your 

iPhone to that statement decal on your 

iPad, we’ve got customization covered. 

Express your iOS individuality…

multi-monitor setups
It doesn’t take many windows to clutter 

up your desktop. Here are our tips for 

window management in macOS, and 

how to make more of a second screen.

3422 42

It’s easier to work 
more efficiently when 

you’ve got plenty of 
space to work with.

Check out our  
latest subscription 

offers on
p52

GO
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Apple recently released big updates 
for its music apps: a new-look interface 
and many more advanced features for 
Logic Pro X on Mac, and a whole raft of 
new stuff for GarageBand on iOS, which 
you can read more about on p14. I’m 
leaving the judgments on Logic Pro to 
someone who really knows what 
they’re doing for our review next issue, 
but I’ve been using GarageBand, and 
I’m just blown away by what Apple has 
added. Without making the main 
interface any more complex, it’s now 
full of fantastic granular tools, and 
offers expansion via app extensions.

It’s interesting that an app that’s theoretically very focused on 
casual users gets updated alongside the pro app. I feel like we’re 
seeing one of Apple’s strategies for the future of iOS really come 
into focus: to make its apps capable on their own with very clean 
and friendly interfaces, but with extensions to allow for more 
advanced and high-end features.

GarageBand’s tools are now impressively deep, but they’re 
nothing compared to Logic. But third-party apps are now capable 
of adding their own interfaces into GarageBand to apply sounds 
and effects. And if you’ve seen some of what’s out there, you’ll 
know these apps can be incredibly complex and detailed. But 
Apple is leaving that choice up to you – instead of it making a 
Logic-style pro app for iOS, it’s up to users to add app developers’ 
more advanced offerings. We see this approach in Photos too, and 
Maps, and even Siri. I kind of love the idea – pull you in with a free 
easy default app, while leaving the door open for you to expand 
that however you want as you become more confident.

I hope we get the same approach in iMovie soon – I can imagine 
extensions adding new transitions, titling styles, color grading, 
and all kinds of effects. Inevitably, this approach can’t satisfy 
everyone, but when I think about how easy this will make it for 
new people to get into video or music creation, and grow their 
skills to produce truly polished work, I get really excited.

Apps become plAtforms

mAtt bolton, Editor

Twitter: @matthewbbolton

>>>ThE TEam

craig Grannell
contributor 

Craig advises backing 

up multiple times a day, 

locally and to the cloud.

mat Gartside
Art editor 

Mat’s Genius tip is to 

learn as many keyboard 

shortcuts as you can!

Jo membery
operations editor 

Jo’s productivity tip is to 

manage your windows 

and workspaces well.
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NAS drives such 
as the WD My 
Cloud work with 
Time Machine.

Apple has got quite a lot money, and armchair 
pundits love to spend the company’s money for it. 
Buy Tesla! Buy GoPro! Buy Sonos! At the risk of 
joining the crowd, I would like to offer my opinion 
to the fray. Apple should strongly consider acquiring 
Nintendo. With a slew of valuable intellectual 
property under Nintendo ranging from Mario to Star 
Fox, it could add an advantage to Apple’s hardware 

offerings. The Apple TV would be poised to enter the game console 
market as a low-priced offering. The iPhone could flex some 
exclusive games muscle over Android, with titles like Zelda 
and Donkey Kong. cHarlES GillESpiE

It’s a very tempting thought for Nintendo fans like myself, but I doubt 
it will happen. For a start, Nintendo is still worth a huge amount of 
money: $28 billion. That’s a bit rich even for Apple. I also doubt the 
traditional Japanese working culture of Nintendo would mix well with 
Apple’s centralized style. We’re starting to see big Nintendo names 
on iOS now anyway – keep your eye out for Animal Crossing soon! 

Time options
If Apple is going to do away with 

creating the Airport/Time 

Capsule, I sincerely hope they 

release the API to allow third-

party vendors to back up 

wirelessly via Time Machine. It’s 

an indispensable part of my life. 

I have everything set up to back 

up so I can set it and forget it. 

bEn HolETon

There kind of already is! 

it’s not an api (application 

programming interface – a way 

for different bits of software 

to talk to each other), but is 

instead a specification that 

network hard drives can use 

which means they’ll show up 

in Time machine as a valid 

backup option. Synology, 

western Digital and others 

offer compatible products.

a map to El capitan
The Ask column in the February 

2017 issue (#124) states that older 

iMacs cannot be upgraded to El 

Capitan because it isn’t available 

from the App Store. According to 

this article (apple.co/2jU76oi)  

on Apple’s Support website,  

El Capitan is indeed available.  

I followed the link in the article 

which took me to the El Capitan 

App Store page. I hope that 

someone finds this useful.

obErT linDSTrom

Thank you for sharing this, 

and we apologize for the error. 

You can’t get to the El capitan 

installer on the app Store by 

searching for it, but the link 

above does enable you to find 

it on the page. 

Extended windows
Regarding the speculation that 

the touchpad might be turned into 

a screen in future iterations of the 

MacBook, I can’t shake the image 

of a giant Nintendo 3DS with an 

Apple logo on it…

micHaEl lavalléE

it’s a double appearance for 

nintendo this issue! it does 

sound a bit like that, but we’re 

intrigued by the idea…

Extended windows
Your article on managing disk 

sets was great. However, I have 

the following question: Can disks 

formatted in Mac OS Extended 

format be read by a Windows PC?

raFał

windows can’t do this natively, 

but there are tools that can 

enable it. HFSExplorer (free, 

catacombae.org) lets you read 

drives and extract files. paragon 

HFS+ ($20, paragon-software.

com) enables you to write to 

them as well. However, we don’t 

know what will happen after the 

arrival of apFS, which will 

probably be later this year. 

This is a replacement for the 

HFS system used in apple’s 

current formatting, which is 

what these pieces of software 

are designed to deal with.  

You can still find OS X 10.11 El Capitan 
via Apple’s support website. 

Your opinions, rants & raves
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FEED YOUR MIND. FEAST YOUR EYES.

Apple TV is in 
decline – what’s 

going wrong?
Apple’s newest platform is 

struggling against competitors
BY EMMA BOYlE

DESpITE ITS REVAMp in 2015, Apple’s video streaming 
box isn’t having the best time. Reviews were positive, 
though identified weaknesses, but recent data from 
market research firm eMarketer indicates sales aren’t 
picking up. Its report says that Apple TV “is at the 
bottom of the U.S. connected TV market, behind Google 
Chromecast and Roku, with its share shrinking.” That’s 
got to hurt for a company that’s not exactly known for 
releasing unpopular products. The data suggests that 
Apple TV is used by 11.9% of connected TV customers, 
marking a steady decline from 12.5% in September and 
12.6% in 2015.

So what could Apple be doing wrong with its offering? 
The new Apple TV was a significant improvement on the 
previous generations of Apple TVs, with its 1080p output, 
third-party apps, and speedy hardware. However, in the 

Amazon’s Fire TV is 
significantly cheaper 

than the Apple TV.
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Feed your mind. Feast your eyes.

Useful changes come 
to App Store reviews
You won’t get bugged for reviews as 
much, and devs get to reply BY AlEx BlAkE

BIg chANgES ARE coming 

to the App Store, both for 

customers and app developers. 

In abridged notes for the release 

of the iOS 10.3 developer beta, 

Apple revealed that it’s 

introducing an official way for 

app and game developers to 

solicit review feedback from 

customers. But, to combat 

complaints from users about 

apps that spam you for ratings 

over and over again, developers 

can only do this three times per 

year, and this counter does not 

reset when new versions are 

released. Users can universally 

disable prompts to leave ratings 

and reviews using the Settings 

app, will be able to post reviews 

from within apps rather than 

bring forced to go to the App 

Store, and can use 3D Touch 

on iPhone to mark reviews as 

helpful when browsing the 

App Store.

ONE chANgE ThAT will be 

welcomed by developers is the 

chance to be given a right of 

reply to reviews on the app 

stores for iOS and Mac, visible to 

all customers. Before, developers 

had no connection to customers 

unless they had collected 

information via user registration, 

and were given no right of reply 

on the App Store. This has been 

a bugbear for app makers for 

years; if anyone left bad ratings 

because they misunderstood 

an aspect of the app or had a 

solvable technical issue, the 

developer had no way to help 

them, while their average rating 

was still lowered. Apple uses an 

app’s ratings as part of its 

metrics for App Store search 

results, so a good rating can be 

vital to an app’s success.

Users will also be able to edit 

their reviews, and developers 

can then edit their replies, 

enabling a kind of conversation 

– albeit in an awkward layout. 

Apple hasn’t given a timeline 

for the implementation of the 

changes, saying only that apps 

already on the App Store won’t 

have to change their review 

prompt behavior immediately.

context of the wider streaming 
device market, devices from the likes 
of Amazon and Roku are offering do 
the same (and more, in some cases) 
for around half the price. Apple’s 
competition with some of the most 
popular streaming services, such 
as Amazon and Spotify, means it’s 
unlikely we’ll see them bring apps 
to the device any time soon, again 
putting Apple TV at a disadvantage. 

ApplE IS increasing the maximum 
size for apps on the Apple TV from 
200MB to 4GB, which should make 
the device better for game designers 
– although improved gaming options 
aren’t likely to make the Apple TV 
more appealing to those looking for 
a TV streaming device.

The company originally had a 
great vision for the Apple TV, going 
as far as calling it the “future of 
television.” But while it’s 
undoubtedly a good device, we 
haven’t really seen any sign of that 
yet. Though Apple clearly isn’t giving 
up on its box, it’s highly unlikely 
that improving it is at the very top 
of the company’s priority list.  

And, while Apple may be making 
improvements, so are its 
competitors who were offering more 
in the first place – making it difficult 
for Apple to catch up enough to be 
considered serious competition. 
Until it’s able to offer a service that 
justifies its price, Apple TV is still 
aimed more at dedicated Apple users 
than the mainstream.

The App Store changes 
should help everyone.

 maclife.com  apr 2017   13



Feed your mind. Feast your eyes.

GarageBand 
for iOS gets 

serious
Apple’s mobile music 

maker gets more easy 
tools, and some killer 

pro ones, too
BY matt BOltOn

You can tweak a 
visual equalizer 

for individual 
tracks while 
they play…

The Alchemy synth 
sounds really cool, 
even if you don’t know 
what you’re doing.

expanded mixer tools. GarageBand 
also gets more of its own built-in 
effects and tools to apply to recorded 
tracks, which have all the controls 
necessary for experts to manipulate 
them individually and in-depth – 
though there’s also a new voice- 
recording effects tool that can apply 
a silly or useful effect with just a tap.

One of the other big features is a 
new synth, named Alchemy, which 
has been brought over from Logic 
using the same pro-quality sound 
engine, but with some simplified 
controls. It’s perfect for those 
wanting to play around with Stranger 
Things or Blade Runner-style sounds, 
and is packed with options while still 
being easy and fun to experiment 
with. Part of what makes it simple to 
use is a new option to play keyboard 
instruments with a chord-based 
layout, like the one available for all 
of GarageBand’s string instruments. 
Again, it’s perfect for people who 
know nothing about music but want 
to play with making something fun.

There are even more tools for 
pros hidden away, including a 
two-handed keyboard layout and 
the ability to record multiple takes, 
plus fast access to instruments. 
We’re blown away by what Apple has 
included without making the app 
harder to use. We hope iMovie gets 
a similar treatment soon!

apple haS recentlY updated its 
flagship music apps on Mac and iOS: 
Logic Pro X and GarageBand 
respectively (though GarageBand on 
Mac hasn’t had the same recent 
love). We’ll take a look at the host of 
technical and feature improvements 
made to Logic Pro X in an upcoming 
issue, but it’s GarageBand that’s 
been impressing us most.

The biggest new addition is audio 
plugins, enabling third-party apps 
to apply effects to a track using their 
own interface within GarageBand. It 
work just like Photos app extensions: 
you install an app from the App 
Store, and then select it from a list of 
options within GarageBand’s newly 

>>>Start
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>>> David Chartier is a content strategist and writer with vast experience analyzing the tech world.  

He runs the website Finer Things in Tech (finerthings.in) and hosts its podcast, The Finer Things In.

T
echnology has a strange 
knack for making us feel lost 
or inadequate. I stopped 
counting the number of 

family, friends, and clients who 
start tech (support) questions with 
“I’m sorry,” or “I must be dumb.” 
This feels unique to tech, too. Do 
you hear people apologize to their 
doctors or car mechanics like they 
do in tech? I don’t think so. And 
while there are myriad underlying 
problems that perpetuate what we 
could perhaps call “techxiety,” 
I believe one could be tackled fairly 
easily, and its solution could have a 
vast, positive impact for just about 
everyone: better onboarding.

The process of teaching a 
customer about how a product 
works while they use it is referred 
to in tech as “onboarding.” The 
first time you start up most new 
Apple devices, they tell you a little 
about new features or ask you to 
turn on certain things. Some App 

Store apps present a message after 
a big update. A few of the good 
ones will walk you through a new 
feature, ensuring you use it at least 
once to give you an understanding 
of how it works.

The industry’s onboarding 
techniques have improved in 
recent years. But considering that 
there are still so many people 
who feel powerless with, or even 
unwelcome by, technology, and the 
blossoming popularity of “digital 
literacy” programs to help people 
from all walks of life, I’d say we 
have a lot more work to do.

Think about onboarding you’ve 
experienced. Much of it has 
probably been in the form of a few 
pop-up pages the first time you 
run an app or start a new device. 
It’s good stuff, but it’s usually too 
much to take in all at once. It also 
usually vanishes once you’re done, 
leaving you with nothing to turn to 
for tips, insight, or help besides a 
big body of support documents.

More progressive and effective 
onboarding is surfacing, slowly. 
As much as I dislike the company’s 
invasive business practices, 
I submit Facebook as a leader 
here. It rolls out new features 
methodically, and when one is 
ready for you, the app displays 
a small pop up, sometimes with 
a quick tutorial. Infrequent, 

contextual, and never lasting long, 
these nibbles of onboarding feel 
more like a quick, pleasantly useful 
tap on the shoulder from your 
friendly neighborhood tech guru, 
versus being whacked with an 
overstuffed bible of feature details.

Other progressive apps are 
building in new kinds of systems 
that are onboarding, in-app chat, 
and support all in one. When you 
can’t find an answer, you can chat 
almost immediately with an expert 
from the company and get on with 

your day. It’s one-tap access 
to that neighborhood tech guru, 
except they’re actually trained 
in the product at hand.

These new techniques and 
tools make a huge difference. 
When users are better informed 
in how their tools work, they’re 
more confident in their capabilities 
and more apt to explore further. 
As long as the trend continues, 
more people can feel in control 
of their tech, instead of the 
other way around.

A lot of people struggle to get into new apps. 
david chartier says more developers 
need to get on board with onboarding

>the shift

some apps are 
building in onboarding, 

in-app chat, and 
support all-in-one

Some apps provide great support, while 
others leave users to try to work things out.
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Feed your mind. Feast your eyes.

T
here’s not a polite way to say 
it, but American technology 
policy is absolutely terrible. 
In fact, the word “inept” is 

probably fair. I can’t sit by any 
longer, and I’m running for the 
US Congress in Massachusetts for 
2018. Chances are, because you 
read Mac|Life, you should consider 
running too. We desperately need 
technology experts serving across 
our government. 

A major factor in deciding to 
run was the FBIs attempt to force 
Apple to develop an iPhone 
backdoor for law enforcement. 
After a terrorist attack in San 
Bernardino, the FBI wanted to 
open the terrorist’s phone to 
try to gather intelligence. The 
problem was, agents had not 
followed procedure, and entered 
an incorrect password until the 
iPhone permanently locked. To 
correct their mistake, the FBI 
tried to pressure Apple in court 
to write a custom version of iOS 
to access this phone.

Though some members of the 
public are always eager to trade 
civil rights when the word terrorist 
is used, technologists saw the 
extreme danger. Not only could 
the American government use the 

program to spy on anyone’s phone 
with this iOS version, it could be 
used by foreign governments and 
hackers to compromise everyone. 
Fortunately for the public, Apple 
stood firm - but even former 
President Obama wanted Apple 
to comply. We desperately need 
technologists serving that will 
protect our civil rights. Because, 
the truth is, congress is comprised 
of 42% lawyers and they don’t 
understand these issues. 

Another major reason I’m 
running was last year’s Mirai 
Botnet attack, which congress 
largely shrugged at. The Mirai 
attack used so-called “Internet of 
Things” devices to shut down large 
portions of the internet in late 
2016. Popular low-cost webcams 
and video recorders shipped with 
the same default password. The 
Mirai botnet locates those devices 
and rewrites the firmware leaving 

them under the control of hackers. 
All across America, people 
unknowingly have devices in 
their homes that were used to 
attack our infrastructure. 

You would think the 
technological equivalent of a 
terrorist sleeper cell would have 
congress working late into the 
night. It did not. Congresswoman 
Martha Blackburn, who serves 
on the same House technology 
subcommittee I hope to serve on, 
had the temerity to go on CNN 
and blame the attack on software 
piracy. Gizmodo very fairly ran 
the headline, “This is the kind 
of idiot that Congress puts in 
charge of technology.” 

But our problems go beyond 
the Mirai Botnet. Because our 
consumer protection laws are 
bought and paid for by large 
corporations, there’s no 
real consequence if a 
company is reckless 
in securing your data 
and ends up hacked. 
They simply send out 
a warning email to 
you, and then it’s 
back to business 
as usual.

Is the US prepared for the future that 
technology is ushering in? Brianna wu 
doesn’t think it is, but we can change that

>game loop

we desperately need 
technologists serving 

in government to 
protect our civil rights

>>>Start
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we have to make it 
more expensive for 

companies to do 
the wrong thing

Data breaches usually happen 
because a database has not been 
properly secured. Recently, one 
security researcher threw an 
insecure database online and it 
didn’t even last 24 hours. Hiring 
security experts to do it correctly is 
expensive, so companies often cheap 
out, and consumers pay the price. 

economists have a term: 
“externality.” If I run an oil drill, 

and don’t spend the money to 
keep the environment clean 

around it, there is an external 
cost. Nearby water will be 

polluted, and local 
municipalities will have 

to spend a fortune to 
clean it up. That cost is 

an externality to my 
oil drill business. 

Similarly, when 
companies don’t 
keep their databases 
secure, the rest of 

us pay a steep price with identity 
theft, hacking, and financial fraud. 

We have to make it more 
expensive to do the wrong thing 
than the right thing. That’s why 
congress needs to open up large 
companies to civil liability if they 
show extreme negligence in 
protecting user data. That would 
have three immediate benefits for 
the tech industry. First, it would be 
a huge boon to open source. Having 
your code reviewed would mitigate 
liability and would incentivize 
corporations to invest in open 
source development. Secondly, 
it would create a huge market for 
cybersecurity experts. Thirdly, it 
would vastly improve our national 
security - hardening us against 
attacks on our infrastructure.

Here in the United States, we 
spend 54% of our discretionary 
spending on the military. Yet, we 
are completely unprepared for the 
wars of the future - which will be 

fought less often with tanks 
and submarines, and more often 
by hacking our infrastructure. 
The corporations that lobby our 
politicians are quite happy to keep 
it this way. Vulnerable infrastructure 
is great for their business.

The free market cannot solve 
these issues, because the consumer 
doesn’t care and the producer has 
no incentive to spend the money. 
Beyond that, our current president 
is poised to eliminate net neutrality, 
which would be a huge blow to free 
information. The stakes are too high 
for inaction. It’s time for those of us 
that understand tech to step up and 
serve in government.

Smart technology is hugely 
beneficial, but it comes 
with security concerns.
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Feed your mind. Feast your eyes.

6 iPhone accessories to 
get you in shape for summer

It’s time to shed the winter weight and look great again
BY alan stoneBridge

summer is coming and you’ll want 
to look and feel your best, so it’s 
time to set aside some time, do some 
stretches and get your pulse racing.
Perhaps you’ve been in this place 
before and given up, or maybe you 
just need a little tune-up. Smart tech 
can help keep you on track by giving 
you an idea of how your efforts are 
paying off without having to wait for 
plainly visible results – which is one 
reason many of us lose motivation.

Apple’s second-generation Watch 
is one way to track the energy you’re 
burning, especially now you can use 
it while swimming, but don’t limit 
your quest for a healthier life to only 
activities one wearable caters for – 
check out these iOS accessories 
for a broader, more flexible, choice.

The TICKR X sensor can track your ground contact time and other stats, and has a treadmill mode.

Zepp’s sensor can be 
fitted to any racket.

Wahoo ticKr X

This $79 sensor 

tracks the motion 

and intensity of 

workouts. Apple 

sells a $149 bundle 

with a one-year 

Beachbody On 

Demand sub, with 

hundreds of 

workout videos.

aftershokz  

trekz titanium

These sweatproof 

headphones use 

bone conduction 

and an open-ear 

design to keep you 

aware of things 

while running; if 

music motivates 

you, consider 

whether staying 

safe is worth the 

$129 price.

Zepp tennis 

sensor

Get fitter while 

having fun: add 

this $99 gadget 

to your favorite 

racket’s handle 

and you’ll be able 

to improve your 

game while 

getting fit.

tangram Factory

smart rope

LEDs in this 

$79 rope use 

persistence of 

vision to show 

your jump count;  

a software update 

will add calories 

burned and more.

Withings Body 

As well as weight,  

this $129 scale 

measures muscle, 

fat and body mass, 

plus hydration. Its 

Health Mate app 

visualizes data and 

provides progress 

updates to help 

you stick to goals. 

concept2 model 

d rowing machine

Add this $945 kit 

to your home gym 

and realize serious 

ambitions thanks 

to its performance 

monitor, which can 

be paired with iOS 

to send data to 

mobile apps.

Yes, this smart jump rope really is a thing.

>>>Start

18   Apr 2017  maclife.com



The premier source for everything video games, TV, films, and more.

www.gamesradar.com



>>>Start Feed your mind. Feast your eyes.

THE GEAR WE’RE LUSTING AFTER

CRAVE
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Sunflower
shadecraft.com
$TBC

>>> This impressive new addition to the Internet 

of Things, albeit in prototype mode at present, 

does a lot more than keep you cool on a hot 

day. The Sunflower is the first autonomous 

robotic shade; it’s solar-powered and boasts 

an integrated camera for security, controlled 

lighting, a speaker system, and charging 

facilities. As it tracks the sun, it optimizes both 

its solar charging capacity and its ability to 

provide shade. The Sunflower is Bluetooth and 

Wi-Fi enabled, and the app allows you to check 

in on the weather, UV levels, and air quality.



LEGO Boost Creative Toolbox
lego.com
$TBC

>>> LEGO: simple bricks, right? Well, the bricks are 

getting a little bit smart, with the help of the LEGO 

Boost Creative Toolbox. The Toolbox includes over 

840 pieces; the accompanying app provides 

instructions to build and code five multifunctional 

models. There’s Vernie the talking robot, a multi-

tooled Rover 4 transport unit with spring-loaded 

missile, the Guitar4000 musical instrument, 

Frankie the interactive cat, and the AutoBuilder  

– which promises an automated production line 

for LEGO models. An inspirational update to our 

favorite interlocking bricks.

Canon PowerShot G9 X Mark II
canon.com
$530

>>> Canon’s PowerShot range has been revamped 

for 2017, and the G9 X Mark II now packs a 

20.1-megapixel sensor, DIGIC 7 processor, 3x optical 

zoom, and 3-inch touchscreen LCD. There’s built-in 

Wi-Fi, Bluetooth and NFC technology, and intelligent 

image stabilization. And you get all this within 

a truly compact and super slim form – the camera 

weighs a mere 7 oz. The high-quality image sensor 

will help you to capture impressively detailed 

images for a camera of this size. We particularly 

love the classic look of the silver version.

Kuri Smart Robot
heykuri.com
$699

>>> A home robot, Kuri will move around your house 

with ease, avoiding obstacles and learning your 

floor plan along the way. It’ll also learn about your 

habits and routines, so that it can, for example, 

wake you at the right time each morning. It’ll 

connect with your home devices, play your favorite 

songs, and respond to your spoken commands – 

it can even respond to touch. The robot’s blinking, 

emotive eyes are equipped with a camera so that as 

well as offering facial recognition, it can monitor 

your home and take HD photos and video. 
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Apple 
Genius

Become an

If only there were a 
secret Apple handbook 
we could all use. Well, 
nik rawlinson has 
conjured one up for us

What do you do when your Mac 
goes wrong? Over the following 

pages, we will unveil the answers. 
In our Mac|Life “handbook,” you’ll 
learn how to diagnose problems with 
unresponsive Macs, misbehaving 
network connections, uncooperative 
backups, and macOS mishaps. 
A word of advice before you begin: 
don’t let on to friends and family 
about your newfound skills, or 
you’ll be forever plagued by 
requests for help and advice…

Become an Apple Genius
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Oh nO, My MAc’s brOken!
Don’t panic – many common problems are simple to fix

There’s An opTicAl 

disc sTuck in my drive

If the eject icon next to the disc in Finder 

doesn’t work, and neither does dragging 

the disc’s desktop icon to the Trash, open 

Terminal and enter drutil eject; if that also 

fails, shut down your Mac, then power it on 

again, holding down the primary mouse 

button or trackpad while the Mac starts up.

i’m seeinG frequenT 

kernel pAnics

An unexpected black screen overlaid by 

a multilingual error message is about as 

serious a problem as Macs ever get. If it’s 

caused by a software glitch, it’s usually fixed 

with a simple restart. however, if it happens 

often, check your Mac’s memory is properly 

seated (assuming it has removable modules) 

and other components you’ve added recently 

are securely connected.

i cAn’T empTy 

The TrAsh

The operating system locks files that it’s 

using or previewing, so if you can’t empty the 

Trash entirely there’s a good chance one of 

its contents is still required by macOs or an 

app. Quit your apps and try again. If that 

doesn’t work, it could be that one of its 

contents is locked. click Finder in the menu 

bar, hold Alt and click the empty Trash option 

(note that the ellipsis after it disappears 

when Alt is held, meaning you won’t be 

asked to provide additional instruction in 

a dialog). still no luck? Open Terminal, 

enter sudo rm ~/.Trash.* and provide an 

admin account’s name and password as 

confirmation, then press ®. back up first!

finder is 

unresponsive

you can’t Force Quit 

Finder like other 

apps, but you can 

force it to restart 

from that menu.

Or, place the pointer 

over Finder’s icon in 

the Dock, hold down 

Alt then press and 

hold down the 

trackpad or mouse 

button; from the 

menu, choose 

relaunch. beware 

that doing this will 

terminate any file 

operations that are 

in progress.

i’m GeTTinG A loT of 

spinninG beAch bAlls

seeing the beach 

ball now and then is 

to be expected – it 

often appears when 

an app is waiting for 

storage to catch up 

with its requests, 

say – but if it’s 

happening 

frequently, check 

in Activity Monitor 

(located in  

/Applications/

Utilities) for apps 

that are excessively 

consuming 

resources, or which 

have become 

unresponsive. If the 

same culprits show 

up again and again, 

either reinstall 

them, see if there’s 

an update or, failing 

those approaches, 

try to find an 

alternative app.

>>>Feature
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my mAc is becominG 

forGeTful

If your Mac forgets volume, screen resolution, 

startup disk or other system settings, try 

resetting its nVrAM (non‑volatile random‑

access memory). shut down, then power on 

again and hold ç+Alt+p+R till you’ve 

heard the startup sound twice (or for at least 

20 seconds on a late 2016 Macbook Pro), 

then let go and allow startup to complete.

is iT Time To Give up 

And sTArT over?

back up all of your data, just in case you 

change your mind, then hold ç+R 

immediately after powering on or restarting 

your Mac to enter the recovery system. 

When you see a window that lists four 

options, choose Disk Utility from it, use it 

to erase your startup disk, then quit Disk 

Utility and choose the option to reinstall 

macOs; this will confirm over the internet 

that your hardware’s eligible to run macOs, 

so ensure it has a reliable Wi‑Fi or ethernet 

connection to the outside world.

diAGnosinG oTher 

hArdwAre problems

hold d while 

starting up your 

Mac to open Apple 

Diagnostics, or 

Alt+d to open it 

over the internet if 

it can’t be found on 

your Mac’s storage. 

(If your Mac is from 

prior to June 2013, 

you’ll need to use 

the Apple hardware 

Test instead; see 

apple.co/2je4tn4 

for details). 

All being well, 

you should see the 

code ADP000, 

which means no 

problems have been 

found. Anything 

else suggests an 

error, which will 

either give you 

a starting point 

for your own 

investigation, 

or guidance 

when talking to 

a professional 

engineer. Apple 

documents the 

meanings 

of diagnostic 

codes at apple.

co/2j4AGey.

my mAc  

is deAd

If your Mac won’t 

turn on, check the 

power supply. 

exercise caution 

while trying both 

a different power 

outlet and a 

different lead if 

you have one, then 

check the fuse in 

the plug. The 

problem may be 

internal, such as a 

transformer or the 

power switch itself. 

The latter two are 

risky fixes – we’d 

recommend a trip 

to a Genius bar or 

Authorized service 

Provider – turn to 

p32 for details.

Become an Apple Genius
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rAndom files 

Are unusAble

If your files are corrupting or 

becoming inaccessible, check 

your Mac’s storage isn’t failing. 

Internal drives incorporate 

sMArT (self‑Monitoring, 

Analysis and reporting 

Technology), which will alert you 

to developing problems so you 

can salvage your data before the 

drive becomes unusable. In Disk 

Utility, select the drive in the 

sidebar (not a volume on it) and 

check its sMArT status at the 

bottom of the window. If it says 

anything other than “Verified,” 

back up your data and replace 

the drive as a matter of urgency.

Airdrop 

problems

check both devices 

against “What you 

need” at apple.

co/2eA1elc, and 

that bluetooth and 

Wi‑Fi are on. If 

receiving on a 2012 

or older Mac, click 

“Don’t see who 

you’re looking for?” 

then “search for an 

older Mac” on the 

sender; iOs devices 

can‘t send to them. 

If the receiver’s an 

iOs device and the 

sender can’t see it, 

try the everyone 

option. Personal 

hotspot (settings > 

Mobile Data) 

mustn’t be active. 

“block all incoming 

connections” in a 

Mac’s firewall (p33) 

prevents AirDrop 

receipt. Toggling 

Wi‑Fi can fix 

devices’ inability 

to see each other.

spoTliGhT 

resulTs 

hAve become 

unmAnAGeAble

strip down what 

spotlight includes 

in its search results 

by unchecking what 

you don’t need 

through its pane in 

system Preferences. 

Use the same pane’s 

Privacy tab to 

exclude files and 

folders entirely – 

perhaps even a drive 

that contains only 

old archived project 

files you rarely need.

helP! I hAVe PrObleMs WITh My FIles
From damaged drives to broken bluetooth, file errors can be fixed

>>>Feature
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i cAn’T Access 

The librAry folder

There are two 

library folders 

on your Mac: one 

at the top of your 

startup disk for 

assets shared by 

all user accounts, 

and one in your 

account’s folder. 

The latter holds 

your preferences 

and other personal 

items, and is usually 

hidden. To open this 

library folder, 

switch to Finder, 

hold Alt and pick 

Go > library, or 

press ç+ß+g 

and enter ~/Library 

in the dialog.

double-clickinG A file doesn’T 

open The AssociATed App

check that files of that type are still 

associated with the expected app: select 

one, press ç+I and ensure the app 

is listed in the “Open with” section. If the 

wrong app is listed there, pick the correct 

one from the pop‑up menu, then click the 

change All button to set that as the new 

default app for this file type.

If the app is already running, it may have 

hung. Press ç+Alt+œ to bring up the Force 

Quit Applications dialog and check whether 

it says “not responding” alongside the app’s 

name. If it does, select the app and click the 

Force Quit button, and then try double‑

clicking the file again. If not, try dragging 

the file onto the app’s Dock icon, or using 

the app’s File > Open command.

i’ve AccidenTAlly 

deleTed A file i need

If you don’t have a 

Time Machine or 

other backup, and 

the file has been 

removed from the 

Trash, step away 

from your Mac so 

you don’t risk 

overwriting the 

file’s data; there’s 

a good chance it’s 

still on the drive, 

and reference to 

it has simply been 

removed from the 

file system. Apps 

like Data rescue 

($99, prosofteng.

com) can often 

recover “lost” files 

by interrogating 

a drive directly, 

rather than 

through its index, 

and are a lot less 

expensive as a 

first course of 

action than a 

professional 

recovery service.

i cAn’T Access my files 

from AnoTher compuTer

The Mac you want 

to access must 

be awake and 

connected to the 

same network. If 

you still can’t see 

the remote Mac 

under shared in 

Finder’s sidebar, 

return to it, check 

File sharing is 

enabled in system 

Prefs’ sharing. If 

that Mac still 

doesn’t appear in 

the other’s Finder 

sidebar, try 

connecting directly: 

in Finder, press 

ç+k and enter 

smb://[machine 

name].local, 

replacing [machine 

name] with the 

name shown at the 

top of the other 

Mac’s sharing pane.

Become an Apple Genius
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I’Ve GOT TrOUble WITh bAckUPs
Don’t ignore stalled, incomplete, or missing backups

Time mAchine isn’T 

bAckinG up AT All

check the drive is connected and shows in 

Finder. If backing up to a local drive, use a 

Mac port rather than an external hub. Don’t 

use a Usb port in a display that’s set to sleep; 

that will disconnect the drive. If Time 

Machine backs up to a nAs drive, ensure your 

Mac connects to it at login: in Users & Groups 

preferences, click your account, login Items, 

then +, select the drive and click Ok.

my Time mAchine 

drive is GeTTinG full

Time Machine is designed to automatically 

remove very old incremental files when it 

runs out of space. It does so automatically; 

to be informed when it happens, in Time 

Machine’s preferences click Options and turn 

on “notify after old backups are deleted.” Or, 

connect a new drive and switch to using it 

ahead of time. It’s worth having a second 

routine to archive files in a way that won’t 

see them disappear over time.

The files i need 

Aren’T in Time mAchine

check the drive 

or folder in which 

they’re stored isn’t 

excluded from the 

backup set. Open 

the Time Machine 

pane in system 

Preferences and 

click Options. If the 

drive or folder 

is listed here, it’s 

excluded from 

Time Machine’s 

backups: select 

it and click the – 

(minus) button. 

If your backups 

are on a network 

drive – a Time 

capsule or a nAs 

with Time Machine 

support – check 

their health: hold 

Alt and click Time 

Machine’s menu 

bar icon, and 

choose Verify 

backups; macOs 

will detail any 

problems it finds.

Time mAchine is TAkinG 

Too lonG To bAck up

The first backup 

creates a complete 

copy of your Mac’s 

contents. later 

ones should be 

quicker as Time 

Machine then only 

saves incremental 

changes to files. 

If using a nAs drive 

or Time capsule, 

check both get a 

strong signal from 

your network and, if 

you can, connect 

both to the same 

access point. If you 

run another Os in a 

virtual machine 

(VM) within macOs, 

follow the advice 

from your 

virtualization tool’s 

developer on how 

to back up your 

VMs: refer to  

bit.ly/2jupJvA for 

VMware Fusion and 

bit.ly/2k3ygrd for 

Parallels Desktop.
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how do i know wheTher A 

problem is mine or Apple’s?

icloud tends to 

be very stable 

and its various 

services exhibit 

excellent uptime. 

However, like all 

online services 

it can suffer 

outages from 

time to time. It’s 

a good idea to 

check the service 

status at apple.

com/support/

systemstatus 

before tinkering 

with anything to 

see whether a 

problem is at 

apple’s end 

or yours.

my AccounT is 

unexpecTedly full

Sierra can make 

use of icloud to 

store your 

Documents and 

Desktop folders in 

icloud Drive so 

they are available 

on all your devices. 

You may have 

enabled this when 

you installed 

Sierra. While 

useful, this can eat 

up your icloud 

space. To switch it 

off, go to System 

preferences’ icloud 

pane, click options 

next to icloud 

Drive; uncheck 

Desktop & 

Documents Folders. 

empty versions 

appear on your 

mac; drag items 

back from those 

in icloud Drive.

i wAnT To conTrol 

synced phoTos

If you don’t use icloud photo 

Library to store and sync 

photos between devices, go to 

icloud’s prefs, click options 

next to photos, turn on my 

photo Stream. on ioS, enable 

my photo Stream in Settings > 

icloud > photos; pics upload 

when that device is on Wi-Fi. 

photos for mac adds items from 

the stream if copy Items to the 

photos Library is on.

persisTenT error 

messAGes

If you can’t access icloud 

services, there may be an icloud 

authentication issue. Sign out 

and in again in System prefs’ 

icloud pane. You’ll see the 

option to remove synced data; 

though it ought to reappear 

when you sign in again, the  

safer approach is to decline 

so you retain a copy on your 

mac throughout.

is only your user 

AccounT AffecTed?

If an app misbehaves, create 

a new user account (Users & 

Groups), log in, and check if it’s 

affected. If not, the preferences 

file for that app (~/Library/

preferences) may be damaged; 

restore from a backup or trash 

it so the app can recreate it.

I’M hAVInG PrObleMs WITh iclOUD
solutions for Apple’s online storage and personal data service

Become an Apple Genius
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helP! I’Ve GOT neTWOrkInG IssUes
Many networking problems can now be fixed with easy tweaks

i ofTen need To chAnGe 

neTwork seTTinGs

As long as location in system Preferences’ 

network pane is set to Automatic, all network 

interfaces will be active and macOs will check 

which can provide an internet connection and 

use it. If you can’t get online or use network 

services, choose edit locations, click + and 

give the location a name, click Done. click the 

cog under the list and pick set service Order 

to what’s appropriate. In turn, select each 

interface, click the cog; for any interface you 

need active, select it and click Advanced, set 

it up however the administrator has advised 

– for Wi‑Fi, don’t remove networks you need 

from the Preferred networks list as that’ll 

remove them from all locations. click Ok > 

Apply. To switch between location settings, 

use the  > location menu.

my browser cAn’T 

connecT To some siTes

your Dns (Domain name system) server 

might be having problems or set to block 

access. In system Preferences’ network pane, 

select your active connection then click 

Advanced. switch to the Dns tab, make a 

note of existing settings in case you need to 

reinstate them, then delete them. Add these 

two entries: 8.8.8.8 and 8.8.4.4, which will 

set your Mac to use Google’s Dns servers.

wi-fi JusT 

won’T work

still not working? 

Try temporarily 

removing your 

Mac’s Wi‑Fi 

connection. 

In system 

Preferences’ 

network pane, 

select Wi‑Fi in the 

left pane, then click 

the – (minus) 

button. Then 

immediately add it 

back by clicking the 

+ to create a new 

Wi‑Fi connection 

with default 

settings.

i’m hAvinG lonGer-Term 

issues wiTh wi-fi

Use Wireless 

Diagnostics (enter 

its name in 

spotlight, or hold 

Alt and click the 

Wi‑Fi icon in the 

menu bar) to 

inspect your 

connection and 

compile a 

diagnostics report 

that you can read 

through yourself or 

send to Apple or 

another support 

agent – say, your 

IsP if you’re trying 

to get it to send a 

replacement router. 

If these tests don’t 

reveal immediate 

issues, opt to 

monitor your 

connection over 

time and watch for 

problems. check 

out the options in 

the tool’s Window 

menu for other 

useful tools.
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how do i reseT 

my preferences?

Make a full backup of your system. Turn off Wi‑Fi. you 

need to copy five files related to network preferences to a 

removable drive, so you can restore them if necessary. In 

Finder, browse to the top of your Mac’s startup disk and 

then dig into /library/Preferences/systemconfiguration. 

Move (as opposed to copy) the following files to your 

removable drive, then eject that drive:

com.apple.airport.preferences.plist

com.apple.network.eapolclient.configuration.plist

com.apple.wifi.message-tracer.plist

networkInterfaces.plist

preferences.plist

restart your Mac and turn on Wi‑Fi again; macOs will 

recreate those files, which should no longer include any 

problems that existed in the versions you removed.

i cAn’T connecT usinG 

bAck To my mAc

ensure both 

Macs are signed 

in to the same 

icloud account 

and that back 

to My Mac is 

enabled in their 

icloud panes. 

In the remote 

Mac’s energy 

saver pane, set 

it to wake for 

network access. 

your router 

must support 

UPnP or nAT‑

PMP; use its 

admin tool to 

enable it – 

usually that 

tool’s accessed 

by going to the 

router’s address 

in a browser. 

To find out 

its address, Alt‑

click the Wi‑Fi 

icon and look 

under your 

network’s name. 

still can’t 

connect? 

Go to apple.

co/2jvvwvk.

Become an Apple Genius
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if All else fails, taking your gear to 

Apple may be the answer. That said, 

Apple isn’t always the cheapest option. 

before booking in at a Genius bar, compare 

Apple’s prices with those charged by your 

local Authorized service Provider (apple.

co/2fbpTu0), and third party repair stores. 

If you use a local repair shop, go to 

getsupport.apple.com, click “see your 

products” and sign in with your Apple ID 

to see the warranty status of devices, and 

whether consumer law might still apply. 

From here, you can book an appointment 

for a repair, not only with Apple but also 

members of its authorized support network.

iphone screen 

replAcemenT

Outside of warranty, Apple asks $129 for a 

regular‑size iPhone, and $149 for the larger 

Plus variants. If going to a main street store, 

take care choosing who to use; a fat‑fingered 

engineer might invoke the dreaded error 53 

on a Touch ID‑enabled device (see apple.

co/2kxbnzA) and cause more problems.

mAcbook bATTery 

repAir

replacement 

batteries cost 

between $129 (for 

Macbook Air) and 

$199 (for 12‑inch 

Macbook and the 

Macbook Pro with 

retina display) 

when supplied and 

installed by Apple. 

In recent models, 

they aren’t user 

serviceable parts, 

but with older 

portable Macs, 

DIy replacements 

are possible. you 

should be able to 

source, say, Duracell 

batteries for older 

Macbooks from 

amazon.com.

hArd drive 

replAcemenT

checking in for a 

faulty hard drive 

replacement will 

often involve two 

separate costs: one 

covering labor, 

which should 

include initial 

investigation to 

diagnose the 

problem (Genius 

bars don’t charge 

for diagnosis) and 

one for the new 

part. expect to pay 

around $99 for 

labor on a Mac mini, 

say. This service 

won’t necessarily 

include the transfer 

of data, so ensure 

you have a backup 

before handing over 

your Mac. For 

security reasons, 

also ask for the 

faulty drive back so 

you can ensure it’s 

safely destroyed 

prior to disposal.

dATA 

recovery 

broken and corrupted hard drives are a 

frequent cause of lost data, which is why 

we recommend running both Time Machine 

and a second backup service at the same 

time – the latter ideally offsite – to protect 

your files. If you lose your data, consider its 

worth, as the cost of recovery can run to 

thousands of pounds, depending on the time 

the job takes. specialists like kroll Ontrack 

(krollontrack.com), which has several 

decades’ experience in this field, can turn 

around your data in as little as 12 hours. 

rePAIr OPTIOns
If you haven’t found a solution, here’s how to get professional help
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Keep apps up to date. If updates 

delivered through mac app Store aren’t 

set to install automatically, regularly 

check the store’s Updates tab, and use 

a check for Updates command or check 

websites of apps obtained elsewhere.

Where a utility or feature of your mac 

has a menu bar icon, such as Bluetooth, 

holding alt and clicking that icon often 

reveals useful diagnostic information or 

menu items that are otherwise hidden.

If your mac won’t start up properly, 

enter safe mode by holding ß as you 

power on. If that works, disable login 

items one at a time (Users & Groups 

preferences), and start up normally. 

repeat until you find the culprit.

Learn helpful startup key combinations 

to diagnose problems, like resetting the 

memory that holds system settings, and 

more. apple maintains a list of startup 

shortcuts at bit.ly/2jeollg.

Use the Utilities folder, located in the 

applications folder. There’s a wealth of 

apps that can help diagnose and fix 

problems with networking, displays, 

passwords, and more. 

Send crash reports to developers. If you 

use el capitan or earlier, try console: 

check lines in system.log from before a 

crash and copy to your app’s developer. 

Sierra’s console can be less useful; 

consider opting in to auto-sharing 

reports – see bit.ly/sieco.

enable macoS’s firewall to boost your 

mac’s defences against any unwanted 

connections from other computers. 

Turn it on in System preferences’ 

Security & privacy pane and then 

configure it by clicking advanced.

Disable Gatekeeper in Security & 

privacy in System preferences (options 

listed under “allow apps downloaded 

from”). Though it may be annoying 

when it stops you installing apps from 

unknown sources, it’s easy enough to 

circumvent for one-off installs.

Use simple passwords: they make it 

easy for others to gain access to your 

mac. Use Keychain access’s password 

assistant (click the key button when 

adding a new entry) to enter passwords 

and get feedback on their strength.

Share user accounts. Give each person 

who’ll use your computer their own. 

This applies to icloud accounts; to 

share calendars, music, and more, click 

Set Up Family in Users & Groups.

make every account an administrator. 

create a standard user account to 

reduce the possibility of harmful 

changes. additionally, use System 

preferences’ parental controls pane to 

further monitor your kids’ actions.

risk losing your data. With Time 

machine built in to the oS, there’s no 

excuse for not backing up. particularly 

when external hard drives are now so 

affordable; a 1TB portable model 

can be bought for about $50.

Leave windows open when quitting apps 

if your startup disk is a hard drive. In 

System prefs’ General pane, turn on 

“close windows when quitting…” so 

documents don’t reopen with their app.

run unnecessary services. If your mac 

is the only computer on your network, 

go to System preferences’ Sharing pane 

and turn off screen and file sharing at 

the very least.

The essenTIAl macOs sOlUTIOns checklIsT
do don’T

Become an Apple Genius
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iPhone 
and iPad
Think all iOS devices look and work 
the same? Think again. Matt Bolton 
shows you how to make your 
iPhone and iPad your own

Personalize your
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Wallpaper settings
Go to the Settings app and choose 

Wallpaper. On this first screen, you can 

see your current wallpaper setup for the 

Lock screen and Home screen. Tap the 

“Choose a New Wallpaper” option to 

change either, or tap the current ones to 

change how they display (see step 3).

Image types
Tap “Choose a New Wallpaper.” 

At the top are choices from Apple, 

including Dynamic wallpapers (which 

animate by themselves), Still images, and 

Live wallpapers (which animate when you 

3D Touch the screen). Below are your 

photo albums from the Photos app.

Setting the image
Tap an image to see a preview of 

how it will look. Choose whether it stays 

static (Still), whether it moves as you tilt 

your device (Perspective), or if it 

animates (Live). Tap Set when happy, 

then choose whether it should be your 

Lock screen, Home screen or both.

How to CHANGe yOur WALLPAPerS

>
Bold text

In Settings > Display & Brightness, 

just below the Text Size option is a 

switch that enables Bold Text.  If you 

activate (or deactivate) this, your device 

will need to restart. It does exactly what 

you expect, turning text in iOS to bold. 

Again, apps will have to tie into iOS’s 

built-in text engine for you to see the 

benefits, but most should.

>
reduce aniMations

Also in Settings > General > 

Accessibility is an option named reduce 

Motion. Tap it you’ll see a switch labeled 

the same thing. Turn this on to disable 

effects such as the way app icons gently 

move as you tilt your phone, and the 

animation of apps shrinking and growing 

when you open or close them. This can 

save power, and some people find it 

more pleasant to use.

>
text size

Go to Settings > Display & 

Brightness and tap Text Size to bring 

up a slider that enables you to adjust 

the default size of text in iOS. The 

change will be visible in all apps that 

tie into iOS’s Dynamic Type feature, 

which all the best should. But there’s 

more! Go to Settings > General > 

Accessibility > Larger Text and 

there’s a switch that enables even 

bigger sizes.

>
Button outlines

When the look of iOS went flat 

and simple in iOS 7, many buttons 

lost their obvious shapes, making it 

occasionally confusing about what 

you can tap. Go to Settings > General 

> Accessibility and turn Button 

Shapes on, and you’ll see that many 

buttons now get dark gray shapes 

around them, showing you that 

they’re tappable. The “General” 

button at the top of the screen 

should already have changed!

> Change iOS’s appearance
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>
In the Settings app, go to the 
Sounds option to change the 
default alert noises your 
iPhone or iPad makes, as well 

its vibration options. There’s a range of 
options here, right from the obvious 
(such as ringtone or text tone) to things 
such as what noise an AirDrop request 
makes, or even tweets and Facebook 
posts. Each is totally changeable from 
the built-in sounds in iOS – just tap on 
one to change it. You’ll then get a big 
list of the sounds available, which will be 
divided into Ringtones and Alert Tones. 
Ringtones are the longer of the two, but 
there’s nothing stopping you choosing 
one of these for a Mail alert or similar.

Tap an option to switch to it and hear 
a preview of the sound, and feel its 
accompanying vibration pattern. You’ll 
also see an option named Classic – tap 
this and you’ll get a different set of 
options dating from before iOS 7, when 
the newer options were introduced. You 
can buy more ringtones by tapping the 
Store button at the top, though it’s also 
possible to add ringtones yourself – 
see below for details.

>>> It may not seem as if 

you can create your own 

ringtone for iOS, but it is 

possible. You need an audio 

file less than 30 seconds 

long in M4a format, which 

you can make on iTunes on 

your Mac. Select the song 

you want to use, then right-

click and choose Get Info. 

In the Options tab, set the 

start and stop times to 

match the portion you want 

to use. Close this window 

and go to File > Convert > 

Create aaC Version. You’ll 

get a new file that’s the 

length you selected (you 

can set the original back to 

normal). Next, manually 

change the file extension of 

this new file from “.m4a” 

to “.m4r” – this is apple’s 

ringtone format. You’ll 

need to sync your iPhone 

or iPad with iTunes to 

transfer the file (or use an 

app such as iMazing 2), and 

it will then be available in 

the Sounds menu in 

Settings. ringtones you’ve 

installed appear at the top 

of the ringtones list.

> add your own ringtone

> Choose some 
new sounds

The options here apply across your 
device as a whole, but you can customize 
the ringtones and text tones for 
individual contacts. Go to the Contacts 
app, then to someone’s entry. Tap Edit 
at the top right, then scroll down until 
you see the Ringtone and Text Tone 
options, which will be set to Default if 
you’ve never changed them in the past. 
Tap one and you get the list of ringtones 
and alert tones again – just choose a new 
one for that person and you’ll have an 
easy way to tell them apart from other 
callers or texters. You can also customize 
their vibration patterns similarly 
through this menu.

Keyboard 
clicKs

Some people like the keyboard 
clicks of an iOS device for the 

feedback, but most people 
want to turn them off ASAP. 

Go to Settings > Sounds 
and scroll to the 

bottom.
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>>> One of the best things 

about the iPhone and iPad is 

the huge choice of apps, and 

over time you’ve no doubt built 

up a wide range of tools, which 

may be filling multiple Home 

screens on your device. But it’s 

simple to organize your icons 

to make things easier to use. 

You can move an icon on your 

Home screen by lightly holding 

a finger on it until you see the 

icons jiggling around on screen. 

Now just drag any of them to 

reposition them – to move one 

to a new screen, drag it to the 

left or right edge and hold 

there until the next screen 

slides in, then drag it to the 

location you want. When you’re 

in this mode, with the icons 

wiggling around, you’ll see that 

they all have an X icon in their 

top-left corner. You can tap this 

to delete an app from your 

phone (a confirmation will pop 

up so you can back out if you’ve 

made a mistake). apps deleted 

like this, including those from 

apple, can always be re-

installed from the app Store.

You can group apps into a 

folder to make them easier to 

find, or to save Home screen 

space. Hold a finger on one to 

enter the rearrangement mode, 

then drag it directly on top of 

another app and hold it there 

for a moment. a new square 

will cover the screen, showing 

the icon for the other app. Let 

go of the app you’re dragging 

to deposit it in this new folder. 

The folder will have a name 

based on what kinds of apps 

are in it. You can tap the name 

to change it; just type in the 

new one – it can include emoji! 

You can even add folders to the 

Dock at the bottom.

>
Lots of apps send you 
notifications, though some 
are more useful, important, 
or urgent than others. 

Happily, you can easily customize how 
these are managed. Go to Settings > 
Notifications and you’ll see an entry 
for every app that wants to show 
notifications. Tap one to see its options. 
The top button stops it from providing 
notifications at all. The next chooses 
whether its messages appear in 
Notification Center, and the next 
whether its notifications make any 
sound. Badge App Icon allows it to show 
a little red dot on the Home screen with 
a number showing how many 
notifications you’ve missed from that 
app. Show on Lock Screen determines 
whether its notifications display on the 
Lock screen. Below that are three 
options for how it shows alerts on your 
phone. None means the notification will 
just make a sound or vibration. Banners 
slide in at the top of the screen for a 
moment, then back out. Alerts means 
the message doesn’t go away until you 
dismiss or open it. Tap one to select it.

> Notification 
options

> custoMize 
tHe HoMe screen
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>>> One of the great 

things about the Today 

view is the way it lets 

you get information 

right on the Lock screen, 

but with the right apps, 

you can turn it into a 

shortcut paradise. apps 

such as Launch Center 

Pro are able to create 

Today view widgets that 

serve to launch apps or 

link to communication 

options, putting these 

just a tap away at all 

times. and you can go 

even further with apps 

such as Workflow, which 

are able to build 

complex tasks across 

apps and services, which 

you can then trigger 

with just a single press.

Let’s take a closer look 

at Launch Center Pro. 

You can build “actions” 

in it, which are basically 

triggers for a series of 

tasks. For example, the 

excellent photo app 

Camera+ works with it, 

so you can set an action 

that’s just “Launch 

Camera+” – and you 

could then make this 

button available in the 

Today view, giving you a 

shortcut to that app. But 

you can also be more 

specific with the 

command, such as 

opening directly to a 

specific shooting mode 

within Camera+. 

Hundreds of apps have 

similar options.

You can also set 

shortcuts to do things 

such as making a 

FaceTime call or sending 

a Whatsapp message to 

a particular person, or 

to create a new Calendar 

entry – all from the Lock 

screen! These launcher 

apps can be confusing at 

first, but once you get 

used to them, they can 

save you a huge amount 

of time.

>
The Today view is a screen 
full of widgets, powered by 
the apps you have installed, 
enabling you to see 

information or perform some tasks 
instantly, without having to open the 
accompanying app. You can see your 
calendar entries, turn on a smart light, 
check the weather, call your favorite 
contacts… the list is almost endless. 
It can be a little command center for 
things you do often – as long as you 
set it up right. You can access it in 
three places: by swiping down from 
the top of the screen (if you see 
Notification Center here, swipe left to 
right on it to open the Today view); by 
swiping left to right from your first 
Home screen; or swiping left to right 
on the Lock screen. You get the same 
screen in all cases. You can change 

what’s shown here by swiping to the 
bottom of the Today view and tapping 
Edit. Tap the red minus button next to 
an app to remove it from view, or the 
green plus button next to one to add it. 
You can change the order in which 
included apps appear by dragging the 
three lines symbol on the far right of 
an app’s row up or down. Some apps 
have more than one widget – Maps has 
several, for example, serving different 
needs. Experiment with layouts to see 
what’s best for you.

Some widgets have two different 
views: a small one and a larger, 
extended one. Tap Show More in the 
top corner of a widget in the Today 
view to expand, or Show Less to 
collapse. You can open the app for 
any widget by tapping its symbol in 
the top-left corner.

> go Places witH launcHers

> The Today view
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>>> When you interact with Siri, 

apple’s voice-controlled 

assistant built into iOS, you 

don’t see many options, but 

you can actually personalize it 

in a number of ways. For a 

start, make sure it knows who 

you are. In Settings > Siri, tap 

My Info near the bottom and 

choose your own entry in your 

address book. This gives Siri  

a bunch of useful information, 

such as your home and work 

addresses (so you can ask it 

things like “Find me a route 

home”), plus tells it what your 

name is. That said, if you’d 

rather it called you by a 

nickname, activate Siri and tell 

it “Call me…” and add the name 

you’d like. You can then give 

Siri some extra information 

about your family, to make it 

easier to contact them. Tell it 

something like “David Smith is 

my father” or “Janet Smith is 

my wife” and it will find their 

contact information, and store 

that familial relationship, so 

that in the future you can just 

say something like “Call my 

wife” to trigger a call.

Sometimes, Siri’s 

pronunciation of names isn’t 

great. You can tell it that it’s 

getting it wrong, and it will ask 

for your guidance, and give you 

new pronunciation options to 

choose from. You can also 

manually fix how it says names 

from within someone’s 

Contacts field. Go to one, tap 

Edit, then scroll all the way 

down and tap add Field. Choose 

Phonetic First Name and 

Phonetic Last Name, then type 

in the phonetic versions.

There are also options to 

change how Siri works. Go to 

Settings > Siri and you can 

choose whether it works on the 

Lock screen, what kind of voice 

it uses, and whether it can be 

activated hands-free by you 

saying “Hey Siri” (on the 

iPhone 6s or later).

>
Go to Settings > General > 
Restrictions on your iPhone 
or iPad and you’ll find options 
to limit certain aspects of 

your device. Some of these relate to 
things such as what content you’d like 
your kids to be allowed to access, while 
others relate to privacy.

First, you’ll be asked to set up a 
passcode for Restrictions, so they can’t 
be turned on or off at will. Make sure you 
don’t forget it! At the top you’ll see the 
ability to turn off access to some built-in 
apps and features, mostly to do with 
communication. Below that are options 
to disable stores and things like In-App 
Purchases. Under that, you can set 
content-ratings limits for different 
media types. Then comes the big list of 
privacy options – you can stop an app 
from changing your settings for certain 
kinds of data by tapping on it, as well as 
rescind the ability of individual apps to 
see your information. The options range 
from obvious stuff such as your contacts 
and location, right down to your 
Facebook account and mic access.

> Lock it down 
with Restrictions

> Make siri a 
sMarter assistant
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> Personalize the outside 
of your iPhone and iPad

1 decals froM 

tHe decal guru

thedecalguru.com 

From $11

Get a cool new stick-on 

design for the back of 

your iPad and really 

make it your own. This 

site has everything from 

pop-culture icons to 

classic art reimagined, 

or just cool motifs. 

Whatever you’re into, 

you’ll almost certainly 

find something here. 

The decals are vinyl, and 

attach with an adhesive 

that shouldn’t leave any 

nasty residue.

3 lifeProof fre

lifeproof.com 

From $50

If want to make sure 

your iPhone is as 

protected as it can be, 

this waterproof, dust-

proof, snow-proof, and 

very-high-drop-proof 

case is it. The Fre totally 

encompasses your 

iPhone, with a scratch-

proof layer over the 

screen. It’s military spec, 

and perfect for hardcore 

outdoors lovers. 

LifeProof also makes 

models for iPad named 

nüüd, because they lack 

the screen covering…

4 decalgirl decals 

decalgirl.com 

From $10

If you like to keep your 

iPhone case-free, you 

can still give it a striking 

look on the back and 

front with a gel skin. The 

designs from decalgirl.

com pretty much cover 

the whole device, and 

come with a code to 

download a matching 

wallpaper, giving an all-

over effect. They’re easy 

to apply, are fairly 

durable, and there’s a 

huge range – or you can 

design your own if you 

really want to!

2 otterBox 

defender 

iPad Pro 12.9

otterbox.com 

$79

If you want serious 

protection for the 

12.9-inch Pro, this is the 

way to go. It’s totally 

drop-proof and dust-

proof, including a screen 

protector. A stand helps 

you view the iPad when 

it’s placed somewhere, 

and there’s even a 

storage spot for the 

Pencil (which works 

through the Defender’s 

screen protector).

4

32

1
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7 gear4 Piccadilly 

gear4.com 

$34.99

This case uses a magical 

substance called D3O to 

protect your devices – 

it’s a liquid that gets 

harder as it compresses, 

absorbing impacts 

easily. D3O is injected 

into the outside ring of 

the case, making it 

amazingly drop-proof 

for something that adds 

relatively little bulk. It 

comes in iPhone-

matching finishes, too.

6 kHoMo dual case 

khomoaccessories.com 

From $14

We didn’t feature 

Apple’s Smart Cases 

here because they’re 

kind of obvious, but if 

you want a cheaper 

alternative, this is our 

pick. It protects your 

iPad front and back, 

comes in a wide range 

of colors, and the front 

folds into a triangle to 

form a stand, just like 

the Smart Cover. The 

auto sleep/wake feature 

works with the cover, 

and there are versions 

for all recent iPads.

5 logitecH create 

keyBoard

logitech.com 

From $119

Want to turn your iPad 

Pro into a portable 

workstation? Apple’s 

Smart Keyboard cases 

are nice, but Logitech’s 

Create range (for both 

sizes of Pro) have more 

control keys, and are 

backlit. They’re really 

comfortable to type on, 

though do make your 

iPad notably heavier.  

If you have a non-Pro 

iPad, Logitech’s 

ultrathin Keyboard 

Cover range is our pick.

8 Just MoBile tenc 

justmobile.com 

From $19

Going from heavy 

protection to light: the 

TeNC case is very thin 

and clear – it’s designed 

to let your iPhone show 

through as much as 

possible. It resists 

scratches well, but isn’t 

the most drop-proof 

option – it’ll take one 

good fall onto a hard 

surface for sure, but 

may need replacing 

after. If you want some  

protection without extra 

weight or bulk, it’s a 

great choice.

5

6

7 8
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Sometimes, one display just isn’t 
enough. Craig Grannell shows 
how several can benefit you, 
connectors you’ll encounter, 
and a host of clever apps

>
There was a time 
when you would be 
thrilled at getting 
your hands on a 
“gigantic” 17-inch 
CRT monitor that 
weighed about as 

much as a sedan. Today, though, 
genuinely huge flatscreen displays are 
cheap, and so you might be tempted to 
grab one (or even two), attach it to your 
Mac, and revel in acres of desktop space.

Should you? That depends. We spent 
hours looking at actual science about 
the productivity benefits of multiple 
displays. Unsurprisingly, quite a lot of 
it was written by companies that make 
displays. Still, the gist of the more 
impartial research is this: having access 
to more pixels can boost your efficiency 

– to a point. It depends on the tasks 
you’re doing and how you best focus on 
them. This article, then, explores the 
ins and outs of using multiple displays. 
It’s designed as a primer for the features 
within macOS, an overview of 
enhancements provided by third-party 
apps, and also to give you ideas of how 
to best use several screens. 

So, whether you’re feeling hemmed 
in by your tiny MacBook Air, or want to 
offload tasks to a second screen to free 
up some room to breathe, our tips and 
insight will help you get more value 
from those extra pixels.

made 

easy!
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Configure your displays

>>> arrange displays

In System Preferences’ 

Displays pane, use the 

Arrangement tab to define 

the relative virtual positions 

of your displays (they don’t 

have to be side by side). 

Drag the menu bar strip to 

the display you want to be 

considered the main one.

>>> seT resoluTions

A display’s resolution can 

be adjusted in the Display 

tab. Default is the 

recommended resolution, 

but Scaled offers others. 

Holding Alt and clicking 

Scaled may reveal more 

options beyond the initial 

range that’s shown.

>>> mirroring opTions

By default, additional displays 

extend your desktop, giving 

you more room to work. 

But should you want the 

same image to be shown on 

your Mac and all connected 

displays, you’ll need to put 

a check mark next to the 

Mirror Displays item.

>>> deTeCT displays

External displays should be 

automatically detected by 

your Mac (but ensure the 

correct input is selected on 

your monitor if it has manual 

controls). If not, hold Alt so 

the Gather Windows button 

becomes Detect Displays 

and click it.

Multiple monitors
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understand your displaysWhat your  
Mac can do

Make the 
connection

Be mindful of optimal 
resolutions… as well as 
a screen’s size, consider 

its pixel dimensions

a
pple Tends to simplify 
where connectors are 
concerned; the original iMac 
obliterated old-school ports 

in favour of USB, and the new MacBook 
Pro has only USB-C/Thunderbolt 3 and a 
headphone jack. However, Macs have 
featured various display connectors over 

the past decade or so, and their different 
capabilities potentially complicates 
buying a display.

If you have a new MacBook Pro 
and the money, go for a Thunderbolt 3 
display. They’re pricey, but look great 
and simplify connectivity – including 
data for their USB ports – to a single 

cable. However, you’ll find cheaper 
options from the likes of Dell, which 
also tend to offer a larger selection of 
ports. For example, Dell’s U2715H 
has HDMI, Mini DisplayPort, and 
DisplayPort, enabling it to work with 
a wide range of recent (and not so 
recent) Macs. You would just have to 
ensure before buying that your Mac’s 
capable of driving it – see “What your 
Mac can do” to the left.

Be mindful of optimal resolutions. 
As well as a screen’s size, consider 
its pixel dimensions; if two have a 
2560x1440-pixel resolution but one of 
them is several inches larger than the 
other, content on the bigger one will 
appear less sharp since there are fewer 
pixels per inch. Displays with a high 
pixel density (Apple calls its own 
“Retina display”) vastly increase the 
pixel count, but they are more costly – 
and need a fairly recent Mac to run 
them. See apple.co/29ZPMM9 for info.

apple’s new MacBook 

pros can drive two 5K 

displays. along with 

its own retina 

display, that’s a lot 

of pixels! However, 

before you splash out 

on a new display, be 

aware this capability 

in part comes from 

Thunderbolt 3 ports, 

delivering staggering 

bandwidth. So, you 

need to find out what 

your own Mac’s 

capable of – and the 

older your Mac, the 

more restricted your 

choice will be.

If you can settle 

for a low pixel-density 

panel, even a 2010 

MacBook pro is 

capable of driving 

an external 23-inch 

screen. To see what 

your Mac can handle, 

note its details from 

 > about This Mac, 

then visit everymac.

com. Find your Mac 

listing and read 

the “2nd Display 

Support” section 

under tech specs to 

see what connections 

you can use and the 

maximum supported 

resolution of each. 

>>> dVi

Favors of DVI have existed 

since 1999, arriving on the 

2002 PowerBook G4 and 

Power Mac G4. A year 

later, a Mini-DVI port was 

seen on the 12-inch 

PowerBook G4, and later 

added to other Macs 

before being phased out 

in favor of the current 

Mini DisplayPort.

>>> hdmi

Used in HDTVs, the HDMI 

showed up on the Mac 

mini in 2010. The 2012 

MacBook Pro with Retina 

display and the 2013 

revision to the Mac Pro 

gained an HDMI port. 

Most 2010 or later Macs 

without one can connect 

to a display with an HDMI 

input by using an adapter.

>>>Feature
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multi-monitor tricks

Whatever your 
use, a second 

screen can really 
free up your 
workspace.

T
he key BenefiTs of 
using multiple displays 
are flexibility and focus. 
If you’re a digital artist 

using the likes of Illustrator, 
Photoshop, or Pixelmator, you can 
dedicate one display to artwork. This 
means your work is never covered 
by tool palettes, and your palettes 
residing on their own display means 
more of them can be kept on screen 
at any given moment.

Similar advantages can be had 
in audio and video apps. With Logic 
Pro X, choose Window > Open Main 
Window to open a second window, 
and fiddle with the layouts until one 
display is primarily a mixing desk 
and the other is used for tapping 
out notes. In Final Cut Pro, put the 
viewer on a secondary display to get 
a more detailed, larger look at your 
edit. (Sadly, Apple’s consumer 
equivalents to these apps – 
GarageBand and iMovie – are 
resolutely single-screen only.)

Dual displays are also great when 
you require ongoing access to 
multiple apps. Whether penning a 
potential bestseller or fine-tuning 
a presentation, having one display 

>>> mini displayporT

Mini DisplayPort arrived in 

2008. Initially proprietary, 

it was later rolled into the 

DisplayPort standard. It 

debuted on the aluminum 

MacBook and 15-inch 

MacBook Pro, and was 

added to Apple’s entire 

line of Macs. The 12-inch 

MacBook was then the 

first model to drop it.

>>> ThunderBolT

Originally using the same 

connector as (and 

compatible with) Mini 

DisplayPort, Thunderbolt 

arrived on the 2011 

MacBook Pro. It can carry 

both video and data. 

Thunderbolt 3 uses a 

USB-C connector, and the 

MacBook Pro with Touch 

Bar has four such ports.

>>> usB-C

Apple’s 2015, 12-inch 

MacBook was the first 

Mac to include a USB-C 

port. Like Thunderbolt, it 

can carry video and data 

(and also power), but the 

data connection isn’t as 

fast. After its late 2016 

addition to the MacBook 

Pro, expect new Macs in 

2017 to adopt USB-C, too.

devoted to an office or writing app 
and another for research can be 
efficient. If you use a minimalist 
word processor such as iA Writer, 
you can have that fullscreen on your 
MacBook, turning it into a futuristic 
typewriter, while a larger display 
contains Safari, a mind-mapping 
tool like MindNode, or inspirational 
imagery in Preview. Similarly, if you 
use Windows-only software, run it 
in Parallels Desktop on one display, 
leaving the other for macOS; this can 
work well if you’re a web designer 
and need to test sites across 
browsers on both operating systems.

Alternatively, you might want to 
monitor data of some kind – to keep 
an eye on your schedule in Calendar, 
rather than switching to that app 
and away from whatever you’re 
doing. Similarly, you might stick 
Mail on a second screen so you can 
glance at emails when they come in, 
rather than getting a notification, 
opening the app, and getting sucked 
into a billion other messages. Or, 
if you hate productivity, go for the 
ultimate procrastination setup of 
using a second display for YouTube, 
Twitter, and Facebook.

Incidentally, whichever of these 
ideas takes your fancy, pay close 
attention to ergonomics. It’s best 
to have your primary display right 
in front of you, your eyes in line 
with the top of the screen. The 
other should be easy to turn to and 
briefly use. If you spend a long time 
interacting with any display that’s 
set at an angle, ensure you can shift 
your chair and input devices 
accordingly. Don’t spend a long 
time twisted in your seat, tapping 
on an awkwardly placed keyboard, 
or you may give yourself back 
problems later on.

Multiple monitors
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Take control

o
ne of the issues 
with using multiple 
displays is that 
managing what’s on 

your desktop can require more 
effort. Stick with vanilla macOS 
and it can become tiresome to 
arrange windows and drag them 
between displays. Thankfully, 
third-party utilities provide you 

with an extra degree of control 
in these key areas. Moom  
($10, manytricks.com) and 
BetterTouchTool (from $3, 
boastr.net) both enable you 
to set up commands for 
manipulating windows. Want to 
drag a window to make it fill half 
of the screen? Done. Swipe with 
five fingers to send a window to 

your other display? Easy. Want to 
use keyboard shortcuts instead, 
to send windows between screens 
and resize them? No problem. 
Read the walkthrough below to 
see how rapidly you can set up 
such behaviors.

For switching display 
resolutions, we recommend 
Resolutionator ($3, bit.ly/ 
2iNxkHL). Normally you have 
to go to System Preferences’ 
Displays pane, move the pointer 
to the relevant screen and then 
hunt for a new resolution. 
Resolutionator simply requires 
you to click its menu bar icon and 
select a new resolution from the 
submenu that corresponds to the 
screen on which you want to set 
a new resolution.

There’s also an optional 
system-wide shortcut for 
bringing up a switcher window 
that can be controlled by 
keyboard – so, as with Moom or 
BetterTouchTool, you don’t have 
to remove your hands from the 
keyboard to make adjustments.

Another type of dual-screen 
setup is rather different. Duet 
Display ($19.99, duetdisplay.
com) is actually an iPad app that 
talks to a free companion app on 
your Mac. You connect your iPad 
and Mac using a Lightning cable, 
whereupon Duet turns the 
iPad into a display for the Mac. 
The iPad’s Retina display 
means the resulting visuals 
can be pin-sharp (though 
there’s a touch of lag at higher 
quality settings). Duet becomes 
really interesting on macOS 
10.12.2 or higher, where it can 
mimic Apple’s Touch Bar tech, 
enabling you to try a brand-new 
control method.

One nuisance in having a ton 
of screen real estate is finding 
the pointer, but there’s a solution 
baked into macOS. In System 
Preferences’ Accessibility pane, 
select Display on the left and 
ensure “Shake mouse pointer 
to locate” is enabled. If it is, 
wiggling the pointer temporarily 
enlarges it.

Manage 
WindoWs on 

Multiple 
displays 1

use moom

In Moom’s preferences, click 

Custom then + (bottom left) to create a 

new shortcut. Set it to Move & Zoom and 

fill the right side of the grid. Click the box 

to the top right of the grid and press 

≈+Alt+‘. Now when you use that 

shortcut, the current window will resize 

to fill the right half of the display.

2
moVe BeTween displays

Create a second shortcut and set 

its behavior to Move to Other Display. 

Click the rightmost button in Direction 

and then enable “Loop through displays.” 

Set the shortcut to ≈+ß+‘. Each 

time you press this key combo, the 

current window will move to the next 

display, eventually coming full circle.

Third-party utilities 
provide you with extra 
control over arranging 

windows across 
multiple displays

>>>Feature

46   apr 2017  maclife.com



accessorize!

>>> noTeBook sTand

You may want to raise your MacBook 

off the desk so it’s more comfortable 

to glance at when focusing on the 

larger external screen. Consider 

Griffin’s Elevator stand ($40, bit.ly/

griffin_elevator), or Lavolta’s laptop 

table ($23, bit.ly/lavoltatable).

>>> Vesa mounT 

adapTer

If your display is 

compatible, you could 

use a VESA mount 

adapter ($25, bit.ly/

vesa_adapt) to hang 

the monitor on a wall. 

Research the right 

mount, check your 

wall – and ensure the 

monitor’s vertical 

position will be just 

right prior to drilling.

>>> apple’s magiC 

aCCessories

If you’re adding a second 

display to a portable Mac, 

it pays to make it bigger 

than the built-in one, and to 

put your MacBook to the side 

and invest in other input 

devices you can position 

centrally. Though other 

options exist, Apple’s Magic 

Keyboard and Magic 

Trackpad 2 are very nice – 

however, they’re not cheap 

at $99 and $129 respectively.

>>> logiTeCh C920 hd

Most monitors don’t come 

with a webcam. You can, 

of course, get by using 

FaceTime or Skype 

through your MacBook’s 

built-in camera (or use 

an iPhone), or you could 

opt for propping a 

webcam on your larger 

external monitor. 

Logitech’s are among the 

best; the C920 webcam is 

$63 (bit.ly/logi_c920).

3
TesT and expand

Open a Finder window and press 

the shortcut from step 2 a few times. Try 

interchanging it with the shortcut from 

step 1. Open Mail and put it on your Mac’s 

second screen, open a new message by 

pressing ç+N, and move it to your 

other screen. Powerful, huh? Now add 

any other shortcuts you want.

4
use BeTTerTouChTool

You can add similar functionality 

to a trackpad. In BetterTouchTool, select 

Trackpads, click Add New Gesture and set 

the gesture to 5 Finger Swipe Right. Click 

the Predefined Action pop-up and pick 

Move Window to Next Monitor. Just as 

with Moom, performing this gesture 

repeatedly will take a window full circle.

5
moVe and resize

BetterTouchTool offers two more 

actions for moving a window between 

displays: Maximize Window to Next 

Monitor makes it as big as possible (but 

doesn’t switch it to full-screen mode); 

Center Window on Next Monitor centers 

the window on the next screen as soon 

as it’s moved there.

Multiple monitors
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>>> aoC u3277pwQu 

>>> BenQ pd3200u 

>>> lenoVo ThinkVision x1

T
here’s noThing quite like a 
large, high-resolution display, 
especially if you work with 
graphics. 4K monitors have 

been around for a while, and some of the 
latest models are showing the benefits of 
this maturity, but the price drops we’ve 
seen for these screens over the last couple 
of years have slowed. They’re great for 
serious work, but they’re not cheap. 

A 4K monitor usually has a resolution of 
3840x2160 pixels, a scale that falls into 
the “Ultra High Definition” (UHD) class. 
You can drive a 4K monitor from pretty 
much any Mac made in the last three or 
four years, although running at 60Hz 
rather than 30Hz can present a challenge. 
See apple.co/29ZPMM9 for more details.

The “4K” label doesn’t define the 
physical size of the display, which is 
why in this test we’ve included a 27-inch 
model alongside two enormous 32-inch 
screens. Technically, none of these are 
actual Retina-class displays, but the 
“smaller” screen packs in an impressive 
163 pixels per inch.

At this level you could choose to work 
with Apple’s “larger, sharper” display- 
scaling tricks, or run as a large, fine- 
grained desktop. Two of the models we 
look at use IPS technology and one uses 
VA. See “Things to Consider” opposite 
for what this means in practice.

One of the monitors in our test 
boasts a built-in webcam, and one can 
automatically dim and even blank the 
monitor if nobody is in front of it for a 
while. But remember these are extras. 
Whether you’re a professional graphic 
designer or someone with wider-ranging 
requirements, if you’re looking for a good 
4K monitor then you’ll be demanding a lot 
from the display itself. That’s why we’ve 
made image reproduction quality our 
overriding priority.

>>> how we TesTed

The image rendering 

and fidelity of these 

displays is critical. 

We tested each one 

using a Datacolor 

Spyder5Elite 

colorimeter, using it 

to assess the color 

accuracy in particular. 

We also assessed how 

easy it is to use the 

on-screen controls 

to make adjustments. 

Features such as 

speakers are nice, 

but accuracy of the 

display itself is the 

bottom line.

Whether you do top-end image 
editing or just want to bask in 
high-res glory, Keith Martin tests 
three of the best 4K displays

>>>Feature
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Things to consider

>>> The Big 

QuesTion:  

ips or Va?

IPS (In Plane 

Switching) panels 

are more expensive 

to make than VA 

(Vertical Alignment), 

but they handle wider 

viewing angles. With 

large VA panels, 

looking from the 

center to sides can 

show contrast shifts.

>>> 60hz 

ConneCTion 

Challenge

Running at 60Hz 

gives a smoother 

experience. Sadly, 

at 4K this needs 

HDMI 2.0, which Macs 

still don’t have, or 

DisplayPort 1.2. Use a 

Mini DisplayPort cable, 

or a USB-C to HDMI 

2.0 adapter with the 

latest MacBook.

>>> more spaCe or 

more VisiBiliTy

You can adjust your 

display to run in pixel-

for-pixel “more space” 

mode, where there’s 

acres of room but 

everything looks fairly 

small, or with macOS 

scaling things 

smoothly so that they 

render at normal size 

but in greater detail. 

It’s up to you.

>>> 10 BiTs are 

BeTTer Than 8

Monitors that work 

internally with 10 

bits per color, rather 

than the standard 

8 bits, are able to 

render subtle color 

gradients without 

visible banding – 

over 1 billion colors, 

in fact. All three 

displays featured here 

process 10-bit color.

>>> personal 

speakers

While all of these 

monitors have built-in 

speakers, don’t expect 

too much from them 

in terms of audio 

quality. They’ll do at a 

push for simple audio 

feedback or perhaps 

dictated text, but 

they’re really not built 

for hi-fi purposes such 

as playing music.
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All three screens here are fairly sleek, sporting the traditional 

monitor fashion of varying shades of mid or dark gray. Regardless, 

they all look good enough to grace a high-end studio. It’s the 

Lenovo in particular that looks eye-catchingly thin – particularly 

at the top. Both the AOC and BenQ displays are relatively angular, 

almost industrial from the side, and with bezels that look solid but 

not obtrusive. The Lenovo display is a bit of a curious one in terms 

of appearance. Its speakers are behind a grille array that runs along 

the bottom of the display, and are thus far more obvious than any 

other speaker arrangement – but they’re still very stylishly done. Its 

webcam is surprisingly functional; it sits on a slim articulated arm, 

and can tilt to face the desk to scan docs, with its own LED light.

The initial setup of a monitor is something you’ll probably only do 

once, but it’s important that it doesn’t frustrate. The AOC needs 

a crosshead screwdriver and a soft place for the screen while you 

affix its stand, but the others are simpler. They all have tilt 

adjustment, but only the AOC and BenQ add swivel, height 

adjustment or the rarely-used portrait rotation. It’s the on-screen 

display controls (OSD) and control buttons that you’ll deal with 

most. BenQ uses a touch-sensitive bezel with LED bumps that help 

fingers find the spots. Many monitor manufacturers opt to tuck the 

buttons out of sight, which obviously looks sleek but is pretty 

unhelpful in use. In contrast, Lenovo’s designers really considered 

the user: its buttons are easy and clear, including volume control.

Because 4K displays appeal particularly to 

designers, video editors, and anyone else who works 

with large visual projects, the quality of the display 

itself is critical. We’ve tested these screens in both 

moderately low and office-level ambient lighting. In 

addition, each screen warmed up for an hour before 

we ran our tests to ensure full stability of the image.

Our Spyder5Elite colorimeter tests showed that, 

while none of these displays achieved full coverage 

of the Adobe RGB color space (no surprise, since 

that’s a rare thing indeed), the 32-inch AOC came 

much closer than other two. The BenQ and Lenovo 

both managed 80% coverage.

However, the AOC’s higher score is actually 

undermined by its VA panel. This means you must 

sit face-on to see colors and contrast accurately. 

With a screen this wide, that’s not possible, so things 

will always look a little different in different parts. 

For gaming that’s not a big deal, but any kind of 

graphics creation can suffer.

Contrast ratio, the difference between darkest and 

lightest tones, is an interesting statistic. It’s tossed 

around a lot, and high ratios can make a difference 

in brighter environments. We noted scores at 50% 

brightness in particular as that’s likely to be a real-

world average brightness setting. AOC’s display 

achieved 1330:1, a score almost twice as high as the 

rest, so if your environment is strongly lit and can’t 

be muted, this will hold out better. This is almost 

certainly due to the use of the aforementioned VA 

panel type, a technology which generally produces 

a far greater contrast ratio than IPS. However, the 

scores of the BenQ and Lenovo are more than good 

enough in typical conditions. This is partly related to 

absolute brightness. The best brightness level 

setting is one that balances with your surrounding 

ambient lighting. Pushing a display to its maximum 

brightness in lower lighting conditions is dazzling 

and can interfere with color perception, so in 

practice, the contrast ratio difference matters less.

Test 1 design

Test 3 ease of use

Test 2 picture Quality
Mirror mirror on the wall, 
who is the sleekest one of all?

Ease of setup and day-to-day use 
are important to bear in mind

Screen quality is critical 
for large displays

AOC U3277PWQU 

BenQ PD3200U 

LenOvO ThinkvisiOn X1 

AOC U3277PWQU 

BenQ PD3200U 

LenOvO ThinkvisiOn X1 

AOC U3277PWQU 

BenQ PD3200U 

LenOvO ThinkvisiOn X1 

>>>Feature
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A close-fought race with good contenders

All three monitors have very good 

points. The unneveness of the AOC 

U3277PWQU’s VA panel technology 

puts it out of the running, despite the 

impressive contrast ratio, but it’s still a 

useful screen in general. Ultimately, 

however, it didn’t impress quite as much 

as the other two: the Lenovo ThinkVision 

X1 and the BenQ PD3200U.

The BenQ 32-inch 4K display is easy to 

set up, performs very well and has loads 

of ports, including an SD card reader. It’s 

a display any professional would love to 

use. It is, however, quite a step up in cost, 

and that money could be used for other 

accessories and cables. 

The Lenovo is the cheapest here, but 

it’s impressive: the display quality is 

excellent and the panel itself is super 

slim. It’s the extras that bring it to the 

front; the speakers are more than a basic 

gesture at sound, the controls have been 

thoughtfully designed, and the webcam 

can act as a document scanner. It’s a 

great display with features that set it 

apart from the crowd. 

This IPS-based display is impressively slim, 
performs very well, and the webcam’s 
usefulness surprised and impressed us.

The Winner lenovo ThinkVision x1

The sPeCs AOC U3277PWQU BenQ PD3200U LenOvO  

ThinkvisiOn X1

PriCe $699 $898 $684

DisPLAy POrTs HDMI, DisplayPort,  

DVI, VGA

2x HDMI, DisplayPort, 

mini-DisplayPort

HDMI, DisplayPort

UsB 4 (+ 1x USB 3.0 Type B) 4 (+ 2x USB 3.0 Type B) 4 (+ 1x USB-C)

PiP/PBP Yes Yes No

TiLT Yes Yes Yes

sWiveL Yes Yes No

heighT 

ADjUsTmenT

Yes (5.1 inch) Yes (5.9 inch) No

PivOT Yes (90 degrees) Yes (90 degrees) No

WeBCAm No No On slim arm, 

fully positionable

vesA-mOUnT 

COmPATiBLe?

100mm VESA-compatible 

mount sockets

100mm VESA-compatible 

mount sockets

100mm VESA-compatible 

mount sockets

COnTrAsT AT 50% 

BrighTness

1330:1 700:1 720:1

WeighT (LBs) 22 18.7 14.1

PAneL TyPe VA (Vertical Alignment) IPS (In Plane Switching) IPS (In Plane Switching)

PPi 138 138 163

% Of ADOBe rgB 92% 80% 80%

OverALL

Multiple monitors
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at a fraction of the cost.

Get the DiGital eDitiOn Get the Print eDitiOn
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Get both the Print & 
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It’s easy to subscribe… 
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Living with 
other people can 
be a challenge, 
especially when it 

comes to sharing household 
expenses or settling up after a 
night out. Factor in roommates 
who are night owls or hardly 
ever home, and it’s easy to see 
how money causes stress for 
renters who split bills.

Available as a web app as 
well as for Android devices, 
Splittable is a free iPhone app 
that reduces this potential 
friction by putting everyone 
on the same page. Whether 

it’s rent, utilities, 
groceries, or other 
shared expenses, 
you’ll always know 
where everyone 
stands thanks to 
the All Square Meter, 
a dashboard that 
shows at a glance 
who owes money.

To get started, set 
up a house, then add 
the relevant costs and 
who’s responsible for 
them. When a new 
purchase is made, 
Splittable notifies 
each roommate with a 

Splittable
Get your shared finances in order
Free  Developer Locatable Ltd, splittable.co

Platform Universal  Requirements iOS 9 or later

SPLITTABLE

   Free app for keeping track of  
shared costs among roommates

   All Square Meter shows where 
everyone stands at a glance

   No payment processing (planned  
for future updates)

   Adding new costs requires  
too many steps

good 

Splittable’s All 
Square Meter is 
a dashboard that 
makes it easy to 
see at a glance 
which roommates 
still owe money.

push notification as a reminder 
to pay their share. Clearly 
aimed at college students 
and young professionals, the 
basic premise also applies 
to unwed couples or even 
spouses living under the 
same roof who maintain 
separate bank accounts.

Splittable can’t currently be 
used to make actual payments 
– the app simply keeps track 
of who owes what. But the 
developers are working on 
payment integration, first 
in the UK with an eventual 
international rollout. We were 
treated to an advance look at 
this feature, and it has real 
potential to make the whole 
process as easy as PayPal, 
Venmo, and Square Cash.

For the time being, 
Splittable users must be 
content collecting money the 
old-fashioned way. There are a 
few improvements we’d like to 
see, such as the ability to check 
off costs as they’re paid, rather 
than waiting until the due 
date. Also, adding a new cost 
requires hopping between a 
few too many screens.

You’ll need to sign up for an 
account or use a Facebook login 

to get started, and for now 
the clean, well designed user 
interface is free of ads or other 
intrusions; hopefully that will 
remain the case down the road. 
Finally, we were a little put 
off by the initial setup wizard, 
which forces you to add a 
cost or payment before you 
have a chance to get the 
hang of things.

the bottom line. Splittable 
puts an end to keeping tabs on 
how much roommates owe for 
shared costs, but you’ll still 
have to collect payments the 
old-fashioned way for now.  
J. R. booKWAlteR

You still have to pay roommates the 
old-fashioned way for the time-being.
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You may wonder why you’d 

need a third-party weather 

app in the first place. As it 

turns out, there are lots of 

reasons: maybe you do a lot of work on 

your iPad – and the default Apple 

Weather app isn’t available for the iPad; 

maybe you want something that shows 

a lot of information in a small space. 

Whatever the reason, Weather Line has 

a lot of great stuff to offer.

The app is really easy to use: input 

your location and be greeted by a sleek 

interface that can be read at a glance. 

It displays information clearly on a white 

background for optimum visibility, and 

If you have a large digital 

video collection, watching 

shows and movies on an 

iPhone, iPad, or Apple TV 

can be an exercise in frustration. Devices 

are limited in what can be stored at any 

given time, and using iTunes to transfer 

files is the opposite of fun.

Infuse Pro 5 provides a better way. 

Point the app at specific folders on your 

network or a cloud service and it will 

present a list of items to play, then 

stream your selection to your device.

From a visual standpoint, Infuse is 

a treat. On iOS and tvOS, folders are 

represented as large thumbnails – 

Weather Line
Graphs make everything better!
$2.99  Developer Off Coast, weatherlineapp.com

Platform Universal  Requirements iOS 10 or later

Infuse Pro 5
Get your videos on all your devices
$12.99  Developer FireCore, firecore.com

Platform Universal  Requirements iOS 8 or later

awesome 

great 

Weather watchers can pore over all sorts 
of monthly and yearly information.

Split View and Picture in Picture support on 
iPad is a welcome addition to Infuse Pro 5.

the infographic-style presentation of 

data gives you everything you need to 

know instantly. You’ll be able to see the 

weather throughout your day, as well as 

the projection for the week, and there’s 

a smart feature that allows you to see  

averages for specific months of the year. 

Worried about precipitation? Check out 

what sort of rainfall-related weather 

you’ll be in for over the next hour, from 

clear skies to heavy rain and everything 

else in between.

We find Weather Line to be an 

improvement over the standard Weather 

app, especially for those who like to plan 

their events using weather projections, 

or cover art if the app correctly 

interprets the file name. When it doesn’t, 

you can edit the video’s title – handy 

should your adorable “toddler and dog” 

video be erroneously listed as “Edge of 

Darkness” for some reason.

This latest release has further niceties. 

On Apple TV, you get a home screen that 

highlights in-progress and recently added 

items. On iPad, there’s Split View and 

Picture-in-Picture support. Cross-device 

sync worked seamlessly during testing.

From a performance standpoint, 

the app fared well, too. Playback was 

generally snappy, although shared 

folders took a long time to appear on 

and a nice alternative to Dark Sky 

Weather, which uses the same highly 

accurate forecast data.

the bottom line. Both functionally 

and aesthetically pleasing, Weather Line 

is a brilliantly designed app to keep you 

abreast of the weather. AmbeR neely

an Apple TV. Subtitle support worked 

very well, too, automatically being 

downloaded for films and shows lacking 

local subtitle files.

the bottom line. A solid, great-

looking and versatile streaming video 

player for both iOS and tvOS. 

CRAig gRAnnell
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Exacto has one real 
aim: to bring a pen 
selection tool (very 
much like the one 

in Photoshop on desktop) for 
cutting out parts of an image 
to iOS. This isn’t an option in 
Photoshop Mix or Pixelmator. 
The latter app does have other 
selection options, but not this 

particular and precise 
tool, so Exacto looks to 
be a useful addition to 
a mobile photo editing 
suite. And it works… 
but not perfectly. 

The way the pen 
selection tool works is 
that you tap around the 
outline of the subject 
you want to cut out, 
which adds End points. 
Each time you tap, 
you’ll add another End 
point, connected to the 
last by a dotted line, 

Exacto – Photo Cut
A more advanced image cut-out tool?
$2.99  Developer Samer Azzam, exactoapp.com

Platform Universal  Requirements iOS 8 or later

You can see your full 
selection in previews, 
and easily invert it.

Exacto - Photo cut

  A pen selection tool on iPad!

  Overall good results

  Awkward export and layers get lost

   Issues with selection process

SoLID 

which is the cut-out. Between 
the End points are Control 
points, and these are key. You 
can move Control points to 
curve the line between End 
points, so by adding plenty of 
points, you can get a massively 
clean and precise cut-out line 
– more deliberate than any of 
Pixelmator’s cut-out options, 
though it’s much slower to do 
and requires more finesse.

Once you’ve finished 
polishing the cut-out line (you 
can easily preview it along the 
way), you can then remove 
either the inside or the outside 
of the selection. You can also 
create a new layer and cut out 
a separate object. Finally, you 
can export the cut-out image 
to another app, or save it to the 
Camera Roll.

The problems come in the 
little details, mostly. Exporting 
is much more awkward than it 

needs to be, and when we 
sent a multi-layer image to 
Pixelmator, it arrived in one 
layer regardless. Limitations in 
iOS sharing mean you can’t use 
multiple exports to get around 
this – you’d need to save each 
layer to the Camera Roll 
individually, clogging up your 
Photos app.

We also experienced a pretty 
annoying bug where End 
points were being added out 
of order, making it a chore to 
build our outline. The manual 
“+” button helped a bit here, 
but we were really slowed 
down. We also don’t like that 
you have to a tap a point to 
select it before you can 
manipulate it when using the 
Pencil (though this is sensible 
on iPhone). And we’d also like 
to see an option to feather our 
cut-outs’ edges in the future, 
to produce a smoother result.

the bottom line. An app 
that does what it sets out to do, 
but with some feature issues 
and small bugs. If these can be 
worked out, this could be a 
great tool. matt bolton

With a bit of care 
you can produce 
some excellent, 
crisp cut-outs.

56   Apr 2017  maclife.com



Digital photography has 

made us a little bit lazy, 

as we don’t have to worry 

about the limitations of film 

or the process of developing our own 

pictures. As would follow, some of us 

have let our skills slip a bit. 

Darkr is an app that is designed to 

emulate the feeling of working in a real 

darkroom, and hopes to help you take 

better pictures. The app only shoots 

images in black and white, but the results 

are so striking that we didn’t mind.

Getting to know Darkr is a bit intense. 

There are a few different cameras to try 

out, each offering different amounts of 

The original Pic Scanner was 

one of the most convenient 

ways to scan multiple photos 

and share them with friends. 

Since then, rivals such as Scanbot and 

Unfade have improved the process, but 

developer App Initio Limited isn’t taking 

this challenge lying down.

Pic Scanner Gold works the same way 

it always has: point your iPhone or iPad 

at one or multiple photo prints, tap the 

shutter button, and the app does the rest, 

cropping images into separate files 

stored inside the app’s gallery. From 

there, users can organize pictures into 

share-ready albums, export to cloud 

Darkr
Relive the days of analog photography with Darkr
Free ($2.99 IAP for Pro version)  Developer Marcus Carlsson, miliam.net

Platform Universal  Requirements iOS 8.1 or later

Pic Scanner Gold
Not everything that scans in is gold…
$4.99  Developer App Initio Ltd, picscannergold.com

Platform Universal  Requirements iOS 9 or later

great 

solid 

Darkr details how the app functions as it 
works, including an explanation of analog tech.

Do more with your scanned photos, including 
slideshows, greeting cards, and craft ideas.

control, allowing users to manually 

control focus and exposure, as well as 

set the contrast in the darkroom. The 

idea is that if you have to slow down the 

process, you’ll be more mindful of the 

photographs you’re taking, and thus take 

better photographs. We’d have to agree, 

as we’ve been very pleased with the 

results so far.

We suggest you take the time to 

read the tutorials. While they may seem 

a little excessive at first, you will get a 

far better result than if you were to go 

in completely blind. If you do forget 

something, Darkr allows you to go 

back and view the tutorials again.

storage services, order greeting cards, or 

view brief tutorials for photo craft ideas.

The “View Caster” feature presents all 

your scanned photos in a Viewmaster-

style slideshow complete with music; the 

Showtime feature works similarly, but on 

a per-album basis. Sadly, there’s no way 

to choose music from your own iTunes 

library, or even pick a general theme 

from the built-in royalty-free cues.

Although Pic Scanner Gold boasts 

enhancements in image quality, they’re 

largely negated by limitations in core 

scanning functionality, which lacks the 

automation and precision of rival apps. 

There are now 19 Creative Cloud-powered 

If you’re looking to improve your 

photography, Darkr will help you create 

stunning results while teaching you how 

to properly compose photographs.

the bottom lIne. Daunting at first, 

Darkr quickly guides users to taking 

better photographs. AmbeR neely

image-editing tools available, but none 

does the kind of basic enhancements 

necessary to restore old photos properly.

the bottom lIne. Pic Scanner 

Gold takes a few steps forward, but fails 

to keep pace with progress made by 

newer rivals. j. R. booKWAlteR
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Astropad is an app 
that links your iPad 
and Mac together: 
the iPad displays 

whatever program you’re 
running on your Mac, and 
whatever you draw with a 
stylus on your iPad appears 
on your Mac.

Last year’s Astropad 
Standard app enabled you to 
do this with a variety of iPad 

Astropad Studio
Draw on your Mac with an iPad Pro
$64.99/year, $7.99/month  Developer Astropad, astropad.com

Platform iPad  Requirements OS X 10.10 or later, iPad Pro, Apple Pencil

Turn your iPad Pro into 
a graphics tablet with 
Astropad, which enables 
you to draw directly into Mac 
software such as Photoshop.

AstropAd studio

  Easy to set up, reliable to use

   Gestures make drawing fluid 
and flowing

   This version only works with iPad Pro

   Subscription-only

greAt 

models and any stylus you 
owned. Studio, however, works 
only with iPad Pro and Apple’s 
Pencil. Another important 
difference is that Standard 
costs a one-off payment of 
$29.99, but Studio is only 
available through a monthly or 
annual subscription, managed 
through an online account. 
It’s clear that Studio is a 
professional solution, aimed at 
working artists and designers 
who expect to be drawing for 
hours every day.

Setting everything up is a 
chore, simply because of the 
number of components you’re 
working with. First, create your 
Astropad Studio account and 
set up your subscription. 
Next, download and install the 
Astropad app on your Mac and 
the Astropad Studio app on 
your iPad Pro. Now run both 
apps: as long as your Mac and 

your tablet are on the same 
network, they’ll recognize each 
other and your Mac screen will 
be reproduced on your iPad 
Pro. Of course, all this only 
needs to be done once.

The combination works well 
in practice. If you link your 
iPad and Mac with your iPad 
charging cable, the connection 
between the two screens feels 
instantaneous. If you decouple 
the iPad and link through 
Wi-Fi instead, you might 
notice a lag between the Mac 
screen changing and the iPad 
screen updating, depending on 
the speed of your wireless 
network. We were never 
excessively bothered by the 
time lag, though.

The exclusive use of iPad 
Pro and Pencil means that 
Astropad Studio has several 
extra features compared with 
Standard. For example, 
Studio’s Magic Gestures 
feature enables you to combine 
finger tap and Pencil gestures 
to trigger responses, including 
simulating a right-click or 
switching between tools.

the bottom line. State of 
the art, but you might prefer 
the Standard edition’s pricing 
if you’re a more casual 
sketcher. RichaRD hill

You can combine 
finger touches 
with Pencil 
movement to 
trigger shortcuts 
such as 
simulating a 
right-click. 
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Old-school point-and-click 

adventures often didn’t 

make much sense – combine 

the kitten with the doorknob 

to make moonshine, or whatever – but 

Milkmaid of the Milky Way does it in a 

way that grates more than usual.

For starters, Milkmaid is written 

entirely in verse, and it’s terrible. The 

meter changes all the time, and the 

rhymes often feel forced, like “this 

put me in a squeeze. What about my 

mountain cheese?” It’s just unnecessary, 

feels gimmicky, and distracts from the 

game – there’s quite an interesting plot 

behind all the bad rhymes.

Mysterium is fantastic – a 

board game in which all the 

players but one are trying 

to solve a murder, and that 

last player is the ghost of the murderee, 

attempting to tell them what happened 

without being able to speak, only being 

able to show them frustratingly obtuse 

and abstract pictures. 

Let’s say the murder weapon was 

poison, and the ghost picks a card with 

a well in it – signifying liquids, obviously 

– but the other players are convinced 

that the well represents the knife, 

because the metal bucket in the image 

could be the knife’s metal. Meanwhile, 

Milkmaid of the Milky Way
We’ve got no time for needless rhyme
$3.99  Developer Mattis Folkestad, machineboy.com

Platform Universal  Requirements iOS 9.1 or later

Mysterium
A fun game that stumbles on iOS
$6.99  Developer Asmodee Digital, asmodee-digital.com/mysterium

Platform Universal  Requirements iOS 7 or later

OKAY 

sOlid 

The verse is unnecessary and cringeworthy. 
Just stick to regular words!

As the ghost, you’re trying to help people pick 
the right culprit – it’s really difficult.

It’s also pretty tedious to play, with the 

character having to run across several 

different screens to get to where she 

needs to go, which isn’t helped by the 

fact that the items you need to pick up 

are often hard to see, and the things you 

need to do with those items are even 

more obtuse. At one point you need to 

put logs on a mountain to dry. How are 

you supposed to know that?

There are some redeeming qualities – 

the style, though minimalistic, is nicely 

done in places, and the way the plot 

twists early on is a surprise. For fans of 

Lucasarts point-and-click games, there’s 

a tingle of nostalgia that may override 

the ghost is tearing out their hair, 

unable to correct them.

Mysterium is very much worth playing,  

but is not as compelling in this version. 

There’s a one-player story mode that 

you play to learn the rules, but playing 

the game with AI is impossible – they’re 

unpredictable and you have no idea 

how smart they actually are. 

The multiplayer mode is fine, but 

it requires you to register an account 

with Asmodee, and though the art is 

good, it’s so much better in person 

where you can appreciate the details. 

It’s also pretty hard to find people to 

play with online, especially if you want 

the tedium. However, largely, Milkmaid of 

the Milky Way is a bit of a milk dud. It’s a 

shame that the game’s qualities couldn’t 

save it from grating writing and overly 

difficult puzzle solutions.

the bottom line. Attempts to 

replicate classic point-and-clicks, but 

falls short of the mark. Kate GRay

a larger game of up to seven players. 

Granted, the board game version is 

significantly more than the $6.99 iOS 

game, but it’s worth it if you want to 

appreciate this game at its best.

the bottom line. A very good 

board game that doesn’t translate too 

well to mobile. Kate GRay
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The original Don’t 
Starve was a 
masterclass in 
misery, pitting you 

against a hostile landscape in 
which everything – even your 
own brain – was out to get you. 
The new standalone version, 
Shipwrecked, takes that 
concept and sends it off to sea.

As in the original game, your 
goal is essentially to survive 

Don’t Starve: Shipwrecked
Turns out Tom Hanks had it pretty easy
$4.99  Developer Klei Entertainment, kleientertainment.com

Platform Universal  Requirements iOS 8 or later

Hats offer protection from 
the weather, as well as 
some stylish flair.

Don’t Starve: ShipwreckeD

   Loses none of its predecessor’s  
savage charm

   Procedurally generated worlds  
offer a new experience each time

   Interface is perfectly suited  
to playing on iPad

   Autosave function tends to 
temporarily freeze the game

excellent 

as long as possible. You’ll need 
to scavenge for food; use raw 
materials to fashion crude 
tools to help you chop, hack, 
and mine (and murder); and 
make sure you’ve got a fire 
burning by the time night falls, 
lest your sanity take a severe 
hammering. Oh, and don’t 
camp too close to the shore 
– if the tide encroaches while 
you’re distracted, out goes your 
fire and you’re plunged into 
darkness… which can kill you. 
Of course it can.

While the joy of splitting 
your survival workload remains 
from the original (scout by day, 
build camp at dusk, huddle up 
and eat snacks through the 
night), the real fun in 
Shipwrecked comes from the 
exploration. Now, rather than 
being dropped in a hostile 
wasteland, you’re on one 
hostile island among many. 

Each is small enough that you 
can usually scope out the 
whole thing in one day, and 
strip it of its bounties in the 
second, so you’re actively 
encouraged to seek out 
seaweed-logged pastures new.

Your mom apparently never 
invested in swimming lessons, 
so you have to put your trust in 
a hand-hewn vessel, whether 
that’s a rickety wooden raft or 
a fully tricked-out sailboat 
complete with spyglass, 
cannon, and fishing net. Its 
seaworthiness erodes over 
time, so setting out on an 
unknown voyage can be risky 
in an older boat.

Death is permanent, so 
the game is unforgiving, and 
the starting stages can feel 
repetitive. However, fight your 
way through that and it’s 
possible to spend a few hours 
at a time without feeling like 
you’ve scratched the surface. 
Any criticisms? We couldn’t 
find a way to paint a face on a 
basketball and call it Wilson.

the bottom line. An 
expansion that redelivers on 
what made the original great, 
while adding new depth to the 
exploration. emmA DAVieS

Whether on land 
or at sea, the 
Don’t Starve 
games are out 
to test your 
survival instincts.
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Taking a trip can be a logistical 
headache, so download our top six 
apps to make organizing your next 
journey a (sea) breeze.

The first step is, of course, 
booking a flight. Load up KayaK 
(Free, iPhone/iPad) and it couldn’t 
be simpler to track down the best 
deal. Input your original and 
destination airports, plus dates, 
and the app will do the research 
for you. As well as checking out 
the best prices, you can filter by 
myriad options such as stops, 
layover lengths, and aircraft – and 
even see at a glance which flights 
offer amenities such as Wi-Fi. 
Found what you’re looking for? 
One more tap will take you through 
to the booking site. Easy.

After a lengthy flight, the last 
thing anyone wants is an even 
lengthier wait in the customs line. 
With Mobile PassPort (Free, 
iPhone/iPad), you can cut that 
right down. Whether arriving in 
the US via plane or cruise ship, this 
invaluable, officially authorized 

app stores your passport details, 
which can then be submitted at 21 
airports and ports to waltz you 
through a special line.

To save the hassle of sifting 
through email folders to dig out 
bookings, load up triPCase (Free 
with IAP, iPhone/iPad). Once 
you’ve made an account, forward 
any confirmation emails relating 
to your trip, and they’ll show in the 
app. You can keep track of multiple 
vacations, or merge them into one. 
It’s a convenient means of keeping 
transport and hotel details handy, 
along with automatically added 
contact details and flight tracker. 

Once you’ve reached your 
destination, CityMaPPer (Free, 
iPhone) is your buddy. Essentially 
Google Maps on steroids, it enables 
you to plan routes for nearly every 
transportation type in cities all 
around the world – as well as how 
many snacks you could burn off by 
using the more active methods. It 
also integrates support for Uber, 
though not other ride-sharing 
services, sadly.

Sure you’ve got everything? This 
is where PaCKPoint (Free with 
IAP, iPhone) comes in. Input your 
destination, the dates and whether 
you’re traveling for business or 
pleasure. You can then choose the 
activities you’ll be partaking in 
(meals, outdoor activities, 
sightseeing, museums, and so on), 
and the app will use these plus a 
weather forecast to supply you 
with a list of essentials to pack. 
Sadly, it won’t make sure you’re 
under the luggage weight limits – 
you’re on your own there.

And how best to spend your 
meticulously organized trip? Ask 
triP Plans-triPHobo (Free with 
IAP, iPhone). Supply it with your 
travel dates and destinations, and 
then choose whether to add in 
attractions and create your own 
itinerary, or have one sketched out 
for you. If you’re pushed for time  
with a lot to see, this virtual tour 
guide is a great helper. Now, 
where’s the app to magic up the 
funds for our next world trip?

rounduP

6 apps to make traveling easier
Take the pain out of getting from A to B with this collection of downloads

by eMMa daVies

Citymapper’s transport options are well 
detailed, so you can find your way around.

Kayak makes it really easy to plan your 
flights, including any layovers.

TripCase: the countdown to your departure is 
great for indulging your inner kid.
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There are countless apps for 
enhancing mobile photos, but 
few offer the kind of liberating 
freedom that infltr does. With 
just the swipe of a finger, 
shutterbugs can concoct 
millions of different looks 
without scrolling through 
endless menu options. Infinite 
filters can be applied either 
to new shots taken with the 
in-app camera or those 
already in your library.

The latest update adds 
support for Live Photos, 
panoramas, and images 

infltr
Easy photo filter control comes to Watch
$2.99  Developer Yooshr, infltr.com

Platform watchOS, Universal  Requirements iOS 9 or later

stored on Adobe Creative 
Cloud, as well as iMessage 
and Apple Watch. The former 
makes it easy to enhance 
images prior to sending them 
to friends, while the latter 
brings control onto your wrist.

First open infltr on your 
iPhone and tap the Camera 
button, then launch the Apple 
Watch app. Oddly, you can’t 
use your finger on the Watch 
display; instead, you must 
rotate the Digital Crown to 
change filters, and you’ll see 
the filter’s color scheme 
change on both devices 
at the same time.

The Apple Watch app also 
supports Force Touch for 
toggling Live, Flash, Flip, and 
Vignette options, as well as 
on-screen buttons for camera 
shutter and time-lapse. When 
it works, it’s a pretty neat trick 
– but more often, infltr refused 
to connect to the iPhone at all, 
or just wound up crashing on 
Apple Watch.

infltr is also best used 
with the connected iPhone 
on a tripod or another camera 
mount, since it’s more than 
a little awkward to hold 

your smartphone while 
manipulating the Apple Watch 
on your wrist at the same time.

the bottom line. infltr 
makes Apple Watch part 
of your shutterbug fun, but 
there are still a few lingering 
connectivity bugs. 
J.R. bookwalteR

Infltr

  Change live filters on iPhone app

  Remote-control camera buttons

   Frequent crashes and 
connectivity issues

   Awkward to hold iPhone while 
using Apple Watch at same time

solId 

When you want 

to quickly return 

to your last open 

Watch app from 

anywhere else, 

double-press the 

Digital Crown to 

jump over to it. 

Best of all, a 

second double-

press will return 

you to whatever 

you were doing 

originally.

watch tiP

Return to previous app
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Classic racing 

game DONKEY.BAS 

will forever be 

remembered as 

the favorite of IBM 

PC owners in 1981. 

Co-written by 

Microsoft co-founder Bill Gates, this 

classic computer game has now been 

ported to Apple Watch in all its 

original CGA, four-color glory.

The goal is to steer your car clear 

of the donkeys popping up on the road 

ahead. All that’s required is turning the 

Digital Crown to switch between the left 

and right lanes, but believe us, it’s way 

more difficult than it sounds, because 

there’s barely any room to maneuver.

Unlike many other Apple Watch 

games, this one also works on iPhone, 

where you tap the screen to avoid 

oncoming donkeys. In keeping with the 

retro gaming spirit, DONKEY.APP also 

offers sound in all its PC speaker glory, 

and it’s quite a bit louder than what 

you’re used to from a smartwatch.

the bottom line. A faithful 

port of a DOS-era classic, but it’s 

bound to raise your blood pressure.  

J.R. bookwalteR

A smartwatch might 

not seem like the 

ideal device for 

enjoying podcasts, 

but if you like to walk, 

run, or exercise with 

your favorite show on 

the earbuds, you needed to have your 

iPhone along for the ride – until now.

Watch Player is exactly what it 

sounds like: an app for transferring 

favorite podcast episodes to Apple 

Watch and playing them on the go 

without an iPhone. The process is 

simple, but requires first knowing the 

feed URL before subscribing to a 

podcast on the iPhone app. After that, 

download one or more episodes to your 

iPhone and transfer the files to your 

Apple Watch. This process does take 

some time (about 15 minutes for a 

62MB file), but you can queue multiple 

files and let them transfer. Once a 

podcast is on your Apple Watch, tap 

to begin playing, then carry on with 

your favorite activity.

the bottom line. Podcasts take 

a long time to transfer, but this is the 

ultimate in convenience for die-hard 

listeners. J.R. bookwalteR

DONKEY.APP
Watch out for asses on the road…
99¢  Developer XVision, xvision.me

Platform watchOS, iPhone  Requirements iOS 10 or later

Watch Player
Take podcasts on the go
Free  Developer Peter Knapp, peterknapp.me

Platform watchOS, iPhone  Requirements iOS 10 or later

good 

solId 

FUtURe liFe 

Ever wanted to live in the 

future? You can by setting the 

Apple Watch display time ahead. 

First press the Digital Crown, 

then open the Settings app.

tURn FoRwaRD 

Finally, tap the +0 min 

button, then turn the Digital 

Crown to add the desired time 

to the clock. Tap Set, and enjoy 

living in the future.

time aheaD 

Tap the first button, Time. 

Here you’ll find a setting to 

change the display by up to 59 

minutes in the future without 

affecting alerts or notifications.

how to

Set your Watch to 
be a little fast
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N
ikon’s D5xxx range is designed 

for those looking for a few more 

features and greater creative 

control than its more entry-level D3xxx 

range. The D5600 is the latest camera in 

this latter series, replacing the D5500.

Resolution remains at a decent 24.2 

megapixels, with the APS-C-sized CMOS 

sensor again shunning an optical 

low-pass filter in the quest to pull even 

more detail from the data recorded. The 

D5600 also uses the same EXPEED 4 

image processor, with a native sensitivity 

range running from ISO 100 to 25,600.

There’s a 3.2-inch vari-angle 

touchscreen display with a 1.037 

million-dot resolution, although its 

operation has been improved. It now 

offers the frame-advance bar to speed 

up toggling through images, as well as 

a crop function for use during playback.

A new addition is Nikon’s timelapse 

movie function. This enables timelapse 

movies to be captured and put together 

entirely in-camera, with an exposure 

smoothing function helping to even out 

variations in lighting. In terms of video, 

Nikon has disappointingly decided to 

stick with 1080p video capture – with a 

choice of 60p, 50p, 30p, 25p, and 24p 

frame rates – rather than opting for 4K.

The most pronounced difference 

between the D5500 and D5600 is 

the inclusion of Nikon’s SnapBridge 

connectivity. This creates a constant 

connection between the camera and your 

smart device, once you’ve downloaded 

the free SnapBridge app. Using a 

wireless connection, batches of images 

– 2MP JPEG versions to be precise – can 

be automatically transferred from the 

D5600 to your device, or you can select 

individual images to transfer at full size, 

though again this is JPEG-only.

The D5600 sticks with Nikon’s proven 

39-point Multi-CAM 4800DX AF system. 

It may be starting to show its age against 

mirrorless rivals offering ever more AF 

points, but it’s still a solid and accurate 

system when shooting with the 

viewfinder. With the same sensor as 

the D5500, the results from the 24.2MP 

chip didn’t throw up any nasty surprises. 

Resolution is good, with the absence of 

a low-pass filter allowing for intricate 

details to be recorded. Images captured 

at lower sensitivities appear clean, with 

little or no noise present.

the bottom line. A modest 

upgrade, but the D5600 is a capable 

DSLR that delivers great images with 

polished handling. Phil hall

Nikon D5600
Modest updates to a great DSLR
$700 ($800 with 18-55mm kit lens)  manufacturer Nikon, nikon.com

Features 24.2 megapixels, 3.2-inch touchscreen, SnapBridge, ISO 100-25,600

NikoN D5600

  Superb image quality

  Good autofocus

  Touchscreen interface

   Pricey compared 
to rivals

great 

TOUGH TESTING, TRUSTED RATINGS
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To say Quicken has a checkered past on 
the Mac is an understatement. It took 
Intuit nearly three years to make the 
software compatible with Intel processors 
after Apple made the switch in 2009, at 
which point the company started over with 
the stripped-down Quicken Essentials.

Things have improved since. Quicken 2017 
still doesn’t have complete feature parity 
with the Windows edition, but this is easily 
the best Mac release to date.

For starters, Quicken for Mac 2017 has a 
refreshed user interface that’s easier to 
navigate, thanks to the blue header menu 
across the top for quickly refreshing data, 
adding new accounts, or jumping directly to 
Reports, Budgets, Bills, Calendars, or Alerts. 
The sidebar now displays a blue dot next to 
connected accounts to indicate when they’ve 
been updated with new transactions.

If you haven’t kept tabs on Quicken since 
the troubled 2007 edition, the software now 
automatically downloads transactions from 
more than 14,500 banks, includes 12-month 

Quicken for Mac 2017
A personal finance manager worth investing in
$74.99  Developer Quicken, quicken.com

Requirements OS X 10.10 or later

Quicken for Mac 
2017

   Interface improvements 
for easier navigation

   Robust automatic sync 
with over 14,500 
financial institutions

   Lacks complete feature 
parity with Windows 
version

   Still missing features 
from Quicken 2007

excellent 

budgeting, and there’s a free, quite good iOS 
companion app for entering transactions or 
keeping tabs on your money from anywhere. 
Managing investment accounts remains 
a work in progress compared to Windows, 
and a few 2007-era features such as loan 
amortization schedules and automatic 
reconciliation are still MIA.

The good news is, Quicken is now listening to 

what Mac users need and working quickly to fill 

any remaining gaps in functionality. The 
full-fledged Quicken Bill Pay makes a 
triumphant return here (although a $9.99 
per month subscription is required to use it), 
and aside from answering a few security 
questions when adding certain new bank 
accounts, syncing was a breeze. Only a few 
secondary accounts gave us any grief, mostly 
store-branded cards issued by Synchrony 
Bank, which required downloading and 
importing a QIF file rather than maintaining 
an active connection.

Upgrades from older Mac or Windows 
versions can be bumpy, but thankfully 
Quicken 2017 now includes US-based 
telephone support in addition to the previous 
live chat option.

the bottom line. Quicken is back in fine 
form, and the 2017 edition opens a promising 
new chapter. J.R. bookwalteR

Budget your finances for 
the next 12 months with 
Quicken 2017, easily the 
best Mac version to date.

Back and better than ever, Quicken for Mac 2017 offers a 
more streamlined user interface that’s easier to navigate.

>>>Reviews
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At its most basic, Pastebot is a massive clipboard, holding 
up to 1,000 clippings. You can ignore copies over a certain 
size, sync clippings over iCloud, and easily get at them using 
a Quick Paste window invoked using ç+ß+V. The most 
recent 10 copies can be pasted using number keys; or you 
can navigate using cursor keys or the mouse, and can delve 
deep into your clipboard history using the window’s search 
field. This proves responsive and reliable, but it’s arguably 
elsewhere Pastebot’s real magic happens. The main window 
lists data for each clip – origin, size, date, and so on – and 
you can search by these criteria. Favorites can be stored as 
custom clipping sets, and again accessed using shortcuts. 

Best of all are the filters, which rework copied text, for 
example changing its case or transforming words into an 
HTML list. Several are included, but you can also make your 
own. In the right hands, these filters make Pastebot hugely 
powerful, but even when just using the basics, it’s well 
worth the outlay.

the bottom line. A utility that should appeal to the 
widest range of Mac users – and end up permanently 
welded to a great many Macs. Craig grannell

CustomMenu 3 takes a similar approach to the 

Default Folder X utility, adding a global menu that 

can be customized for quick access to favorite 

applications, files, and folders. Just create groups 

from the Customize Menu window, then add your 

desired items. Click on the CM menu bar icon and 

groups and items appear as a cascading menu 

used to navigate, preview, or open files with a 

single click. CustomMenu 3 offers two submenus 

for recent items and a switcher for hopping 

between running applications. Hovering on a file 

displays a preview as well as basic info (file type, 

size, and date created/modified); users also have 

the option to open files with applications other 

than the default, or reveal files in the Finder.

One feature we’d like to see is the ability to 

customize folder names – if you have multiple 

folders with the same name on different volumes, 

there’s no easy way to differentiate between them.

the bottom line. An affordable alternative 

to Default Folder X. J.r. bookwalter

Pastebot
Infinite clipboards for your Mac
$9.99  Developer Tapbots, tapbots.com/pastebot

requirements OS X 10.11 or later

CustomMenu 3
A global menu utility for Mac
$7.99  Developer PointWorks Software Dev, 
pointworks.de/software/custommenu-3

requirements iOS 10.11 or later; 64-bit processor

Pastebot

  Feature-rich

  Usable yet deep

  Can opt-out apps

  Filters are superb

awesome 

Custommenu 3

  Customizable groups and items

  Submenus for application switcher and recent items

  Can’t customize names for added items

   Global menu isn’t available directly from 
the Open and Save dialogs

good 

Tough testing, trusted ratings

 maclife.com  apr 2017   67



Let’s face it: university life isn’t always 
the wild free-for-all depicted in Hollywood 
movies. It’s also a lot of hard work and long 
study hours, which require intense focus and 
educational commitment.

Student Assistant Prof (“Professional”) 
is a Mac app to help organize your schedule 
and visualize the studies and homework 
necessary to excel. The user interface is 
straightforward and easy to understand, 
although not always designed with American 
students in mind; for example, the software 
only displays 24-hour military time, 
although dates do appear in the US-friendly 
“month before day” order.

The application is divided into three main 
screens, each represented by a shortcut in 
the left-hand sidebar: Timetable, which 
displays details for each day’s events in a 
weekly calendar view; Journal, where you 
keep track of attendance and assigned 
grades; and Teachers, an address book with 
email, phone, Skype, and Facebook contact 
information for educators and their subjects.

Student Assistant Prof
Organize your college life – the academic part, that is
$24.99  Developer Academ Media, academmedia.com

Requirements OS X 10.11 or later

Student 
ASSiStAnt ProF

   Calendar and organizer 
specially designed for 
college students

   Automatically averages 
attendance and grades

   Built-in teacher 
contacts

   Expensive

good 

In Timetable view, classes display relevant 
information such as date, time, subject, 
teacher, and event type (regular or exam), 
with 10 assignable colors and 48 different 
icons to help differentiate between them at 
a glance. The process works a lot like regular 
calendar apps, complete with a recurring 
schedule option.

Journal allows students to create a group 
from different subjects, as well as add 
sub-journals for tracking homework and 
grades for quizzes or exams. The software 
also automatically calculates an average 
attendance and grade as info is entered.

The software comes preloaded with demo 
data including subjects, schedule colors, 
icons, and teacher assignments that help you 
get up to speed quickly; at any time, you can 
purge this data and replace it with your own.

Aside from the Euro-centric time display 

and occasional interface misspellings (for 

example, “ungroupped” instead of “ungrouped”), 

Student Assistant Prof is a useful tool in any 

college student’s arsenal. It’s a bit on the 
expensive side, but there’s a free ad-
supported version also available, which can 
unlock the full version via In-App Purchase 
for a more affordable $9.99.

the bottom line. It’s a little pricey, but 
Student Assistant Prof provides the tools 
necessary for surviving your college studies. 
J.R. bookwalteR

Student Assistant Prof 
makes it easy to schedule 
and manage all your 
classes, grades, and 
teachers from one app.

Timetable view is a great way to keep tabs on what 
classes are coming up for the week ahead.

>>>Reviews
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Everybody gets ideas for The Next Great 
App. But to move on it, you need a clear, 
strong mockup of your vision to share 
with others. Make My App 2 Pro wants 
to be the vehicle for your vision.

Available in free (with ads) and paid 
versions, Make My App 2 Pro is a tool 
for building visual examples of your app, 
allowing you to tinker with how your 
apps might look and work at a basic level. 
Think of it like an app for diagrams or 
mindmaps along the lines of OmniGraffle 
or MindNote, but specialized for apps. 

Make My App 2 Pro has built-in objects 
to represent devices like the iPhone, iPad, 
and even Apple Watch. Drag one to your 
canvas, then drag a variety of iOS objects 
on top to build your interface. There’s a 
good choice of objects – buttons, text 
boxes, scrollbars, tables, charts, switches, 
and more. However, a few essentials are 
missing, including tab bars (at the bottom 

of the likes of Tweetbot, Day One, and 
Safari). It would be nice to see Make My 
App 2 Pro get rounded out with some of 
these common visual building blocks. 
Something else we found disappointing 
is a lack of what we call “alignment 
smarts.” If you’ve ever dragged things 
around in apps like Apple Pages, 
Pixelmator, OmniGraffle, and others, 
you’ll have seen the smart guides that 
help you align objects. Make My App 2 Pro 
has ways to group and resize objects to 
your specifications, but no tools to help 
you polish a clean, clear layout.

Make My App 2 Pro could do with a few 
more of the core objects found in iOS, and 
a little more smarts to help polish ideas. 
Still, for $25 (or free, if you can put up 
with ads), it isn’t a bad way to get started.

the bottom line. A decent app 
mockup tool that could benefit from 
some fleshing out. DaviD Chartier

Make My App 2 Pro
A tool for bringing app ideas to life, on “paper” at least
$24.99  Developer IT Top, ittop.mobi

requirements OS X 10.10 or later, 64-bit processor

Make My 
app 2 pro

  Easy to get started

   A good variety 
of visual objects

   Lacks a few standard 
iOS objects

   Alignment options 
are absent

good 

A Make My App 2 
Pro canvas with an 
iPhone and Watch 
app being created.

Tough testing, trusted ratings
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P
hotolemur is a photo editor with a difference: it uses subject recognition 

and applies adjustments automatically. rather than applying specific 

filters or fixes, it identifies features such as faces, trees, skies, and 

landscapes to make enhancements that are specific to the subject and image. 

What’s more, it learns as it goes, so should get better the more it’s used. 

photolemur looks at image colors, exposure, contrast, and white balance, 

and analyzes an image on a pixel-by-pixel basis before making adjustments 

to enhance each shot individually. If you save an image, it’s added to the 

“success” list, but if you don’t it’s added to the “blacklist,” thus helping 

photolemur learn what you like to see.

photolemur couldn’t be easier to use. Click Load photo to upload an image 

or a selection of images, or drag a collection of files to the main screen. It 

then starts processing the images before revealing the first image, with a 

line dividing it into before and after views. You can drag the line left or right 

to reveal more or less of the adjusted version. a sliding control under the 

preview lets you alter the adjustment on a scale from realistic to Vivid. In 

most cases we found the default effect was fine, but it’s nice to be able to 

make a tweak occasionally. The only other control is a crop/rotate tool 

accessed via the scissors icon. This can be used as a click-and-drag tool, 

but you can also enter a specific angle of rotation if you like. It’s also 

possible to set an aspect ratio for the crop.

If you upload more than one image, the unopened images are visible 

in the collapsible browser bar underneath the central preview screen. 

Simply click any of the images to see the adjusted version.

photolemur is extremely easy to use and works very well, with a variety 

of adjustments applied to varying degrees to different images. In some cases 

the adjustment can be very subtle, whereas other images may have a more 

dramatic edit applied. It works especially well with dull or dark images, 

bringing them to life by brightening them selectively, boosting the local 

contrast to bring out details, and increasing color saturation.

the bottom line. photolemur is very easy to use and it successfully 

enhances a wide variety of images automatically. AnGelA niCholSon

Photolemur
Photo editing and AI combine
$49  Developer photolemur, photolemur.com

Requirements OS X 10.10.5 or later, Core 2 Duo (late 2009 or later),  
4GB, 1280x800 display

Photolemur

  Easy to use

  Automatic adjustments

   Effective results 
in many cases

   Limited control

great 

Tough testing, trusted ratings
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The first thing we noticed about Frequency 
was the price, which puts it firmly into 
novelty-app territory: serious software 
doesn’t cost three bucks. But then we used 
it, and all that changed.

If you’ve ever wrestled with complex audio 
software when all you want to do is combine 
a couple of files, fade out a track, or tweak 
the sound a little bit, you’re going to love 
Frequency. It’s a multitrack-capable audio 
editor and mixer that enables you to make 
big changes to sound files with little effort.

It’s the sort of app that will have 
podcasters in particular jumping with joy, 
because it makes combining multiple pieces 
of audio, equalizing them, and positioning 
them exceptionally quick and simple, but we 
can see the possibilities for musicians and 
movie-makers too.

The app’s layout is simple enough. There’s 
a ten-band equalizer at the bottom, and the 
various audio tools are set to the right. The 
track or tracks you’re working on appear as 
waveforms in the main window, and you 
can move them around with the mouse or 
trackpad as needed.

You can import M4A, MP4, MP3, AIFF, 
and WAV, and you can extract the audio from 
MOV, MP4, and M4V videos. You can also 

Frequency – Music Studio
A serious music app for not-so-serious money
$2.99  Developer Valentino Frati, sites.google.com/site/frequencyquentinapps

Requirements OS X 10.10 or later

Frequency - 
Music studio

  Lightweight and fast

  Really easy to use

  Surprisingly powerful

   Interface isn’t 
customizable

excellent 

drag and drop from iTunes, or directly from 
the Finder. It’s all very intuitive.

Once you’ve got your audio file(s), the fun 
can begin. You can use the sliders to fade 
tracks in or out, boost the low frequencies, 
apply high or low pass filters, or adjust the 
pitch and/or speed of the track.

You can adjust each track’s stereo position 
and volume, apply reverb and boost the low 
frequencies, and if you find a combination 
you like you can save it as a preset for later, 
or just copy it to the other tracks. Once 
you’re happy you can export as AIFF, MP3, 
or WAV, and you can also automatically add 
it to your iTunes library if you wish.

If you’ve used the open-source audio 
editor Audacity you’ll be familiar with this 
kind of thing, but Frequency’s user interface 
is much more friendly: it looks like it came 

from the same place as GarageBand, and that 

means you’ll get the hang of it in no time.

It’s fast, too, handling multiple long AIFFs 
on an aging iMac without breaking sweat. In 
a market where apps are often frighteningly 
expensive, Frequency is an exceptional value.

the bottom line. Cheap doesn’t always 
mean cruddy. Frequency is exceptionally 
good value for money, and ideal for 
podcasters and musicans GaRy maRshall

Frequency’s interface 
reminds us of GarageBand, 
or a Logic instrument. 
It’s very user-friendly.

Combining multiple audio tracks couldn’t be simpler: just 
import and then move it to where you want it.

>>>Reviews

72   apr 2017  maclife.com



The much admired Desk app has been redesigned and 
recreated with macOS Sierra in mind. It’s attractive to work 
on, and powerful too. Desk is designed to make writing for 
WordPress a pleasure. It has a clean, simple interface, 
shortcuts to speed up common tasks, a range of modes to 
suit particular preferences, and it makes even the most 
ill-thought-out blog post look amazing. It saves work 
offline, automatically backs up to iCloud, supports multiple 
WordPress blogs, and makes it easy to embed media. It can 
also be customized for specific designs – for example, you 
might want to specify featured images, categories, or tags 
for your content on one site but not on others.

It’s clear that the developer is a prolific blogger: the app 
offers both WYSIWYG and Markdown editing, real-time 
previewing, word counts, and estimated reading times. 
There are a few odd choices. For example, the font options 
and style definitions don’t appear in the Edit or Format 
menus; you need to right-click the post to see them. The 
app also crashed on us every time we tried to export as PDF.

the bottom line. Desk 3 is a powerful writing tool for 
WordPress, but we found it to be crashy. Gary marshall

QuickKey is a text expansion app that aims to go 

beyond macOS’s built-in tools. TextExpander is 

usually our go-to for this, but not everyone loves 

its new subscription system. With QuickKey, you 

press a keyboard shortcut, type in your text 

shortcut, and the snippet automatically pastes 

into your document (provided you have an 

extension installed, which the app helps with). 

Snippets are added via a dedicated manager, 

and sync over iCloud. They can only be plain 

text, so you can’t include characters for complex 

equations or similar. All of which makes it actually 

not a lot better than the Mac’s built-in tools. It’s 

easier to enter and edit multi-line snippets, but 

you can actually enter these in macOS’s seemingly 

single-line tool by pasting them in. And QuickKey 

is more awkward to trigger because you have to 

press a shortcut in the first place. 

the bottom line. A fine app, but doesn’t do 

enough for us to get excited. matt bolton

Desk 3
Popular WordPress app gets a reboot
$19.99  Developer John Saddington, desk.pm

requirements OS X 10.10 or later

QuickKey –  
Text Expansion
Smarter text replacement?
$9.99  manufacturer LittleFin LLC, littlefin.com

requirements OS X 10.11 or later

DESK

  Beautifully designed

  Very fast and flexible

  Multiple blog support

   PDF export crashed the app

GREAT 

QuicKKEy - TExT ExpAnSion

  Easy way to create multi-line text snippets

  Good snippet organization tools

  Only plain text support

   Not enough standout features

SoliD 

Tough testing, trusted ratings

 maclife.com  APR 2017   73



>>>Reviews

74   apr 2017  maclife.com



W
hen you film movies on an regular video camera, you point at what you want 

to film, and the camera will capture a flat frame’s worth of image in a set 

resolution. Where a Vr camera differs is that it can capture a 360-degree 

scene – everything that happens around you. Kodak’s new action-oriented pixpro 

Sp360 4K has two cameras bolted together, the lenses pointing away from each 

other. This captures every ounce of detail around the device. Naturally, this sort of 

imagery is perfectly suited to Vr: don a compatible pair of glasses and you can look 

in all directions as the video plays. You’ll feel like you’re actually there, experiencing 

the action first-hand. 

The Sp360 4K comes as either a single pack or a dual pack, the latter of 

which we tested. This gives you full spherical video capture, while the single 

pack manages only half that. If you go for the dual pack, you get the advantage 

of a wrist-mounted remote control, but mounting options are limited to a 

suction mount or an extending selfie-type stick.

There are a simple set of controls on one side, an LCD on the other, and 

access to the ports and memory card slot underneath a plastic tab. The case is 

splashproof, but you’ll need an underwater case for proper wet-weather activities. 

We found the buttons to be a little flimsy at times – particularly the record button, 

which would occasionally get slightly stuck within the housing. The LCD screen is 

tiny, too, which makes reading on the fly a little tricky.

The software side of things is, frankly, just not that good. If you’re planning to 

edit via a Mac, you have two separate programs to download and install – one for 

editing videos and one for stitching two videos together – and neither is great. 

There are no help guides within the software either, so you just have to fumble 

your way around until you figure out what to do. The mobile app does much the 

same thing but is a little more refined, and a mite more intuitive. 

Even with the power of double 4K, the video quality doesn’t rival the static image 

you get from a regular 4K action cam, so we were left slightly underwhelmed. It’s 

good, it’s just not exactly awe-inspiring. Of course, having to cover such a huge 

amount of picture real estate, the quality is always going to take a hit; it’s probably 

why Gopro has settled for three times the number of cameras in its own Vr setup.

the bottom line. If you want to bring your action videos to life, the Sp360 

is a good option, imbuing incredible depth to scenes. It’s also a relatively 

inexpensive way of jumping on the Vr bandwagon. nick odantzis

Kodak Pixpro SP360 4K
Want 360-degree 4K video? This could be for you
$500 (single pack), $633 (dual pack)  manufacturer Kodak, kodak.com

Features 12.76 megapixels, 235-degree field of view, 3840x2160 resolution, Wi-Fi

KodaK PixPro 
SP360 4K

  Immersive footage

  Easy to use

   Comparatively 
good value

   Movie quality 
could be better

good 

Tough testing, trusted ratings
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T
he Lume Cube is a rugged external light 

to help when taking photos or video, which 

can be controlled from an accompanying 

iPhone app. It’s waterproof, so can be used in 

poor outdoor conditions without any worries. 

You can buy the Lume Cube on its own, or in 

a set with the Smartphone Kit, which includes 

a hand-held mount. The mount can hold your 

iPhone in its clip as well as the Lume Cube (or 

just one of the two can be attached if you want 

an off-light effect), and the setup is impressively 

flexible thanks to multiple thread points on the 

clip and an included ball-joint attachment. 

The Lume Cube’s light has multiple levels 

of brightness accessible by pressing buttons 

on its body (a slider can be used to control it 

in the iPhone app), and is really quite powerful 

for its size, with a wide, long-reaching throw at 

higher levels. It’s quite a hard light (there’s not 

much diffusion), so can seem fairly harsh, 

with sharp shadows. It also appears cooler 

than expected, so if you’re using it in an area 

with warmer lights around, the results can be 

odd. For closer objects, we got better results 

with the iPhone’s TrueTone flash. We wish the 

Lume Cube came with an easy way to attach 

filters to diffuse or change the light’s color 

(a diffusion kit is coming soon, but in a 

pretty expensive attachment).

The battery life is decent – a couple of 

hours at mid-level strengths. You can trigger 

it to flash only when you start shooting in the 

app, saving power, but we got better results 

forcing it on, controlling the light level with 

its app, and using a superior camera app.

the bottom line. A strong, convenient 

portable photo and video light kit, but we’d like 

more control over its effect. matt bolton

Lume Cube Smartphone Video Kit
Shed some extra light on your iPhone photos and videos
$109  manufacturer Lume Cube, lumecube.com

Features 150 lux at 3m, Bluetooth connectivity, app control, smartphone mount

Lume Cube 
Smartphone 
VIDeo KIt

  Small, portable, tough

  Powerful light…

  …but hard and cool

   App not as useful 
as it should be

GooD 
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Add-on lenses for the iPhone are now quite common, 
although they vary wildly in quality and price. If the Zeiss 
ExoLens (see last issue) is a little too hot for you at $200, 
here’s a more attainable alternative.

The Olloclip Core Set for iPhone 7 and 7 Plus has 
superwide, fisheye, and 15x multiplication macro lenses, 
with the macro lens being revealed when you unscrew the 
fisheye. You can attach two lenses to the frame that sits on 
the iPhone, so changing a lens simply means flipping the 
frame and snapping it into place.

The superwide lens is great for landscapes, since the 
iPhone’s camera is somewhat narrow, although Olloclip’s 
lens suffers from horizon distortion near the edges of the 
frame. We really like the macro lens, though; its focus range 
is admittedly narrow, but that can add to the appeal in the 
right circumstances. You may not find much use for the 
fisheye lens beyond the odd shot, on the other hand. The 
price feels a little steep considering Olloclip sells a 4-in-1 
lens set for $80, but that’s only for earlier models. 

the bottom line. A great starter set for taking better 
iPhone shots – though it’s not without issues. Alex blAke

Prynt is a handheld printer, relying on a Lightning 

connection rather than Bluetooth: you slot your 

iPhone SE/5s/6/6s/Plus into the camera-lookalike 

case. (There’s no iPhone 7 version yet, and you 

have to buy a version for your particular iPhone 

model.) It relies on inkless Zink technology for its 

3x2-inch prints. Image quality isn’t amazing, but 

neither is it terrible: pics are reasonably sharp, 

but have noticeable horizontal scanlines.

Using the Prynt app you can take photos, load 

snaps from your library or create video “stories.”  

This, as it turns out, is the most interesting part 

of Prynt. Choose a photo as a “cover” (the picture 

that gets printed out) and attach one or more 

videos to create a story. Once your picture has 

been printed, hold your iPhone over it and your 

videos play through the not-quite magic of 

augmented reality. It’s fun and, given the so-so 

quality of the printouts, is probably the part 

that will appeal most.

the bottom line. Fun video prints and 

decent image quality are offset by some design- 

and app-related quirks. Alex blAke

Olloclip Core Lens Set
Better iPhoneography to the core
$100  manufacturer Olloclip, olloclip.com

Features Fisheye, superwide, and macro (15x) lenses

Prynt
Bring your photos to life
$150  manufacturer Prynt, prynt.co

Features Zink printing, Lightning connection

OllOclip cOre lens set

  Fun macro lens

  Increases your picture-taking options

   Horizon distortion on superwide lens

   Fisheye is very specialist and/or gimmicky

excellent 

prynt

  Video prints are fun

  Easy to use

   No Bluetooth, and limited phone model support

   Surprisingly big case

sOlid 
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A 
new kind of drone is taking to the skies. 

Over the past 18 months or so, we’ve 

seen a number of “autonomous” drones 

being launched via Kickstarter. These drones 

will follow your every move, hands-free, 

whether you’re thrashing down a mountain 

on a bike or shredding deep powder (it’s a 

thing) on an alpine black run.

a key difference with the Hexo+ is its six 

arm-mounted propellers, which make it a 

hexacopter rather than the more common 

quadcopter design. Despite its ample size, 

the Hexo+ is light enough to be transported 

to filming locations off the beaten track 

– even with the Gopro-compatible gimbal 

attached (you’ll need to buy the camera 

separately) and a battery installed.

assembly is a cinch. Slide the two plastic 

landing gears into place, screw the color-

coded propellers onto the motors, attach 

the gimbal to the rails on the drone’s belly 

and plug in the gimbal’s power cable. The 

battery slots neatly inside the rear of the 

drone, and charging takes just over an hour 

via an aftermarket eCube charger. 

additional batteries cost $130 each; 

that’s cheaper than other brands, but still 

steep considering the average 15 minutes 

of flight time per battery.

The Hexo+ uses a phone’s GpS position via 

the free app, along with four other sensors 

(accelerometer, gyroscope, barometer, 

magnetometer) to pinpoint where the subject 

is and how it’s moving to ensure optimum 

tracking and framing. It takes just 21 seconds 

from switching the drone on to it syncing with 

GpS, and connecting your phone to the drone 

via Bluetooth is simple. 

It’s safe to say that trees and power lines 

are a no-no for this device. That aside, the 

fun really begins when you’re comfortable 

with the drone and ready to shoot. Camera 

movements are selected by a single tap 

within the app menu; the drone flies into 

position and awaits your command to Start 

Shooting. Highlights include Hover High, 

where the drone sits directly above you, 

taking in a huge amount of the landscape 

and moving with the smartphone-wielding 

subject on the ground. 

The panoramic 360, Fly In/Out and Slide 

Sideways modes all perfectly capture the 

moment when you conquer your next 

mountain peak. reaction to sudden bursts 

of speed or movement is instant, and the 

gimbal’s three-axis stabilization keeps 

the camera fixed firmly on the subject.

Connection between drone and 

smartphone is consistently strong, and 

there’s no noticeable difference in drone 

reflexes whether the phone is in your hand, 

or stowed in your pocket or backpack.

the bottom line. It’s still early days 

for the Hexo+, but this is an impressive 

foundation for the fledgling brand to 

build upon. Christopher barnes

Hexo+
You’ll never be alone with this drone
$999  manufacturer Squadrone System, hexoplus.com

Features Max speed 45 mph, max range 300 ft, three-axis stabilization, Bluetooth

Hexo+

  Accurate tracking

  Great stability

  App is glitch-free

   Lengthy charging time

great 
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T
his portable Bluetooth speaker costs, as 

you’ve probably already noticed, a large 

number of dollars. Vifa’s sales pitch makes 

it out to be an objet d’art as much as a way to 

listen to music, and we do like the design a lot.

The frame is a single piece of aluminum that 

covers the sides and connects all the way around 

to form the handle, with a matt finish. The grilles 

on the front and back are covered with a custom 

textile from a Danish manufacturer that feels a 

lot like a high-quality wool finish – because that’s 

partly what it is. It’s all very finely made and 

very polished, as you’d expect.

Most importantly, the sound has had the same 

treatment. The Oslo’s audio is big and rich, full of 

detail and warmth. Bass is thick and disciplined, 

meaning that it doesn’t overwhelm the rest of 

the soundscape despite having good punch for 

the size of speaker. You’ll have no problem 

picking out not just individual instruments, 

but exactly how they’re being played. It fills a 

room with its audio easily without any hint of 

distortion – it’s great across the range. Our only 

complaint is with the volume gradation steps; on 

iOS, we found that pressing the volume buttons 

led to it being either too loud or too quiet in a 

fairly average-sized living room.

We also found that it tended to hijack our 

Bluetooth connection a lot if we left it on. We’d 

switch to our iPhone speaker, then suddenly find 

it apparently silent, because it was playing on 

the Oslo in another room. We’ve been 

disconnecting in the Bluetooth menu as a 

workaround, and reconnecting when needed, 

but we’re not keen on the extra hassle.

the bottom line. An excellent-sounding 

speaker with a cool design – but it’s expensive 

and has a few small niggles. matt bolton

Vifa Oslo
Warm sound from this textile-covered speaker
$549  manufacturer Vifa, vifa.dk

Features Bluetooth aptX, 3.5mm aux-in, rechargeable battery

Vifa OslO

  Excellent audio

  High-end design

  High-end price

   Some connection 
irritations

GOOd 
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G-Tech G-Drive Slim SSD USB-c 500GB

  Mostly great speeds

  Sleek and lightweight

  Bus-powered and easy to set up

   Minor speed drops

GreaT 

Orbi is designed to eliminate wireless deadspots, 
particularly with large-family or multiple-occupancy 
homes where everybody has multiple wireless devices. 

It consists of a tri-band Wi-Fi router, and a separate 
satellite that you place in an area where your wireless signal 
isn’t so good – you can add more if needed. Together, you 
get a strong, robust, and reliable signal with one single 
network, so your device will have the best possible signal 
wherever you are in the home.

Setting up Orbi is a piece of cake and synchronizing the 
satellite is easy. You can also plug in numerous wired 
devices to both units, so if you have the satellite near your 
TV, you can connect other devices such as Apple TV and 
games consoles too. So far, so good… But Orbi has one 
pretty big downside: it costs a lot of money. Indeed, it’s 
such a high upfront cost that you really do need to be sure 
you need it. Unless you have an extremely large house, 
you’d be better off buying a high-end tri-band router for 
less than $200. 

the bottom line. Very expensive, but a faultless 
solution for large home total coverage. Dan Grabham

This looks like it should contain a 2.5-inch hard 

drive, but is much lighter, thanks to flash storage. 

The maker draws attention to the G-Drive’s 

0.39-inch body, but its 4.4 lbs weight is just as 

attractive. Over the bundled USB-A cable, this 

drive peaked at 440MB/s when using an adapter 

to connect it to a Late 2016 MacBook Pro. But 

over its USB-C cable, peak transfer rates when 

reading files were just a few megabytes per 

second less than what’s quoted: 550MB/s. Peak, 

mean average, and minimum sequential transfer 

rates were all healthily ahead of our old favorite, 

Samsung’s T3, peaking at 534.7MB/s when reading 

and 496.1MB/s when writing.

In our difficult random read and write tests, 

which use small file sizes up to 1MB, the G-Drive 

exhibited excellent speeds – except for randomly 

reading files upwards of 256KB, where it lagged 

behind the T3, but not enough to be a concern. 

alan StonebriDGe

Netgear Orbi
Faultless networking for large homes
$380  manufacturer Netgear, netgear.com

Features High speed tri-band Wi-Fi, covers up to 4,000 sq ft

G-Drive Slim SSD 
USB-C 500GB
Pick up some speed
$230  manufacturer G-Technology, g-technology.com

Features 500GB, USB 3.1 Gen 2

NeTGear OrBi

  Superb total-home coverage

  Very simple to set up

  Useful connection options

   Very expensive, and do you need it?

GreaT 
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“Open-world zombie game with crafting and 
parkour” doesn’t gin up much excitement in 
2017, but don’t overlook Techland’s Dying 
Light. Far from capitalizing on industry 
zeitgeist, free-running is the foundation 
upon which the fictional, Turkey-ish city of 
Harran is built. It’s relatively easy to simply 
scarper up the side of a building or to bound 
across the rooftops of Harran’s labyrinthine 
slums, so skirting the zombie throng is often 
more effective than hacking through it.

The setting sun marks a dramatic shift 
in tone and priorities: during the day, 
protagonist Kyle Crane is free to scavenge 
scrap parts, craft increasingly exotic 
weapons, and chase down the intermittent 
supply drops filtering in from the outside 
(and un-zombified) world. At night, Dying 
Light mutates into a mix of desperate stealth 
and panicked chase scenes as Crane tries to 
escape the feral, snarling Volatiles long 
enough to find a safehouse. 

Dying Light’s parkour and real-time 
day-night cycle combine to prop up even 

Dying Light: The Following Enhanced Ed.
Do not go gentle into that good night…
$59.99  Developer Techland, techland.pl

Requirements OS X 10.12.1, Intel Core i5 3.2GHz, 4GB RAM, 2GB VRAM

Dying Light: 
the FoLLowing – 
enhanceD 
eDition

   Parkour provides a new 
twist on both zombie 
and open-world games

   Day and night cycles 
keep things fresh

   Enhanced Edition is 
full of new content

   Looting and combat 
can become repetitive

gooD 

the most menial tasks: fetching a fellow 
survivor’s reading glasses or delivering a 
batch of tainted drugs to a rival faction. 
When chance, quest design, or Harran’s 
dizzying geography force a more direct 
confrontation, Dying Light focuses on 
close-quarters melee combat. One of Crane’s 

three skill trees is full of elaborate take-downs 

and grapples, but the appeal of any zombie game 

is the indulgent thrill of squishing undead skulls 

like so many overripe casabas. In combat, too, 
Dying Light’s parkour provides interesting 
twists: hop up to high ground to hurl 
Molotov cocktails, or herd a flock of undead 
toward enemy thugs and let them sort each 
other out. Adapt and survive.

Dying Light is a free-flowing romp, 
complete with seamless drop-in, drop-out 
cooperative play and a bevy of multiplayer 
options. Some of its finer details are less 
accomplished, though: weapon degradation 
(and subsequent crafting) is never as fun 
in practice as in theory. The immediacy of 
melee combat and the tension of nighttime 
sorties are what make Dying Light scary.

the bottom line. Techland improves on 
its previous series while carving out its place 
in two crowded genres. Dying Light isn’t bold 
or striking, but smart design that encourages 
player freedom wins the day – and night. 
Joseph leRay

Clear out defensible, 
fenced-off areas: 
they make for ad hoc 
fortresses at night.

Volatiles are single-minded in their pursuit, and poor 
Crane doesn’t have the lungs or the legs to run all night.
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It’s not often we see entirely new 
mechanics in gaming, but Headlander is 
as refreshing as it is colorful – and with 
its 1970s sci-fi aesthetic, it’s also 
positively groovy.

You start out as a disembodied human 
head in a world full of machines, and your 
quest is to discover what happened to the 
rest of your body – and uncover your past. 
Playing as a disembodied head is fun; the 
helmet surrounding it can float, boost, 
attach to random machinery, and even 
shield itself temporarily. But when limbs 
are required to get to a certain spot, you 
can pop that head down on any available 
body – after you use your helmet’s 
vacuum to suck their head off, naturally. 

Combining elements of exploration, 
platforming, and combat on a slowly 
revealed map isn’t exactly new; this 
“Metroidvania” genre is named for two 
games from the ’80s, after all. It’s 
Headlander’s core mechanic and plot 
point – the disembodied head – that 

makes it so different. Throughout the 
game, you’ll embody passersby, soldiers, 
brawlers, dogs, map droids… you name it. 
That’s not taking into account all of the 
other things you can do with your head, 
such as finding secret rooms with 
upgrades to stats, moving elevators, and 
more. It makes combat even more fun 
– if your current body is low on health, 
you can pop off your head, throw up your 
shield, and vacuum off the head of a 
shooting robot.

Other than enemies respawning a bit 
too quickly at times and a few vague 
objectives, there’s almost nothing to 
complain about. It’s a groovy good time, 
just as intended, imbued with humor 
and style. It’s the type of game you play 
when you want to escape into a more 
entertaining, colorful world for a while.

the bottom line. Headlander mashes 
a well worn genre with original ideas and 
a great retro aesthetic, and the result is 
massive amounts of fun. Sarah leboeuf

Headlander
So trippy and fun you’ll lose your head
$19.99  Developer Double Fine Productions/Adult Swim Games, adultswim.com

requirements macOS Sierra, dual-core Intel i5, 4GB RAM,  
GeForce GT 650 Ti/AMD Radeon HD 7800 or newer graphics, 4GB storage

Headlander

   Bright, colorful ’70s  
sci-fi feel

   Head-swapping 
mechanic feels fresh

   Side quests and secrets 
throughout the map

   Respawning foes can 
be a hindrance

excellent 

Zone out ’70s-style with 
some retro sci-fi action. 

Tough testing, trusted ratings
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in-car 
smart 
tech

espite all the rumors, it’s still 
not clear whether Apple is 
planning to develop its own 
self-driving smart car, or simply 

focus on intelligent driving software that 
it could license to other manufacturers. 
In any event, nobody is expecting the 
famously secretive company to unveil the 
Apple Car for a few years yet at least. 

In the meantime, there are still plenty 
of ways to add some Apple tech to your car – 
or buy a car that has Apple software built 
right into them. Apple’s CarPlay technology 
is a display and controller for your dashboard 
that enables you to control key iPhone apps.

If your vehicle supports CarPlay (see  
apple.co/2j2vFSc) and has a compatible 
screen installed on its dashboard, you can 
connect your iPhone to it and see and interact 
with apps such as Maps, Messages, and Music 
without handling the phone. You can use Siri 
for handsfree voice commands, telling it to 
play your favourite playlist, for example, or 
“call the office” so you can tell someone 
you’re stuck in traffic.

CarPlay made big strides in 2016, and there 
are now dozens of manufacturers, from Audi 

> get started with…

The Apple Car may never happen, but 
there’s plenty of smart tech that you 
can use in your vehicle already

d

By cliFF JosePh
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to Volkswagen, that include CarPlay as a standard 
feature in many of their latest models. But you 
don’t need to go out and buy a brand new car, as 
there are plenty of car accessories that allow you 
to use your iPhone while you’re driving.

Safety is all-important, of course, and there are 
many handsfree kits that use Bluetooth to connect 
to your iPhone so that you can make or take calls 
without taking your hands off the wheel.

Many of these will also allow you to talk to Siri 
while you’re driving, with prices starting as low 
as $20 for a basic model such as the Besign Car Kit. 
One of our favorite handsfree kits is the Parrot 
MiniKit Neo 2 HD, which is a little more expensive 
at around $70, but includes additional features, 
such as an app that remembers the location of your 
car when you park. We’re also fans of Pioneer’s 
range of receivers, especially the AVH-X3800BHS 
($230), which provides HD Radio, Sirius XM 
compatibility, and voice integration with Siri.

Sat-nav systems are probably the smart car 
tech most people are familiar with. TomTom 
makes a number of affordable models, starting 
from $90, and there’s the Garmin nüvi range 
starting at around $100.

Get yourself a new 
Mustang and you’ll 
get CarPlay thrown in.

Garmin has 
a number of 

variously priced 
models in its nüvi 

sat-nav range. 

If you really want to give your wheels a high- 
tech upgrade, you can choose from several in-car 
entertainment systems also made by Pioneer. 
These include its own dashboard displays and 
full support for CarPlay, with prices starting at 
around $400 for its entry-level SPH-DA120. Some 
of Pioneer’s CarPlay systems also allow you to 
connect a rear-facing camera, so that you can view 
the camera image on the dashboard screen to help 
you with parking, although these tend to be more 
high-end models costing $700 or above.

Because we’re fans of JBL’s speaker systems, 
we’re very much looking forward to its first entry 
into the automobile market – the forthcoming 
Legend CP100. Like its Pioneer rivals, the Legend 
will include a dashboard display with support for 
CarPlay, and an option for connecting a rear-view 
camera, although it should be more affordably 
priced at $400. The launch of the Legend was 
delayed after Apple updated CarPlay along with 
iOS 10 last September, but it’s now due for 
release in early 2017.

Cameras are another technology that’s getting 
more popular in cars. It started with professionals 
using action-cams stuck onto the dashboard for 
recording footage during races, or for TV shows 

Thinkware’s Dash Cam 
X550 isn’t cheap, but 

has both front and rear 
cameras plus GPS.
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The Parrot MiniKit 
Neo HD 2 is a 
handsfree kit with 
extra smarts.

such as Top Gear. The action-cam specialists at 
GoPro quickly saw the potential here and released a 
series of dashboard mounts and accessories for the 
company’s popular Hero cameras, and you can get 
a kit that includes the Hero5 camera and complete 
set of car accessories starting at around $300. 

There’s a more down-to-earth use for these 
dash-cams too. Apart from anything else, the 
footage from a dash-cam could prove that you 
weren’t at fault in the event of an accident, saving 
you money and headaches. Some insurance 
companies will also offer discounts if you have 
a dash-cam in your car. You can get a basic 

dash-cam such as the Haoponer dual-camera for 
around $55, but it might be worth looking at a more 
advanced models such as the WheelWitness HD Pro 
($125) or Thinkware F750 ($250), which include 
additional safety features, such as collision 
warnings in case you get too close to the car 
in front, or start to veer across lanes. 

A lot of accidents happen when drivers are 
reversing, and a new category of “back-up cams” 
has recently appeared that can be attached to the 
back of a vehicle in order to provide a clearer view 
than you get from your normal rear-view mirror. 
As we’ve mentioned, dashboard systems such as 
the JBL Legend allow you to connect to a rear-view 
camera and display the image on their dashboard 
screens, and there are several companies that 
make rear-view cameras, such as the low-cost 
BC30 from Garmin ($150).

Thinkware also makes a number of kits that 
include both front and rear cameras, such as the 
Dash Cam X550, which is fairly expensive at around 
$300, but includes advanced features such as GPS 
tracking, and the ability to warn you of nearby 
traffic cameras. It even has a Mac app for viewing 
your recorded footage on your computer, in case 
you want to create a library of driving videos.

a  n e w  c at eg o ry  o F 

“ B a c k- u P  c a m s ”  h a s 

r ec e n t ly  a P P e a r e d  t h at 

c a n  B e  at ta c h e d  to  t h e 

B a c k  o F  a  v e h i c l e
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We recommend the best five in-car gadgets for you

Pioneer avh-3800Bhs

$230

pioneerelectronics.com

> Pioneer’s in-dash DVD 

receiver offers a whole lot 

of stuff for the price, 

including Bluetooth control, 

Sirius XM satellite radio, 

HD Radio, Spotify app 

control (new to this model, 

in addition to the existing 

Pandora support), and 

integration with Siri’s Eyes 

Free functionality for 

spoken directions.

1 2 3 4
coBra JumPack cPP 

8000

$100

cobra.com

> More brute-force than 

smart tech, but this 

could be a life-saver in 

an emergency. It looks like 

a conventional battery 

pack, with a USB port for 

charging your iPhone – but 

it’s also powerful enough to 

jump-start a car, and even 

includes its own set of 

jump cables.

Pioneer sPh-da120

$400

pioneerelectronics.com

> Also known as the 

AppRadio 4, Pioneer’s 

in-car entertainment 

system can give your car 

a major digital upgrade, 

with touch controls and 

support for Siri and 

CarPlay. Pioneer provides 

its own apps to play a 

variety of digital music 

formats, and you can 

connect a rear-facing cam.

wheelwitness hd Pro

$130

wheelwitness.com

> The WheelWitness’s 

camera and recording 

resolution is impressive at 

2560x1080 pixels, and with 

a 170-degree wide-angle 

lens, it’s recording virtually 

the entire field of view in 

any given direction. You 

can also follow your 

recorded video alongside 

a Google Maps screen to 

precisely pinpoint an event.

 Five oF 
the Best
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ost cars sold since 
the mid-’90s have a 
connector for OBDII 
(on-board diagnostics 

2.0). You can read the diagnostic 
data these collect with a hand-held 
scanner. However, many of these 
scanners are aimed at professional 
mechanics with advanced 
knowledge, so they’re not 
exactly simple to use.

In addition, while there are 
some that integrate with a 
smartphone to analyze and display 
stats, there are surprisingly few 
that support iOS. One that does is 
the Bluedriver ($100), which can 
read and clear codes, generate 
repair reports for countless 
models, and which works 
seamlessly over Bluetooth.

Another useful maintenance tool 
is the FOBO Tire sensor set ($229), 
which uses Bluetooth to transmit 
info about your tires to an iPhone 
app. And, in a pinch, we’d 
definitely recommend the Cobra 
JumPack (around $100, see left 
for more). This looks like a 
conventional battery pack that 
you can use to charge your iPhone 
while you’re driving, but it’s so 

powerful that it can jump-start 
the battery on most small and 
medium-size cars, and could 
really get you out of trouble on 
a cold winter morning.

M

when 
things go 
wrong

> what else should i think about…

Digital tech can help to keep your 
car healthy and safe, too

Parrot minikit 

neo 2 hd

$70

parrot.com 

> With phone handsfree 

kit available for next to 

nothing, manufacturers 

have to justify higher 

prices. So Parrot has 

incorporated support 

for dual phones with 

simultaneous connections, 

“HD-quality” sound, voice 

control (though not 

through Siri), and more.

5
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how to

add carPlay to your car 

hey, siri
And, of course, there’s Siri. You can use 

Siri in your car just as you would ordinarily use 

it with your iPhone, so you can ask it to launch 

Maps and locate a particular destination, play 

some music, or make a call to your office. 

Or just pass the time on a long trip…

Carplay kit
A CarPlay kit such as JBL’s new Legend 

is a fairly chunky piece of gear. It includes a 

6.75-inch touch-sensitive screen, along with 

all the electronics needed to run the CarPlay 

software and apps. There’s a microphone for 

voice calls and Siri, too.

in-car entertainment
Once installed, the Legend acts like a 

standard car-entertainment system. It includes 

AM and FM radios, and can play music from 

any device with a USB connector. The Phone 

button switches everything over to CarPlay, so 

it can link up with the iOS apps on your iPhone.

eyes free
You need Maps for navigation, but 

CarPlay primarily focuses on audio-based apps 

such as Music and Phone, which don’t require 

you to take your eyes off the road. There are 

some third-party apps that work with CarPlay 

but these also focus on audio, such as Spotify.

 
jargon buster

The slots on the 
dashboard that a car 

audio system fits into are 
known as DIN slots. 
A single-DIN slot is 

180x50mm (about 7x2 
inches). However, CarPlay 

kits and other audio-visual 
systems require double-

DIN or 2-DIN slots, which 
are 180x100mm (about 

7x4 inches).

 
genius tip

 
CarPlay was updated 

as part of iOS 10 in 
September last year, and 

gained new features such 
as the ability to remember 
where you parked your car 

if your iPhone moves 
beyond Bluetooth pairing 

range (328 ft). 

>>>Home Life

90   apr 2017  maclife.com



The home of technology

techradar.com



ConneCted gadgets to enhanCe your lifestyle 

get smart

yamaha disklavier enspire
yamaha.com
From $28,000

>>> Yamaha has a long history of producing 

musical instruments, including the new 

Disklavier Enspire range of pianos, which 

works as part of its Musicast multiroom 

audio system. While it’s a traditional acoustic 

piano you can play at home or even in a 

concert hall, it’s also packed with digital 

technology, including the ability to stream 

your piano party-pieces to Yamaha speakers 

around your home. Other features include 

the ability to record your performances, 

which is great if you’re a musician or 

studying the subject.

If you’re not that musically gifted, there 

are 500 recordings stored on the piano, 

covering genres such as classical piano solos, 

jazz, and even a few pop tunes, too. The 

Enspire doesn’t simply play back these songs 

like a glorified speaker – it plays the piano 

parts itself, with the keys and pedals moving 

like an old player-piano, thanks to a built-in 

servo drive mechanism.

There are 14 models in the Enspire range, 

starting at around $28,000 for the Enspire 

DU1, an upright piano that’s suitable for 

homes or schools where space is tight. Step 

up to $92,000 and you get a grand piano 

model, the DC3X, while a premium grand 

piano such as the Enspire DCF6 comes in 

at a cool $160,000.

>>>Home Life Better living through smarter tech

92   apr 2017  maclife.com



airBolt smart 
travel lock
theairbolt.com

$80

>>> Keep an eye on 

your bags with the new 

AirBolt smart lock, which 

you control over 

Bluetooth from an app 

on your iPhone. This can 

track your bag too, 

sounding a buzzer if it 

starts to move beyond 

Bluetooth range. If the 

bag truly gets lost, the 

lock can message other 

AirBolt users nearby and 

prompt the companion 

app on their phones to 

tell you where your bag 

is, anywhere in the world.

Withings 
steel hr
withings.com

$180

>>> Withings is the latest 

company to come up 

with a hybrid smartwatch 

that ditches a digital 

screen for a more 

traditional analog watch 

face. The Steel HR is 

available in three styles, 

with a 36mm face in 

black or white, and a 

40mm model in black 

only. As you might guess 

from the HR part of its 

name, it can monitor 

your heart rate as you 

run, walk, or swim, and it 

displays your data on a 

small digital counter set 

within the main face. The 

Steel HR can also alert 

you to incoming calls and 

text messages from your 

iPhone, and has a built-in 

alarm feature too, which 

can be set to vibrate.

>>> my mother has started pressing 

money into my hands and urging me to 

“Treat yourself,” which in Mom-to-

Adult-Daughter-speak means “You’re a 

hot mess, put on some damn lipstick 

before the pitchfork-wielding villagers 

show up.” My make-up bag yields seven 

cotton balls and a Tic-Tac, so I do what 

any nerd would do and download the 

L’Oréal Make Up Genius app. 

I’ll be honest; I fully intended to make 

fun of this. It’s a virtual mirror for 

iPhone that allows the user to “try on” 

L’Oréal cosmetics. I expect it to be a 

novelty promotional tool with strong 

potential for cat-makeover hilarity, but 

it is unexpectedly brilliant. I see what 

eyeliner should look like when properly 

applied (hint: not like a direct punch to 

the ocular cavity). I try costly lipglosses 

in outrageous colors — and on my lips 

rather than the back of my hand, very 

high-brow. Even better, the Snapchat-

like AR means the virtual make-up 

moves with my face as I look into the 

camera; I can wink provocatively to get 

a better look at mascara. I can suck in 

my cheeks and the blusher follows 

along… which is how my family finds 

me on a quiet Saturday afternoon. A 

half-hour later and we know exactly 

how my mom, husband and one-year-

old look with a glam smokey eye. 

(Fabulous, obviously.)

Depending on where you live, it’s 

possible to order products online too, 

and I can suddenly see how virtual 

cosmetics apps could totally change 

the lives and looks of women – and 

men – who are too busy, remote, or 

self-conscious to set foot in a 

department store for a makeover.

In her efforts to glam up, 
Jennifer Phin discovers 
an unexpected app ally
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The Mill Creek studio specializes 
in the best of nostalgic 
entertainment, with a catalog 

that’s ripe with classic movies, retro TV shows, 
and fascinating documentary collections.

Thanks to the Mill Creek Entertainment app, 
now you won’t have to shamble into Walmart or 
Target in search of your favorite sci-fi, mystery, 
horror, drama, comedy, or Westerns featuring 
iconic stars. That’s because all those massive 
movie collections are now assembled in digital 
form, ready to stream on your Apple TV.

While 50-movie sets such as Midnight Movie 
Madness, Cowboy Legends and Icons of Comedy 
aren’t free, plenty of individual titles are – and 
collections can be had for as little as $4.99. You 
can even purchase DVD + Digital sets and 
redeem codes to add them to your streaming 
collection. j. R. BOOKWALTER

Mill Creek 
Entertainment
Magical movie memories
Free

Minecraft:  
Apple TV Edition
Building blocks of fun
$19.99

Minecraft: Apple TV Edition may not offer all the features you’d like it to just 
yet, but it’s still Minecraft on your Apple TV. And is, therefore, a Big Deal!

Make your Sunday afternoons matinee movie afternoons, 
with the Mill Creek Entertainment app on your Apple TV.

Mojang has 

finally delivered 

Minecraft: Apple 

TV Edition in all its glorious 

blocky wonder. 

Like the iOS Pocket Edition, 

the Apple TV Edition allows 

players to explore randomly 

generated worlds and build 

things, from the simplest of 

homes to the grandest of 

castles. Whether you choose 

survival mode for mining, or 

take advantage of unlimited 

resources by playing in creative 

mode, you’ll have the same 

ability to craft weapons and 

armor to protect your turf. 

Naturally, Minecraft landing 

on Apple TV is a Big Deal, but 

there are a few things worth 

noting. First, you’ll need an 

Apple TV-compatible gamepad 

to play. Also, there’s currently 

no support for Realms, nor can 

you sign into Xbox Live or play 

with friends. While those 

features are coming, for now 

it’s more like “Minecraft Lite.” 

That said, playing with a proper 

game controller beats the 

experience of tapping on-

screen buttons in the Pocket 

Edition. j. R. BOOKWALTER

>>>Home Life
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Kapow! Get your favorite superheroes to 
save the day on your TV screen.

With a wireless smart antenna, WatchAir 
offers a live TV solution for Apple TV owners.

LEEcO SupER4 X65 EcOTv

$1,199  LEMALL.cOM

Not familiar with LeEco? This 
upstart Chinese brand has 
invaded US shores with a 

65-inch 4K UHD television 
offering Harman Kardon 

sound, and powerful specs for 
responsive apps – all at a 

pretty affordable price that 
includes three months of 

DIRECTV NOW plus EcoPass, 
the company’s own cloud 

storage and all-around 
entertainment service.

NEWER TEchNOLOgy 

NuSTANd ALLOy

$24  NEWERTEch.cOM

Sure, Apple TV was designed 
to lay flat, but if you like to do 
things differently, here’s an 
inexpensive aluminum-alloy 
desktop stand to cradle your 
media streaming box, with 

a silicone center and 
non-skid rubber feet. 

Make the most of 
home entertainmentWith support for cloud 

storage providers 

Dropbox, Google Drive, 

and OneDrive, this inexpensive app 

allows comic book enthusiasts with 

existing collections to download and 

read books right on the TV screen.

Easy comic Reader supports all 

popular comic formats including cBZ, 

cBR, cB7, cBT, ZIP, and RAR, allowing 

one-click downloading of your favorite 

titles. Getting started is a snap by using 

a four-character code to link your 

account from any web browser.

The app fills the screen horizontally, 

so you’ll need to use the Siri Remote to 

swipe down the page, clicking the left 

or right edge to turn the page backward 

or forward. Most compressed JPEG 

pages don’t look super-clean on a big 

TV screen, but it’s an entertaining way 

to catch up on favorites while lounging 

on the couch. j. R. BOOKWALTER

Networks may keep most 

live television out of 

reach for Apple TV 

owners, but WatchAir app/antenna may 

be the solution. A $239 wireless smart 

antenna delivers over-the-air signals 

to iOS and Android devices, as well as 

smart TVs, Roku boxes, and more.

The free WatchAir TV app is what 

ties the service together, wirelessly 

streaming live or recorded content 

from within a 60-mile range directly 

to the big screen. With no monthly 

subscription fees, WatchAir TV includes 

an enhanced schedule guide as well as 

sorting shows by category or type so 

it’s easy to find something on to watch.

And you can record live TV to watch 

later – up to five hours of storage is 

built into the smart antenna, or you can 

plug in a microSD card or USB device to 

keep h.264 recordings for hours or 

even days. j. R. BOOKWALTER

Easy Comic Reader
Read comics on TV
$1.99

WatchAir TV
Over-the-air streaming
Free (hardware required)

Better living through smarter tech
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There are two ways to use iCloud for 

this type of synchronization. The 

simpler way is to work on the files in 

iCloud, and only make local copies for 

backups and archives. This is easier 

because you don’t have to do any 

synchronization, just pull down copies 

when you want to back them up locally. 

not careful, the iCloud copy won’t 

be up to date, and you could end up 

with different versions of files on 

your Mac and PC. 

To implement the second method, 

you’ll need folder synchronization 

software running on both your Mac 

and your PC. It must be able to see 

your iCloud Drive so it can copy to it, 

and it must run automatically. For your 

Mac, the Mac App Store has good 

options, such as Folder Sync ($8.99, 

apple.co/2gwdzn5). 

Backups halt in Sierra
I upgraded to a 27-inch iMac with a 

1TB Fusion Drive, but every time it 

tries to run a Time Machine backup, 

the process stalls at the same point. 

I have even bought a new external 

hard drive, but it won’t complete the 

first backup to that either. Is Time 

Machine broken in Sierra?

Some users have reported problems 

backing up with Time Machine, but 

most of these issues can be fixed. If 

you can, archive the drive containing 

your old backups and switch to using 

the new one, starting afresh with it. 

Ensure that Sierra is fully up to 

date, and that there’s ample free space 

on the external drive to perform a full 

backup, as well as incremental backups 

thereafter. It’s also wise to check that 

any migration from your old Mac didn’t 

bring old or buggy software across to 

your new one, particularly extensions 

and enhancements. 

Turn off Time Machine, connect 

the new external drive, and restart in 

macOS Recovery (hold ç+r at boot). 

Using Disk Utility there, run First Aid 

on your Fusion Drive, then initialize the 

external drive to Mac OS Extended 

(Journaled) format. Restart your Mac 

as normal. In Time Machine’s 

preferences, click Options and add any 

folders you don’t wanted backed up to 

the exclusions. 

Re-enable Time Machine to back up 

to the new drive. Leave the iMac alone 

to back up, running no apps; overnight 

is ideal. If Time Machine sticks again, 

I’m delighted with my new MacBook Pro, but I still use 
a Windows PC too, so I’d like to use iCloud to keep files 
and folders synchronized between them. Is it possible to 
automatically update changed files on my PC to iCloud, 
and with my Mac too? I want to keep originals on my PC, 
and have them copied to my iCloud Drive.

CroSS-plaTForM SynC 

You can use iCloud Drive as a means 

of synchronizing local copies, as you’ve 

said you would prefer. Of the two 

methods, this is inevitably the more 

complicated option, as it requires 

local software that copies from each 

computer whenever you make changes 

to the local copy of each file. If you’re 
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Sierra’s Console isn’t much help in 

diagnosing it. You could try to use 

Recovery to reinstall Sierra, erase the 

new back-up drive, and then try again. 

Lost Handoff in Sierra
I upgraded my MacBookpro (late 

2011) with an internal SSD, along 

with Bluetooth 4.0 (lE) support 

so I can use Handoff. now that I’ve 

upgraded the MacBook to Sierra, 

Handoff has stopped working. 

How can I restore it?

According to Apple, your model of 

MacBook Pro doesn’t support any 

Continuity features, including Handoff. 

The oldest MacBook Pro models that 

support them are those released in 

Mid 2012. This is despite your upgrade 

enabling your Mac to support 

Bluetooth Low Energy. 

You can check that by opening 

System Information and selecting 

Bluetooth under Hardware in the list 

on the left. The pane on the right will 

probably report that Bluetooth Low 

Energy is supported but Handoff isn’t. 

When you upgraded your Mac’s 

hardware, El Capitan’s Bluetooth 

drivers were clearly happy to work 

with the new components. 

Unfortunately many people have 

found that such ad hoc support 

doesn’t extend to macOS Sierra, and 

the moment they upgraded to that 

system, Handoff stopped working – 

probably a result of the new Bluetooth 

drivers in Sierra. 

There is currently nothing that you 

can do to get Handoff working again 

under Sierra. Hopefully this will be 

restored in a future update, but given 

that Apple considers that your 

MacBook Pro doesn’t support Handoff, 

it’s best that you don’t expect it.

Ongoing memory hogs
When running oS X 10.11 El Capitan, 

Safari, and Safari DaVClient 

consumed huge amounts of memory 

– up to 50GB according to activity 

Monitor – and I often saw the 

spinning beach ball and heard the 

disk in my Mac thrashing. I thought 

that upgrading to Sierra might fix 

this, but it continues. What can I do?

Run a malware checker, such as 

Malwarebytes (Free, malwarebytes. 

com/mac), as a common cause of 

Safari swallowing lots of memory is 

unwanted software. SafariDAVClient is 

unusual to see running; find out the 

cause and ensure the instigator is 

current and configured correctly. 

Next, check Safari for old and 

unwanted extensions and plugins; 

extensions are listed in a tab in Safari’s 

prefs, but also check these folders for 

plug-ins: /Library/Internet Plug-ins 

and ~/Library/Internet Plug-ins, and 

look for extensions in ~/Library/ 

Safari/Extensions. 

over many years, I’ve 

built a large and carefully 

ordered photo library, 

first in iphoto, and more 

recently in photos. I use 

iCloud photo library so 

that I can access this 

from all my devices. a 

few weeks ago I needed to 

change my apple ID. Ever 

since I first signed in to 

my new account, new 

albums have proliferated 

and the library has 

become badly messed up. 

How can I restore order?

With a lot of photos and 

albums, once an iCloud 

copy becomes corrupted 

like this, it’s very hard to 

reorganize properly. 

One strategy is to get 

everything back onto a 

single Mac, kill the iCloud 

Photo Library, reorganize 

the library on that Mac, 

then turn iCloud Photo 

Library back on, first on 

that Mac, then on your 

other devices. It’s best 

if you ensure that all are 

upgraded to macOS Sierra 

and iOS 10 before starting. 

Killing the iCloud Photo 

Library is the only step 

that can be tricky. Once 

you’re confident that you 

have the whole library 

stored locally on your 

Mac, on an iOS device 

go to Settings > iCloud > 

Storage > Manage Storage 

> iCloud Photo Library and 

tap Disable and Delete. 

Or, on a Mac, open System 

Preferences’ iCloud pane, 

click Manage (bottom 

right), select Photo 

Library, then click Disable 

and Delete.

> iCloud Photo Library mess

Activity Monitor should still show 

quite a lot of memory in use; macOS is 

designed to make best use of what‘s 

available, and the Memory Pressure 

chart on the Memory tab should show 

Memory Pressure should almost always be 
green, and not venture into the red zone.
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>>> green almost all of the time, and 

never hit the red. Utilities that claim 

to “free up” memory are pointless; 

their effects are transient and soon 

overtaken by events.

Wrong search engine
Whichever search engine I choose in 

Safari, it keeps defaulting back to 

yahoo. How can I get it to stick?

This is almost certainly being set by 

unwanted software on your machine. 

Like the previous question, check your 

Mac for that and malware by running 

the current version of a tool such as 

Malwarebytes Anti-Malware (Free,  

bit.ly/2hF6oKi), which should be able 

to remove any nasties it finds and 

report back to you. 

Next, browse Safari’s preferences 

again, looking for old or suspicious 

extensions and plugins. You’ll find 

these in its Extensions tab, and by 

clicking on the Plug-in Settings button 

in the Security tab. It’s also worth 

disabling all plugins for the time 

being, as that can help you track 

down the culprit.  

Follow this up with a manual check 

of the three folders in which Safari’s 

plugins and extensions are kept: /

Library/Internet Plug-ins, ~/Library/

Internet Plug-ins, and ~/Library/ 

Safari/Extensions. 

receive event invitations as emails 

instead. Sign in through your browser 

on a Mac or PC using the same Apple 

ID and password as on your iOS device, 

then click Calendar’s icon. Click the 

cog icon (bottom left) and choose 

Preferences, then click Advanced and, 

next to Invitations, set “Receive event 

notifications” to “Email to…” 

You’ll still receive these spam 

invitations, but only as emails, and 

they won’t be inserted into your 

calendar automatically any more. 

You can also delete these spam 

invitations without declining them 

and inadvertently confirming to the 

spammer that your email address is 

active. Move the invitations to a new 

and otherwise blank calendar, and 

then delete that calendar to get rid 

of it and the event invitation at the 

same time.

Partition location
Why can’t Boot Camp installer 

locate its partition? 

This can happen if you have a 

Thunderbolt or USB storage device 

connected while trying to install 

Windows in Boot Camp. Disconnect 

all storage bar the USB media that 

contains the Windows installer, then 

start up and try again to install 

Windows. If that fails, try upgrading 

to Sierra, if possible. 

Nightly backups
How can I stop backups occurring 

during the night? 

Once that’s done, set the correct 

search engine, quit Safari, and then 

reopen it. If the first anti-malware scan 

picked up anything, consider running 

another scan now to check that there’s 

nothing left behind.

How to stop spam  
calendar invites
Just recently, I’ve been getting 

unwanted Calendar appointments 

inserted automatically from 

someone who’s writing them in 

Chinese. Have they gained access 

to my iCloud account, and how 

can I stop this?

These almost certainly don’t result 

from any failure on your part, or any 

compromise of your iCloud account. 

They result from Calendar’s ability 

to receive push notifications about 

event invitations that have been sent 

to you. This feature would normally 

work as a benefit to you by alerting 

you when people you know invite you 

to an event. In fact, anyone can send 

you invitations. All this spammer has 

been doing is using your iCloud 

account’s email address to send an 

event invitation. Apple’s servers then 

convert that into a push notification, 

which ends up in your calendar. 

In the Calendar web app over at 

iCloud.com, there’s an option to 

Block unwanted invitations in Calendar by changing a setting that’s only available at iCloud.com.

TimeMachineEditor can suspend backups 
without affecting other Power Nap features.

>>>Ask
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I’ve upgraded to Sierra, 

and have two issues with 

apple Mail. First, I can’t 

find a way to auto delete 

sent messages after a 

month, which was 

configured prior to Sierra. 

Second, an empty window 

appears every time I open 

Mail, which I have to 

close. How can I prevent 

that and automatically 

delete old sent 

messages?

There’s no longer 

a setting in Mail’s 

preferences to achieve 

this. In an account’s 

Mailbox Behaviors’ 

tab, you could set sent 

messages to be saved in 

the Deleted Messages 

mailbox and have those 

erased after a month, but 

this carries the risk that 

you might accidentally 

erase things early. The 

blank window problem has 

occurred in the past when 

Mail had been upgraded. 

It’s the remains of the 

Welcome to Mail splash 

screen, which should have 

been turned off after the 

upgraded app ran for the 

first time. a trick that has 

fixed this previously is 

to open Mail, disable all 

accounts, quit Mail, open 

it again, re-enable 

accounts, quit the app 

again, and finally open it 

a third time. 

If the window remains, 

you may be able to kill 

it by trashing Mail’s 

preferences file, but that 

would create more work 

to configure the app 

again. You may find it 

simpler to live with it for 

now. Let’s hope a future 

update to Mail will do 

away with this for good.

> Mail issues in Sierra

If you put your Mac to sleep 

overnight then, by disabling Power 

Nap in the Energy Saver pane, 

Time Machine will stop running. 

Alternatively, TimeMachineEditor 

(Free, bit.ly/2hl9KFS) can suspend 

backups between certain hours 

without affecting other Power Nap 

capabilities that occur while your 

Mac is ostensibly asleep. 

Dropbox compatibility
Is Dropbox compatible with  

macoS Sierra yet?

Yes, but there can be some 

problems. Full details are at  

bit.ly/2grNyFo. Avoid using it with 

iCloud Drive’s Optimize Mac Storage 

feature or other forms of iCloud 

syncing, and don’t move or rename 

Dropbox’s folder from its defaults. 

Putting items with aliases into 

Dropbox can also cause issues. 

Security code
Do I really have to use an iCloud 

Security Code? 

No, but if you create one while 

setting up iCloud Keychain, it adds 

an extra level of security that enables 

you to access your keychain on 

additional devices without the need 

to approve them from one that’s 

already authorized. It can be six 

digits, a complex alphanumeric 

code, or a random code.

Login keychain
How can I repair my login keychain 

in Sierra?

The Keychain First Aid feature 

was removed from Keychain Access 

in OS X 10.11.2 due to a security 

vulnerability. Unfortunately, all you 

can do to work around this is create 

a new keychain and copy the old 

one’s items to it.

Sshh…
Why is airplay music quietened 

on my apple TV? 

This is because you’ve enabled the 

Reduce Loud Sounds feature on your 

Apple TV. This not only affects video 

played on that Apple TV, but also 

music sent from your iOS device via 

AirPlay. To restore normal volume, 

go to Settings > Audio and Video in 

Apple TV’s settings. 

Damaged app
How can I run an app macoS says 

is damaged?

You can’t, and the only action 

you can take on it is to put it straight 

in the Trash. 

When you open an app, macOS 

checks the signature, and if the app’s 

damaged it will fail that check. You 

will need to obtain an undamaged 

copy of the app. 
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Time is precious, which is 
why it’s important to ensure 
your Mac is working for you, 
not the other way around.

Tags enable you to keep track of files 
by subject, no matter whether they’re on 
your desktop, buried five folders deep in 
Documents, in iCloud, or even spread 
among all these locations. You can also 
make the Desktop and Documents folders 
available on iCloud-connected devices.

Pages, Numbers, and Keynote have the 
built-in ability to use a document you’ve 
set up as a template on which to base 
future work. You can achieve a similar 
effect with any file in Finder, so that when 

Keep your workspace organized
Learn essential techniques for keeping track of your files and apps

you open it you work on a copy, which 
keeps the original intact while making 
your work consistent and professional.

Any apps, folders or server connections 
you regularly use can be set to open when 
you log in. Additionally, you can create a 
stack in the right-hand side of the Dock 
that shows your most recently used apps.

Most of the tips here can be used on any 
Mac, because they focus on features in 
macOS itself, but we’ve also included a  
third-party tool, Quicksilver.

For the most part, the techniques you’ll 
learn about here are pretty simple to get 
to grips with. However, one requires a 
command in Terminal. AdAm smiTh

REQUIRES
OS X 10.10 or higher, 

Quicksilver (optional)

yoU wIll lEaRn
How to use stacks, tags, 

document templates, 
Finder shortcuts and more

IT wIll TaKE
30 minutes

Use tags effectively
Tags help you group files across folders. 

You can pick which are listed in Finder’s 

sidebar; click one there to see relevant files. 

You can add multiple tags when saving a doc, 

or add them by right-clicking a file in Finder.

Flexible search
You can use tags with other criteria 

in Smart Folders. In Finder, choose File > New 

Smart Folder, click the + on the right, choose 

Other as the attribute and find “Tags.” You can 

also save Smart Folders in Finder’s sidebar.

 
SET appS  
To opEn

For quick access, you 
can set apps to open  

at login by adding  
them to Login Items  

in System Preferences’ 
Users and Groups pane.

how To Get your work organized

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

CREATE
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reusable template
To turn a document you use often into  

a template, ensure it’s closed, select its file in 

Finder and choose File > Get Info. Put a check 

mark next to Stationery Pad. Now when you 

open that file, you’ll actually work with a copy.

access using stacks
Simply drag a folder (or a tag in Finder’s 

sidebar) to the right-hand side of the Dock for 

quick access to it. To change how it shows files, 

right-click on the stack and pick grid, list or fan 

view. You can choose a sort order as well.

One click to folder path
Right-click the name at the top of a 

Finder window or doc that’s open in an app to 

see the path to it. Click an item in the path to 

open it. You can also drag a folder onto an 

Open or Save dialog to focus on that location.

Sync your desktop
In iCloud’s prefs, iCloud Drive provides  

an option to put your Desktop and Documents 

folders online and keep them in sync across all 

your Apple devices. (You can go straight to 

iCloud Drive in Finder by pressing ß+ç+2.)

recent apps stack
To create a stack of recently used apps, 

in Terminal enter defaults write com.apple.

dock persistent-others -array-add '{ 

"tile-data" = { "list-type" = 1; }; "tile-type" 

= "recents-tile"; }' then log out and in again.

Use Quicksilver
Quicksilver (Free, qsapp.com) enables  

you to use keyboard shortcuts to open folders, 

files, and more. Click the + button to create 

custom trigger conditions, and link multiple 

actions together to streamline your workflow.

 
fIndER’S  
SIdEbaR

Drag a folder from a 
removable drive into 
Finder’s sidebar; it only 
appears there when that 
drive is connected, cutting 
down on clutter.

How to do anything on your Mac, iPhone & iPad
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Quick Look FontForge’s interface

FontForge is an open-source 
tool for creating and editing 
typefaces. It is made for Unix’s 
X11 windowing system, which 

you’ll need to install in macOS to be able 
to use it. FontForge is pretty clunky, 
which is why most type designers pay 
for alternatives such as Robofont 
(around $430, doc.robofont.com). 
But it does the job for free.

In this tutorial we can only give you a 
quick introduction. Creating a typeface 
requires planning and organization, and if 
you want to get into the subject in depth, 
the process is thoroughly explained at 
designwithfontforge.com. It’s worth 
reading everything there.

Drawn this way

Fonts are stored as vector graphics, but 
rather than drawing these from scratch, 
it’s usual to start by roughing out glyphs 
on paper, big, and then scan them. You 
could also sketch on an iPad using Apple 
Pencil or a third-party stylus.

Either way, you import a bitmap image 
of a single glyph into FontForge’s glyph 

create your own typeface
Use a free, open-source app to draw new fonts or edit existing ones

window using File > Import. This image 
appears in the background layer, which 
you can edit by clicking Back at the 
bottom left or pressing ß+b. Position 
it, then switch back to the foreground 
layer and draw over the top of it. Upon 
completion, you can choose Edit > Clear 
Background to remove the bitmap, 
although it’s ignored anyway when 
you export your finished font using 
File > Generate Fonts.

You can import glyphs drawn with 
other apps. Copy and paste won’t work, 
but we found that exporting an SVG file 
from another app and using File > Import 
in FontForge was reliable, though saving 
as EPS file back out of FontForge wasn’t.

Another way to use FontForge is to 
tweak an existing font, bearing in mind 
that any licensing terms will still apply 
to your edited version. Just go to File > 
Open – almost any font file will work, 
enabling you to edit each glyph, add 
missing characters, and learn from how 
professional fonts are drawn. Google’s 
Chivo (see below and bit.ly/2hhWdf6) is 
an especially tidy example. aDam Banks

REQUIRES
XQuartz, FontForge 

yoU wIll lEaRn
How to run FontForge 
on your Mac and start 

drawing some character 
shapes, or “glyphs”

IT wIll TaKE
45 minutes

GET XQUaRTz
This version of X11 is 

no longer included 
with macOS. It’s free 
and you can obtain it 

from xquartz.org.

EdITInG paThS
Points with handles work 
much like Béziers in other 
apps, but some tools will 
be less familiar.

GlyphS
The character set for 

your font is listed here. 
Double-click any glyph 

to create it from scratch 
or edit what’s there.

ThE EdITInG 
wIndow
Editing glyphs takes place 
in another window, which 
has its own menu bar and 
tool palette.

>>>Create
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Edit a glyph
The window has its own menu 

bar, rather than using macOS’s. In the 

grid of empty characters (glyphs), start 

by double-clicking the lower-case “o.” 

A second window opens with a tool 

palette and, again, its own menu bar.

Install XQuartz
Go to xquartz.org, download 

the disk image (dmg) file, then double- 

click it to open it. Open XQuartz.pkg 

from the image to install the software. 

Log out and back in, or restart, to 

enable XQuartz to work correctly.

add a counter
Keep going and you’ll complete 

the o’s outline. Hold the Spacebar for 

a preview; it appears as a solid disc. 

Switch to the plain curve point tool on 

the left and draw a counter (the white 

space inside) by placing points.

adjust metrics
The window’s horizontal guides 

set the ascender/descender heights for 

all glyphs; alter them in Element > Font 

Info > General. The vertical guide on 

the right can be adjusted per glyph. 

Drag it to about 800 (1/8th of an em).

Download
Go to bit.ly/2hzMzaw and enter 

your email address. You’ll get a 

confirmation email, but you can ignore 

it. Either way, you can make an optional 

donation to support development of 

the app or click to download FontForge.

Correct path
If you preview the glyph again, 

you’ll still get a solid disc, because both 

paths have the same direction. Press 

≈+ß+d to correct this. Holding 

down the Spacebar shows your 

finished letter o. Almost done…

Scale for overshoot
To make curves align optically 

with straight lines of other glyphs, they 

need to overshoot. Press ç+a to 

select all points, press ≈+\, choose 

Scale, enter 105%, click OK. Draw 

additional glyphs, then export the font.

Draw a curve
Rather than using the Bézier 

pen, let’s try one of the alternative 

tools below, “Add a curve point always 

either horizontal or vertical.” With this, 

click – don’t drag – in the middle of 

each side of the central square in turn.

Up and running
Click Short Guide and skip to 

where you’re asked to pick a download. 

Drag the FontForge app to your Mac’s 

Applications folder, then double-click 

it to open it. XQuartz should open and 

you‘ll see a window named “Untitled 1.”

how to Get started with FontForge
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Okay, yOu’ve taken your 
personal “shot of the year,” 
a photo so stunningly great 
you want to blow it up to a 

giant size and display it. The trouble is, 
even a 12MP shot from an iPhone 7 can 
barely reach 16 inches across without 
starting to look soft. So how did Apple 
create those giant “real iPhone shots” for 
its billboard ads? The answer is simple: 
interpolation. The images have been 
processed for large-format printing by 
dramatically boosting the number of 
pixels and applying careful sharpening.

Repeat after us: it’s not cheating, it’s 
optimizing. Photographers and designers 
tweak and tune images for different kinds  
of output all the time. It’ll help to know a 
bit about image resolution and to get hold 
of software to do the optimization. First, 
though, make sure your photo really is 
technically good. If it’s a bit fuzzy, if the 
focus is off, or there’s camera shake, 

Print your photos as posters
Make the most of your photos’ pixels to get optimal giant printouts

that’s going to be magnified along with 
the scene itself. Start with the best 
originals you have.

The secret to image resolution is 
simple. Never forget this fact: a digital 
photo is just a grid of pixels, like a sheet 
of graph paper with extremely fine 
squares. If you stretch that grid to fill a 
larger space, you make the squares bigger. 
Take this enlargement too far and that 
grid becomes noticeable; the image looks 
pixelated and we call it low resolution. 
Scale the same image grid down to a 
smaller print size so we can’t see the 
pixels and we call it high resolution. 

You can take a photo and “interpolate” 
it – recalculate all the pixels using a finer 
grid – so it can be printed much larger 
without those pixels being visible. On its 
own this would soften the image a little, 
so sharpening tricks are often used to 
make the picture look crisp again. 
However, always remember that you 

REQUIRES
A good photo,

Preview, Photoshop, 
or ON1 Resize 

yoU wIll lEaRn
You will learn how 

to resize images for 
perfect poster prints

IT wIll TaKE
30 minutes

>>>Create
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cannot add detail to the image; if it wasn’t 
in the original, it never will be.

There’s a resolution rule of thumb that 
says you should go no lower than 300 
pixels per inch (ppi, also known as dpi). 
This means that an image that is 3,000 
pixels wide can be printed at up to 10 
inches across without going below that 
threshold. But that’s really for best 
magazine-quality printing; if you hang 
something on a wall you’ll be viewing it 
from further away, so you can scale that 
same image up a bit, taking the effective 
resolution down to around the 240ppi 
mark. Really giant posters are normally 
seen from even greater distances, so you 
could even swing under 200ppi.

This should help you work out roughly 
how many pixels wide and tall you need 
to interpolate to for your final print. 
Remember: size in inches x minimum 
pixels per inch = the total number of 
pixels your image needs to be. For 
example, a 36-inch-wide print at 240ppi 
needs to be at least 8,640 pixels across. 
So you’d better get interpolating!

Doing this resizing process well is much 
easier now than it was in the past. If you 
have a recent version of Photoshop to 

hand, you can use its Image Size 
command. Photoshop CC includes a 
“Preserve Details (enlargement)” option 
that does an excellent job of preserving 
detail and avoiding ugly pixel blockiness 
while upscaling images. Photoshop 
Elements has the slightly simpler 
“Bicubic Smoother” for this job.

Resizing images mORe easily 

ON1 Resize ($79.99, free trial available 
at on1.com) is the latest version of what 
used to be called Genuine Fractals. It is 
dedicated to the process of resizing 
images for large-format printing, and it 
includes a number of presets. You can 
apply a short selection of effects to your 
image, then pick from a range of printer-
specific paper sizes and types, or enter 
the dimensions and pixel resolution by 
hand. Printing can be done directly, or 
the scaled image can be saved. It also has 
some special tricks to tile your image into 
multiple parts or create a “gallery wrap” 
border to cover the sides of a canvas print 
frame. The app creates images that 
preserve detail well, but you get exactly 
the same quality level from Photoshop, 
and you’ll do so significantly faster.

Resampling images can avoid visible pixels, although eventually you will notice clumps and lack of detail.

 
JaRGon BUSTER

Resolution is the scale 
of an image’s pixel grid 
when it is printed, which 
determines how many 
of its pixels fit within 
a linear inch.

 
onE-STEp 
SolUTIonS

Don’t resize by small 
amounts over many steps. 
This old-school trick 
doesn’t do any better 
than today’s one-step 
processes, and it’s very 
slow and awkward.
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visual guide Resizing images in Preview

ChECK 
InfoRmaTIon
Choose Tools > Show 

Inspector to see facts 
and figures about your 

image: its format, 
resolution, and so on.

CloSE 
ExamInaTIon
Always check details 
by zooming in after 
resizing an image, so 
that you can then set 
sharpening perfectly.

SET dImEnSIonS
Choose Tools > Adjust Size 

and use this sheet to 
set an image’s final 

resize dimensions 
and pixel resolution.

add ShaRpnESS
Choose Tools > Adjust 
Color to use this panel 
to alter saturation, 
contrast and, crucially, 
sharpness of an image.

What really surprised us is how good 
the humble Preview app – yes, the one 
that comes with macOS – is at scaling 
images up. It doesn’t apply the same 
automatic sharpening as Photoshop and 
ON1 Resize, but the difference is relatively 
slight. It’s also easy to apply sharpening 
yourself after you’ve resized an image. 
You get world-class photo editing options 
in Photoshop, and easy paper presets with 
ON1 Resize, but you needn’t buy anything 
to scale, sharpen, optimize and crop a 
photo. In our tests the differences were 
hard to spot!

All digital photos are captured as RGB 
images: they are made from different 
strengths of red, green, and blue light. 
Printing doesn’t work in the same way; 
it’s done using CMYK – cyan, magenta, 
yellow, and black. (The K stands for 
“key,” for the definition and contrast that 
the black ink adds to the colors.) Some 
inkjet printers use additional pale colors 
or extra orange and green ink, but it’s still 
all about light reflecting off the page. The 
old advice was to convert images to CMYK 
before printing, but that’s no longer best 
practice. Most of today’s print engines 
(from desktop inkjets to high-end 
commercial raster image processors, or 
RIPs) will happily convert RGB to CMYK 
for you as the print is sent, and they’ll 

know exactly how to do this to best suit 
their own idiosyncrasies. Convert the 
image yourself with the wrong settings, 
and your prints could look awful. If you’re 
sending files off to be printed it’s worth 
asking, but the answer will almost always 
be to leave things in RGB. That’s good in 
other ways too, as a CMYK version of an 
image is less flexible and less suitable for 
different uses than an RGB original.

When you look at the final printed 
result, remember that print simply can’t 
reproduce the deep lushness of fully 
saturated RGB colors. Any print will 
always be a little more dull, although you 
probably won’t notice this if you don’t 
hold the result next to your screen.

Your images are almost certainly in 
8-bit RGB, not least because that’s all 
that the JPEG format supports. Each of 
the three color channels uses eight bits 
of data for each pixel; 256 levels from 
full-strength color down to nothing, 
enabling roughly 16.8 million different 
colors to be represented. ON1 Resize can 
convert an image to 16-bit color, but 
that’s unlikely to be any benefit for a 
final-stage printing tool. This is great for 
photo-editing adjustments, but only 
really if the original was in that mode.

Let’s look at how to apply the 
techniques… keith maRtin

 
JaRGon BUSTER

Interpolation is the 
recalculation of an image 

and generating a new 
pixel grid. Different 

interpolation methods 
work better for scaling 

up and scaling down.

 
adJUST  

SIzE ShEET
 

In Preview’s Adjust Size 
sheet, click the first row 

of text in the Resulting 
Size box to cycle through 

all the different units 
of measurement.
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Use ON1 resize
The Document Size pane can be used to 

set an image’s dimensions and pixel resolution 

manually; a pop-up menu of suggestions is 

provided as an aid. Alternatively, pick a printer 

and paper type from the presets on the left.

Set pixel size in 
photoshop

Choose Image > Image Size, set Width and 

Height to Pixels, and set the number of pixels 

this needs to be. Alternatively, set the physical 

size your print needs to be, then set resolution 

to the pixels-per-inch value you’ve calculated.

resize in preview
Open your image in Preview and choose 

Tools > Adjust Size. Next, either set the overall 

pixel dimensions you need, or use the drop-

down on the right to set the physical width and 

height, and the pixel resolution, then click OK 

to scale the image smoothly.

Tricks for ON1 resize
The big benefit of ON1 Resize is its bag 

of print-related tricks. Here, the Gallery Wrap 

feature mirrors the edges of the image to 

create a print that’s suitable for wrapping 

around the sides of a frame.

Set interpolation 
method

In the Resample pop-up menu, choose 

an interpolation method. We recommend 

“Preserve Details (enlargement)” for most 

images, but test the available choices to see 

which you prefer for your image.

Sharpen in preview
To sharpen the results of resizing your 

image, simply choose Tools > Adjust Color from 

the menu bar and drag the Sharpness slider to 

the right. Try setting it from the three-quarters 

point onwards. (Dragging the slider to the left 

actually blurs your image.)

hOw tO Prep a photo for a large print  
JaRGon BUSTER

The interpolation styles 
called Nearest Neighbor, 
Bilinear, and Bicubic are 
increasingly complex 
ways software looks at 
surrounding pixels when 
it is resizing an image.

 
REal-woRld 
oUTpUT

Never forget that 
an image’s “per inch” 
resolution is ultimately 
meaningless if you don’t 
know the real-world 
output size this gives.
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Quick app actions
For many apps, a firm press on 

their Home screen icon reveals a list of 

actions. In some cases, it also shows a 

widget with info or additional actions;  

if you refer to a widget often, there’s 

an option to add it to iOS’s Today view.

Switch apps
Instead of double-pressing the 

Home button to open the app switcher, 

press firmly on the left edge of the 

screen. Alternatively, press firmly 

while swiping to the screen’s right 

edge to go back to your previous app.

Control Center
Apply 3D Touch to an icon in 

Control Center’s bottom row: pick from 

flashlight strengths, start a 1, 5, 20, or 

60-minute timer, copy the last result 

from Calculator, or jump into Photo, 

Selfie, Video, or Slo-mo camera modes.

The screen in the iPhone 7 
and 6S series (but not the SE) 
can sense the amount of 
pressure you apply, enabling 

apps to react differently than if you 
simply tap on an item. Apple calls this 
tech 3D Touch. On the Home screen, 3D 
Touch provides shortcuts – or Quick 
Actions, as Apple calls them – to popular 
features in many apps with just a firm 
press followed by a tap. In fact, you don’t 
even need the tap; just press your finger 
on an icon, slide it to the Quick Action you 
want and let go to choose it. Sometimes 
you’ll also be shown a widget containing 
key information from the corresponding 
app, such as current conditions from 
Weather, the last item you worked on in 
Notes, and up to four of your most recent 
Memories in Photos. (Note that items in 
widgets have to be tapped.)

3D Touch also provides a more powerful  
experience when selecting text in apps 
such as Notes and Pages. It enables you 
to move the insertion point around a 
document while keeping your fingers 
over the on-screen keyboard rather than 

Make full use of 3D Touch shortcuts
Unleash the extra power of your iPhone’s pressure-sensitive screen

obscuring the text with them and having 
to rely on iOS’s magnifying glass effect 
and find the desired finishing position. 
3D Touch also enables you to very quickly 
extend your selection by additional whole 
words, sentences or paragraphs.

Though we say text selection with 
3D Touch is powerful, it can take a few 
attempts to master applying different 
levels of pressure. If you find 3D Touch 
over- or undersensitive, bear in mind that 
its responsiveness can be altered; you’re 
shown an option to tailor it when you first 
set up your iPhone, and it can later be 
adjusted to one of three levels in Settings 
> General > Accessibility > 3D Touch.

There is, of course, a chance that you’ll 
dislike some aspects of 3D Touch. Sadly, 
unlike being able to turn off certain 
gestures on a multi-touch mouse or 
trackpad on your Mac, iOS provides no 
way to selectively disable some 3D Touch 
behaviors. So, you must get used to 
accidentally triggering some features and 
try to adjust the firmness of your presses, 
or, if that doesn’t work out, disable 3D 
Touch altogether. AlAn sTonebriDge

REQUIRES
An iPhone 6S,  

6S Plus, 7, or 7 Plus 

yoU wIll lEaRn
Many different ways you 

can use 3D Touch to 
take shortcuts 

IT wIll TaKE
10 minutes

how To Use 3D Touch system shortcuts
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Move within text
To select a range of text, press 

firmly on the on-screen keyboard and 

its keys will go blank. Keep your finger 

on the screen and slide it around to 

reposition the insertion point in the 

document, relative to your movements.

peek and pop
In many apps, pressing lightly 

on an item (say, a message in a mailbox 

in Mail or a link in Safari) peeks at that 

content. Let go to close it, or press 

harder to pop it open. You can swipe up 

from a light press for available actions.

Start a selection
After positioning the insertion 

point, keep your finger on the screen, 

press firmly again to select the word. 

Slide your finger to add more words. 

After lifting your finger, you can access 

options by tapping your selection.

Notifications
Tapping a notification’s banner 

takes you to the relevant place in an 

app, but you can deal with an item by 

pressing firmly on it, then swipe down 

to clear it. This also works at the Lock 

screen and in Notification Center.

Bigger selection
Position the insertion point, 

press firmly twice in quick succession 

to select the sentence; slide your finger 

to extend the selection a sentence at 

a time. Or, press three times to select, 

then grow your selection in paragraphs.

Live photos
If you take or receive a Live 

Photo (with a short amount of video 

either side of a still image), you can tell 

it apart from regular pics by an icon of 

concentric circles when editing. Apply 

3D Touch to a Live Photo to play it.

> oTher 3D Touch shorTcuTs

A few more useful places you can press firmly

3D Touch can help you in even more ways in iOS and many third-party apps. 

On the Home screen, a firm press on a folder reveals a shortcut to rename it  

and direct routes to apps inside that have notifications waiting. 3D Touch the cross 

to the right of a heading in Notification Center for a shortcut to dismiss all items.  

In Reminders, press on an item to set a location or time at which to be nudged 

about it. When restoring from a backup or downloading several apps, press on 

an app’s Home screen icon to pause or resume, cancel, or prioritize its download.

how To Work with text using 3D Touch

how To Take a closer look at things
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Indent and tabulate
The indent button allows you to 

shift the entire paragraph to the right 

(Indent) or left (Outdent) using tab 

markers (tap again to shift to the next 

marker). Tap “Tab” to insert a single 

tab at the cursor point.

Change font/size
Tap the current font name to 

select a different font to type new 

characters with, or select your text 

first to change its font. Tap the AA 

button to change its size using one 

of the supplied presets (10 to 48).

More controls
Tap the paragraph button to 

change the alignment of the current 

paragraph: choose from left, center, 

right, and justified. Tap the final button 

to access controls for inserting 

comments, breaks, and footnotes.

If you’re looking to edit text 
with a bit of flair and panache, 
there’s no substitute for 
Apple’s own Pages app. But 

for all its extra features, Pages remains 
first and foremost a word processor. 
In this tutorial we’re going to focus on 
exploring its text-based tools to reveal 
how to simplify, speed up, and improve 
the way you work with text documents 
on your iPad.

Pages has evolved to put more text-
editing and formatting tools at your 
fingertips. Start typing, and you’ll see the 
pop-up keyboard now offers shortcuts to 
a number of useful formatting options. 
You’ll notice one particular option, the 
resize text tool, offers a limited number 
of text sizing options, but don’t worry – 
if none of these fit, you’ll find the Format 
Painter enables you to resize in one-point 
increments, from single-point text up 
into the hundreds. You’ll also find other 
text-styling tools – bold, italic, underline, 
and strike-through – here too.

One major limitation is that there’s still 
no way to update text styles on your iPad. 

edit and format text in Pages on ioS
Tap into Pages’ powerful text-handling tools to improve your documents

You can, naturally, edit text styles on the 
fly for selected text, following the step-
by-step guide opposite. It’s just a shame 
you can’t yet save those changes, either 
by updating an existing style or by 
creating a new one. Instead, you need to 
open the document in Pages on your Mac, 
apply changes there, then sync the 
document back via iCloud.

Don’t forget to make use of Pages’ 
spellcheck tool. Tap the “…” button and 
make sure Check Spelling is switched on. 
Once enabled, misspelled words will be 
shown with a red underline. Tap it 
and choose Replace to see suggested 
alternatives, then tap the correction. 
Pages will also use your system-wide 
autocorrect settings to correct mistyping; 
to switch this on and off, return to the 
Home screen and choose Settings > 
General > Keyboard.

Last, but not least, flick on the Word 
Count switch under “…” and you’ll see a 
running word count appear at the bottom 
of the screen. Tap and drag it to reposition 
it, or tap it to reveal more detailed 
statistics. NIck PeerS

REQUIRES
Pages for iOS, Bluetooth 

keyboard (optional)

yoU wIll lEaRn
How to style and  
edit text; master  

keyboard shortcuts 

IT wIll TaKE
20 minutes

How to Format text from the keyboard

>>>Create
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Quick changes
Tap the “…” button in the 

toolbar and select Document Setup. 

Use the arrows at the sides of the 

document to tap and drag the margins 

to resize them in set increments. Set 

them to 0 inches to remove them.

paragraph style
Tap three times to select 

a paragraph. Then tap the Format 

Painter to view its current paragraph 

style. Tap the style name to bring up a 

list. Try a style by choosing it, then tap 

another until you find one you want.

View on-screen
Tap Undo to start again, 

or Done to return to the document – 

you should see the text has reflowed. 

Tap “…” and turn on Edge Guides so 

you can use the margin to snap images 

and other elements to.

Tweak text style
You can select a style as your 

starting point, then tap “<” to return to 

the main Format Painter screen where 

you’ll find controls for tweaking font, 

style, size, and color – note this only 

affects the selected text.

Set custom tabs
Tap “…” to enable the ruler. 

Tap your text to bring up the ruler. 

Tap and hold on the ruler and a > sign 

will appear, magnified. Drag it to the 

desired spot and release to set it; 

repeat for as many stops as required.

Change page layout
Scroll down further and you 

can set the paragraph alignment, 

implement bullets or lists, and change 

the text to a multi-column layout. 

Adjust line spacing to change the 

gap between each line of text.

> keyboard SHortcutS

Speed up Pages using an external keyboard

Pages works brilliantly with a physical keyboard – you can pick up a serviceable 

Bluetooth keyboard for under $10 on eBay. Not only does this make typing easier, 

it also opens up a number of great keyboard shortcuts. Most are similar to those 

you find on the Mac, and a comprehensive list can be found at the Apple support 

site (apple.co/2jYzJE4). But why memorize that when you can simply hold down 

the ç key on your keyboard? After a short pause a pop-up window appears, 

listing all available shortcuts for the currently selected item.

How to Master page margins

How to Style text with Format Painter
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Gesture control
Before you begin, you should note a few 

useful gestural shortcuts. Tapping on an image 

with three fingers reverts it to its original state, 

and double-tapping any image attribute’s slider 

resets it to its original position.

Check image attributes
Tap an image until it opens fullscreen. 

Tap the “i” icon (top of the screen) to show 

information about the image’s file at the top 

left – tap this data to cycle through information 

such as EXIF data, star rating, and so on.

PerhaPs one of the most 
compelling features of a 
Creative Cloud membership  
for photographers is the tight 

integration of Lightroom between desktop 
and mobile devices. The two apps work in 
harmony, syncing image collections over 
the internet, enabling you to begin editing 
a set of images on your Mac, then pick up 
where you left off on an iPad. You can also 
work through a collection of images and 
approve or reject them, as well as assign 
star ratings. All the changes you make 
work their way back to Lightroom on your 
Mac, from which you can export the 
full-size versions to get the best quality.

You’ll need a Creative Cloud 
subscription. Adobe’s Photography 
subscription plan – which includes 
Lightroom, Lightroom Mobile and 
Photoshop CC – costs $9.99 per month 
when you sign up for a year.

Not all of the images in your Lightroom 
library are synced via Lightroom Mobile. 
To sync just a few images, press ç+N to 

Perfect photos in Lightroom for ios
Discover the advanced camera and editing tools in Adobe’s updated app

create a new collection. In the dialog box 
that appears, once you’ve chosen a name, 
ensure “Sync with Lightroom mobile” is 
checked. Drag the images you want into 
the new collection and syncing will begin.

Alternatively, under Catalog in 
Lightroom’s left toolbar you’ll see 
a collection called “All synced 
photographs” – simply drag individual 
shots or groups of images into that 
collection to synchronize them.

There are a few organizational tools 
in the mobile version of Lightroom to 
be aware of. Tap an image to open it 
fullscreen, then swipe up to apply a 
Picked flag to it, or swipe down to mark it 
as rejected – useful for sorting through a 
batch of images. You also have the ability 
to assign numeric ratings out of five. Once 
you’ve sifted through a batch of shots, tap 
“Lightroom Photos” (top of the screen) to 
find controls that filter the images based 
on the flag or rating applied – useful if 
you’re working through initial edits of 
a large collection. Dave stevenson

 
Go Pro

Lightroom for iOS’s 
camera abilities were 
recently updated with  

a “pro” mode. This gives 
you more controls, and 

can take raw photos.

rEQUIrES
An Adobe Creative 

Cloud subscription that 
includes Lightroom 

yoU wIll lEarn
How to sync images to 

Lightroom for iOS, work 
with collections, and 

sort and edit pics 

IT wIll TaKE
1 hour

how to Sort and process images in Lightroom on iPad
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Open the editor
Once your images are synced and 

flagged, swipe to the left of the toolbar at the 

bottom of the fullscreen view to reveal the 

editing panel. This is where you can begin 

the process of finishing off your images.

adjust gradient filter
To rotate your graduated mask, tap its 

middle line, then tap the exposure tool below 

your image and, in the case of a landscape like 

this, reduce that attribute a little. You might 

also want to raise the saturation a little.

adjust a color channel
Tap the compass-like icon just above 

the color sliders then tap anywhere on the 

image. Now slide your finger left or right to 

reduce or raise the saturation of the color you 

tapped. This is useful to make blues bluer, say.

add a gradient filter
Gradient filters are just as useful in the 

mobile version of Lightroom as they are on the 

Mac. Choose Selective on the right-hand side 

of the toolbar, then tap and drag downwards 

on your image to produce a graduated mask.

Selective saturation
This is a useful color technique. Tap Edit 

at the bottom of the screen, then the left-most 

icon to display different sets of editing tools. 

Tap Color/B&W and you can use the various 

sliders to change individual colors’ saturation.

Fix with a lens profile
Tap the left-most icon again and pick 

Lens Corrections. This tool doesn’t have the 

power of its Mac counterpart, but if you trust 

Lightroom’s built-in lens profiles you can 

quickly correct problems like barrel distortion.

 
JarGon BUSTEr

Picked, rejected, and 
unflagged are the three 
basic flags Lightroom 
provides to help you 
quickly pick good shots 
and reject bad ones.

 
SharE 
To ExPorT

Lightroom uses iOS’s  
built-in Share sheet to 
send photos elsewhere. 
Tap the Share icon at the 
top right to quickly export 
and post images.
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That clamshell truly was 
portable when it came to 
internet connections.
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AN Air Of unreality pervaded Apple’s 

keynote at Macworld Expo New York on 

July 21 1999. Proceedings began as usual 

with Steve Jobs striding on to the stage, 

dressed in his now familiar jeans and 

black turtleneck; except it wasn’t Steve 

Jobs at all, but Noah Wyle, star of the TV 

hospital drama ER, who’d recently played 

Jobs in the film Pirates of Silicon Valley.

Steve himself soon arrived to mock 

Wyle’s actually pretty passable imitation 

of his physical and vocal tics, a rare 

acknowledgement of the interim CEO’s 

cult of personality. Things looked set to 

get even weirder when he invited Ozzie 

Osbourne on stage to demonstrate IBM’s 

screen, picked up the machine, walked 

across the stage and opened another 

website. Seeing the point immediately, 

the audience erupted as Steve milked the 

moment by passing the machine through 

a hula hoop. Look, no wires!

Once again, a technology not invented 

by Apple – the 802.11b Wi-Fi protocol, 

then branded by the company as a series 

of products under the AirPort name – 

became a groundbreaking, unique selling 

point of the Macintosh.

ViaVoice speech recognition software, 

but it turned out he was referring to the 

similarly named general manager of 

IBM Voice Systems, who completed his 

presentation without biting the head 

off anything.

But it was what happened later that 

was truly “magical.” Bringing out a long-

awaited consumer laptop – which was 

described as “iMac to go” – in the 

colorful plastic form of the iBook, Jobs 

talked through its style, practicality, and 

performance, and showed a series of TV 

commercials the company had made to 

promote it. Then he loaded up the Apple 

website on its 12-inch 800x600 color 
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iBook
Adam Banks remembers when wireless internet was the stuff of dreams
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